
	
		
		    
			
			    
			
			
			    
			    
			    
			 
		    

		                     
				 Home
	 Add Document
	 Sign In
	 Register


			
			    
				
				    
					
					
					    
					

				    

				

			    

			

		    

		

	

	
    
	
	        	    
		    		PowerPoint 2010 Bible    	    

	    	    	Home 
	PowerPoint 2010 Bible


	

    




    
        
	    

	    
            
		

		
		    		    
			
			    
				
				    CD-ROM Included! • More than 500 professionally-designed PowerPoint templates and backgrounds

Faithe Wempen

PowerPoint...				

				    				
    				    Author: 
										    Faithe Wempen					    				

				
			    

			    
				

				 179 downloads
				 1801 Views
				    				 18MB Size
								 Report
			    

			    
				
				This content was uploaded by our users and we assume good faith they have the permission to share this book. If you own the copyright to this book and it is wrongfully on our website, we offer a simple DMCA procedure to remove your content from our site. Start by pressing the button below!
				
 Report copyright / DMCA form

				
			    

			

			
			    
				
				     DOWNLOAD PDF
				

			    

			    
				
				    
				    
					
				    
				    
				    
					
				    
				

				
				    

				

			    

			

			

			

			

			
			
			
		    

		    
						    CD-ROM Included! • More than 500 professionally-designed PowerPoint templates and backgrounds
 
 Faithe Wempen
 
 PowerPoint 2010 Microsoft®
 
 Discover what makes a great presentation Add eye-popping graphics and multimedia Make a connection with your audience
 
 The book you need to succeed!
 
 ®
 
 ®
 
 Microsoft PowerPoint 2010 Bible ®
 
 Faithe Wempen
 
 Wiley Publishing, Inc.
 
 Microsoft® PowerPoint® 2010 Bible Published by Wiley Publishing, Inc. 10475 Crosspoint Boulevard Indianapolis, IN 46256 www.wiley.com Copyright © 2010 by Wiley Publishing, Inc., Indianapolis, Indiana Published simultaneously in Canada ISBN: 978-0-470-59186-4 Manufactured in the United States of America 10 9 8 7 6 5 4 3 2 1 No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permitted under Sections 107 or 108 of the 1976 United States Copyright Act, without either the prior written permission of the Publisher, or authorization through payment of the appropriate per-copy fee to the Copyright Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600. Requests to the Publisher for permission should be addressed to the Permissions Department, John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030, (201) 748-6011, fax (201) 748-6008, or online at http://www.wiley.com/go/permissions. Limit of Liability/Disclaimer of Warranty: The publisher and the author make no representations or warranties with respect to the accuracy or completeness of the contents of this work and specifically disclaim all warranties, including without limitation warranties of fitness for a particular purpose. No warranty may be created or extended by sales or promotional materials. The advice and strategies contained herein may not be suitable for every situation. This work is sold with the understanding that the publisher is not engaged in rendering legal, accounting, or other professional services. If professional assistance is required, the services of a competent professional person should be sought. Neither the publisher nor the author shall be liable for damages arising herefrom. The fact that an organization or Web site is referred to in this work as a citation and/or a potential source of further information does not mean that the author or the publisher endorses the information the organization or Web site may provide or recommendations it may make. Further, readers should be aware that Internet Web sites listed in this work may have changed or disappeared between when this work was written and when it is read. For general information on our other products and services please contact our Customer Care Department within the United States at (877) 762-2974, outside the United States at (317) 572-3993 or fax (317) 572-4002. Wiley also publishes its books in a variety of electronic formats. Some content that appears in print may not be available in electronic books. Library of Congress Control Number: 2010923569 Trademarks: Wiley and the Wiley logo are trademarks or registered trademarks of John Wiley & Sons, Inc. and/or its affiliates, in the United States and other countries, and may not be used without written permission. Microsoft and PowerPoint are registered trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks are the property of their respective owners. Wiley Publishing, Inc. is not associated with any product or vendor mentioned in this book.
 
 To Margaret, who makes it all possible
 
 Credits Executive Editor Carol Long
 
 Vice President and Executive Group Publisher Richard Swadley
 
 Project Editor Maureen Spears Technical Editor Echo Swinford Senior Production Editor Debra Banninger
 
 Vice President and Executive Publisher Barry Pruett Associate Publisher Jim Minatel Project Coordinator, Cover
 
 Production Editor Kathleen Wisor Copy Editor Mildred Sanchez
 
 Lynsey Stanford Proofreaders Nancy Carrasco Jen Larsen, Word One
 
 Editorial Director Robyn B. Siesky Editorial Manager Mary Beth Wakefield
 
 Corina Copp, Word One Indexer Robert Swanson
 
 Marketing Manager Ashley Zurcher
 
 Cover Image
 
 Production Manager Tim Tate
 
 Cover Designer
 
 Joyce Haughey
 
 Michael E. Trent
 
 About the Author Faithe Wempen, M.A., is an A+ Certified hardware guru, Microsoft Office Specialist Master Instructor, and software consultant with over 90 computer books to her credit. She has taught Microsoft Office applications, including PowerPoint, to over a quarter of a million online students for corporate clients including Hewlett Packard, CNET, Sony, Gateway, and eMachines. When she is not writing, she teaches Microsoft Office classes in the Computer Technology department at Indiana University-Purdue University at Indianapolis (IUPUI), does private computer training and support consulting, and owns and operates Sycamore Knoll Bed and Breakfast in Noblesville, Indiana ( www.sycamoreknoll.com).
 
 About the Technical Editor Echo Swinford has been a Microsoft PowerPoint MVP (Most Valuable Professional) since 2000 and has been awarded for her contributions to the PowerPoint community. For a time, she worked for a medical education communications company, where she was responsible for the development of presentations as well as enduring materials and standalone learning modules for continuing medical education programs. With a master’s degree in New Media from the Indiana University — Purdue University at Indianapolis School of Informatics, she’s worked as a self-employed presentation specialist and PowerPoint trainer and consultant. Echo has been the author and technical editor on several PowerPoint books and has been a featured speaker for the PowerPoint Live user conference since its inception. When she’s not helping PowerPoint users or developing presentations, you can find her updating her website, www.echosvoice.com or engrossed in a cheap dimestore thriller on her Kindle.
 
 I
 
 was very fortunate to have a great team of experienced professionals on this book. Thanks to executive editor Carol Long for the opportunity to work on this project. Maureen Spears did a great job as my Development Editor, managing the process through some very tight deadlines, and once again my wonderful technical editor Echo Swinford came through with numerous improvements and suggestions that took the book up a notch in quality and usefulness. Thanks also to my copy editor, Mildred Sanchez, for tightening up my language and making sure I was making sense.
 
 vi
 
 Preface ...........................................................................................................................................xxix
 
 Part I: Building Your Presentation . . . . . . . . . . . . . . . . . . . . . . . . . 1 Chapter Chapter Chapter Chapter Chapter Chapter Chapter Chapter Chapter
 
 1: 2: 3: 4: 5: 6: 7: 8: 9:
 
 A First Look at PowerPoint ............................................................................................3 What Makes a Great Presentation? .............................................................................. 37 Creating and Saving Presentation Files ........................................................................57 Creating Slides and Text Boxes ....................................................................................89 Working with Layouts, Themes, and Masters ...........................................................115 Formatting Text ..........................................................................................................151 Formatting Paragraphs and Text Boxes .....................................................................187 Correcting and Improving Text ................................................................................. 213 Creating and Formatting Tables .................................................................................235
 
 Part II: Using Graphics and Multimedia Content . . . . . . . . . . 261 Chapter Chapter Chapter Chapter Chapter Chapter Chapter Chapter Chapter
 
 10: 11: 12: 13: 14: 15: 16: 17: 18:
 
 Drawing and Formatting Objects .............................................................................263 Creating SmartArt Diagrams .....................................................................................311 Using and Organizing Clip Art ................................................................................331 Working with Photographic Images ........................................................................353 Working with Charts ................................................................................................387 Incorporating Content from Other Programs ..........................................................421 Adding Sound Effects, Music, and Soundtracks ..................................................... 437 Incorporating Motion Video .....................................................................................463 Creating Animation Effects and Transitions ............................................................491
 
 Part III: Interfacing with Your Audience . . . . . . . . . . . . . . . . . .521 Chapter Chapter Chapter Chapter Chapter Chapter
 
 19: 20: 21: 22: 23: 24:
 
 Creating Support Materials .......................................................................................523 Preparing for a Live Presentation .............................................................................545 Designing User-Interactive or Self-Running Presentations ......................................577 Preparing a Presentation for Mass Distribution .......................................................607 Sharing and Collaborating ........................................................................................629 Customizing PowerPoint ..........................................................................................649
 
 Part IV: Project Labs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 673 Lab 1: Presenting Content without Bulleted Lists ........................................................................675 Lab 2: Adding Sound and Movement to a Presentation ..............................................................691 Lab 3: Creating a Menu-Based Navigation System ......................................................................709 Lab 4: Creating a Classroom Game ..............................................................................................729 Appendix: What’s on the CD-ROM? ............................................................................................749 Index ..............................................................................................................................................753
 
 vii
 
 Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxix
 
 Part I: Building Your Presentation
 
 1
 
 Chapter 1: A First Look at PowerPoint . . . . . . . . . . . . . . . . . . . . . . . . . . 3 Who Uses PowerPoint and Why? ...........................................................................................4 Sales ...............................................................................................................................4 Marketing .......................................................................................................................5 Human Resources ..........................................................................................................6 Education and Training ................................................................................................ 7 Hotel and Restaurant Management ...............................................................................8 Clubs and Organizations ...............................................................................................8 What’s New in PowerPoint 2010? ..........................................................................................9 Backstage View ..............................................................................................................9 Better Support for Video Import and Editing ............................................................10 Output to Video and DVD ......................................................................................... 11 Collaboration ...............................................................................................................11 Other Changes .............................................................................................................11 Learning Your Way around PowerPoint ...............................................................................12 Starting and Exiting PowerPoint .................................................................................12 Understanding the Screen Elements ...........................................................................14 Working with the Ribbon ...........................................................................................14 Working with Collapsible Tab Groups ............................................................16 Working with Backstage View ..........................................................................17 Working with Dialog Boxes ........................................................................................18 Changing the View ................................................................................................................20 Normal View ............................................................................................................... 20 Slide Sorter View .........................................................................................................22 Slide Show View ..........................................................................................................23 Notes Page View ..........................................................................................................24 Zooming In and Out .............................................................................................................25 Enabling Optional Display Elements ....................................................................................26 Ruler ............................................................................................................................ 27 Gridlines ...................................................................................................................... 28 Guides ..........................................................................................................................29 Color/Grayscale/Pure Black and White Views ............................................................29
 
 ix
 
 Contents
 
 Opening a New Display Window .........................................................................................30 Arranging Windows ....................................................................................................30 Switching among Windows ........................................................................................31 Using the Help System ..........................................................................................................31 Using PowerPoint Support Resources .................................................................................. 33 Understanding Product Activation ........................................................................................34 Adjusting Privacy Settings ...........................................................................................35 Summary ................................................................................................................................36
 
 Chapter 2: What Makes a Great Presentation? . . . . . . . . . . . . . . . . . . . 37 Qualities of an Effective Presentation ...................................................................................37 Developing Your Presentation Action Plan ...........................................................................38 Step 1: Identifying Your Audience and Purpose ........................................................38 Step 2: Choosing Your Presentation Method .............................................................40 Speaker-Led Presentations ................................................................................41 Self-Running Presentations ............................................................................... 42 User-Interactive Presentations ...........................................................................42 Step 3: Choosing Your Delivery Method ................................................................... 43 Step 4: Choosing a Theme That Matches Your Medium ...........................................44 Step 5: Developing the Content ................................................................................. 45 Step 6: Creating the Visual Image ..............................................................................46 Step 7: Adding Multimedia Effects .............................................................................47 Step 8: Creating the Handouts and Notes .................................................................48 Step 9: Rehearsing the Presentation ...........................................................................48 Rehearsing a Live Presentation .........................................................................48 Rehearsing a Self-Running Presentation ...........................................................49 Rehearsing a User-Interactive Presentation ...................................................... 49 Step 10: Giving the Presentation ................................................................................50 Step 11: Assessing Your Success and Refining Your Work .......................................50 Choosing and Arranging the Room ......................................................................................51 Choosing Your Attire ............................................................................................................ 53 Keeping the Audience Interested ..........................................................................................54 Speech Techniques ......................................................................................................54 Content Tips ................................................................................................................55 Managing Stage Fright ...........................................................................................................55 Summary ................................................................................................................................55
 
 Chapter 3: Creating and Saving Presentation Files . . . . . . . . . . . . . . . . 57 Starting a New Presentation ..................................................................................................57 Starting a Blank Presentation from Scratch ................................................................57 Starting a Presentation from a Template or Theme ...................................................58 Using a Sample Template .................................................................................59 Using an Online Template ................................................................................59 Using a Saved Template ....................................................................................60 Basing a New Presentation on an Existing One .........................................................61 Basing a New Presentation on Content from Another Application ...........................61
 
 x
 
 Contents
 
 Saving Your Work .................................................................................................................62 Saving for the First Time ............................................................................................63 Saving Subsequent Times ........................................................................................... 64 Changing Drives and Folders ..................................................................................... 64 Changing the Save Location (Windows 7) ...................................................... 65 Changing the Save Location (Windows Vista) .................................................66 Changing the Save Location (Windows XP) ....................................................67 Saving in a Different Format .......................................................................................68 Saving Slides as Graphics ................................................................................. 73 Saving Slide Text Only ..................................................................................... 73 Specifying Save Options ..............................................................................................73 Setting Passwords for File Access .........................................................................................75 Closing and Reopening Presentations ...................................................................................77 Closing a Presentation .................................................................................................77 Opening a Presentation ...............................................................................................78 Opening a File from a Different Program ..................................................................80 Finding a Presentation File to Open ..........................................................................82 Setting File Properties ...........................................................................................................83 Managing Files from Within PowerPoint .............................................................................85 Creating a New Folder ................................................................................................85 Copying a Presentation ...............................................................................................85 Deleting a Presentation ............................................................................................... 85 Renaming a Presentation .............................................................................................86 Mapping a Network Drive ..........................................................................................87 Summary ................................................................................................................................88
 
 Chapter 4: Creating Slides and Text Boxes . . . . . . . . . . . . . . . . . . . . . . 89 Creating New Slides ..............................................................................................................89 Creating New Slides from the Outline Pane ..............................................................89 Creating a Slide from the Slides Pane ........................................................................91 Creating a Slide from a Layout ...................................................................................91 Copying Slides .............................................................................................................92 Inserting Content from External Sources .............................................................................93 Copying Slides from Other Presentations .................................................................. 94 Inserting New Slides from an Outline ........................................................................94 Tips for Better Outline Importing ....................................................................95 Importing from Other Text-Based Formats ..................................................... 97 Post-Import Cleanup .........................................................................................97 Opening a Word Document as a New Presentation ..................................................98 Importing Text from Web Pages ................................................................................98 Managing Slides .....................................................................................................................99 Selecting Slides ............................................................................................................99 Deleting Slides .............................................................................................................99 Undoing Mistakes ......................................................................................................100 Rearranging Slides .....................................................................................................101
 
 xi
 
 Contents
 
 Using Content Placeholders ................................................................................................103 Inserting Content into a Placeholder ........................................................................104 Placeholders versus Manually Inserted Objects .......................................................104 Creating Text Boxes Manually ............................................................................................105 When Should You Use a Manual Text Box? ............................................................106 Creating a Manual Text Box .....................................................................................107 Working with Text Boxes ...................................................................................................107 Selecting Text Boxes ..................................................................................................108 Sizing a Text Box ...................................................................................................... 108 Positioning a Text Box ..............................................................................................110 Changing a Text Box’s AutoFit Behavior ................................................................. 110 Summary ..............................................................................................................................113
 
 Chapter 5: Working with Layouts, Themes, and Masters . . . . . . . . . . . 115 Understanding Layouts and Themes ..................................................................................115 Themes versus Templates .........................................................................................116 Where Themes Are Stored ........................................................................................117 Themes, Layouts, and Slide Master View .................................................................117 Changing a Slide’s Layout ...................................................................................................118 Applying a Theme ...............................................................................................................119 Applying a Theme from the Gallery .........................................................................120 Applying a Theme from a Theme or Template File ................................................122 Changing Colors, Fonts, and Effects ..................................................................................122 Understanding Color Placeholders ...........................................................................123 Switching Color Themes ...........................................................................................123 Understanding Font Placeholders .............................................................................124 Switching Font Themes ............................................................................................ 125 Changing the Effect Theme ...................................................................................... 125 Creating and Managing Custom Color and Font Themes .................................................127 Creating a Custom Color Theme ..............................................................................128 Sharing a Custom Color Theme with Others ..........................................................129 Deleting a Custom Color Theme ..............................................................................129 Creating a Custom Font Theme ...............................................................................130 Sharing a Custom Font Theme with Others ............................................................131 Deleting a Custom Font Theme ............................................................................... 131 Changing the Background .................................................................................................. 132 Applying a Background Style ................................................................................... 133 Applying a Background Fill ......................................................................................134 Working with Background Graphics ........................................................................135 Displaying and Hiding Background Graphics ................................................135 Deleting Background Graphics .......................................................................135 Adding Your Own Background Graphics ...................................................... 136 Working with Placeholders .................................................................................................136 Formatting a Placeholder ..........................................................................................137 Moving, Deleting, or Restoring Placeholders ...........................................................137
 
 xii
 
 Contents
 
 Displaying the Date, Number, and Footer on Slides ...............................................138 Date and Time .................................................................................................139 Slide Number ..................................................................................................139 Footer .............................................................................................................. 140 Don’t Show on Title Slide .............................................................................. 140 Customizing and Creating Layouts .....................................................................................140 Understanding Content Placeholders .......................................................................141 Adding a Custom Placeholder ..................................................................................141 Deleting and Restoring a Custom Placeholder .........................................................142 Overriding the Slide Master Formatting for a Layout ............................................. 143 Creating a New Layout .............................................................................................143 Renaming a Layout ................................................................................................... 144 Duplicating and Deleting Layouts ............................................................................144 Copying Layouts Between Slide Masters ..................................................................145 Managing Slide Masters .......................................................................................................145 Creating and Deleting Slide Masters ........................................................................ 146 Renaming a Slide Master ...........................................................................................146 Preserving a Slide Master ..........................................................................................147 Managing Themes ............................................................................................................... 147 Creating a New Theme .............................................................................................148 Renaming a Theme ................................................................................................... 148 Deleting a Theme ......................................................................................................148 Copying a Theme from Another Presentation ......................................................... 149 Summary ..............................................................................................................................149
 
 Chapter 6: Formatting Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151 Changing the Font .............................................................................................................. 151 Choosing the Right Fonts .........................................................................................152 Changing the Font Theme ........................................................................................154 Applying a Fixed Font ..............................................................................................155 Using the Font Dialog Box ....................................................................................... 156 Replacing Fonts .........................................................................................................156 Changing the Font Size .......................................................................................................157 Choosing the Right Sizes ..........................................................................................157 Specifying a Font Size ...............................................................................................158 Adjusting Character Spacing ...............................................................................................158 Changing Font Color/Text Fill ............................................................................................161 Applying a Text Outline .....................................................................................................162 Applying Text Attributes .....................................................................................................163 Changing Text Case ..................................................................................................166 Applying WordArt Styles ....................................................................................................167 Applying Text Effects ..........................................................................................................168 Shadow ......................................................................................................................169 Reflection ...................................................................................................................170 Glow ..........................................................................................................................171
 
 xiii
 
 Contents
 
 Bevel (3-D format) .................................................................................................... 173 3-D Rotation ..............................................................................................................176 Transform ..................................................................................................................177 Applying a Transformation .............................................................................177 Modifying a Transformation ...........................................................................178 Tips for Using the Follow Path Transformations ...........................................178 Copying Formatting with Format Painter ..........................................................................180 Inserting Symbols ................................................................................................................181 Inserting Math Equations ....................................................................................................182 Inserting a Preset Equation .......................................................................................182 Creating a New Equation ..........................................................................................182 Switching Between Professional and Linear Layout .................................................184 Formatting an Equation ............................................................................................185 Summary ..............................................................................................................................185
 
 Chapter 7: Formatting Paragraphs and Text Boxes . . . . . . . . . . . . . . . . 187 Formatting Bulleted Lists ....................................................................................................187 Bullets and the Slide Master .....................................................................................188 Using Bullet Presets ...................................................................................................189 Changing Bullet Size and Color ............................................................................... 189 Changing the Bullet Symbol .....................................................................................190 Resetting a Bullet Preset ............................................................................................191 Using a Picture Bullet ............................................................................................... 192 Formatting Numbered Lists ................................................................................................193 Using Numbering Presets ......................................................................................... 194 Changing Number Size and Color ...........................................................................194 Changing the Start Number ......................................................................................195 Setting Tabs and Indents .................................................................................................... 195 Working with Indents ...............................................................................................196 Working with Tabs ...................................................................................................197 Adjusting Line Spacing ....................................................................................................... 199 Changing Horizontal Alignment .........................................................................................200 Formatting Text Boxes ........................................................................................................201 Applying Fills and Outlines ......................................................................................201 Setting Fill Transparency ..........................................................................................203 Controlling Vertical Alignment .................................................................................205 Changing Text Box Rotation .....................................................................................207 Changing Text Direction ...........................................................................................208 Setting Internal Margins ............................................................................................209 Creating Multiple Columns ...................................................................................... 210 Summary ..............................................................................................................................211
 
 Chapter 8: Correcting and Improving Text . . . . . . . . . . . . . . . . . . . . . 213 Finding and Replacing Text ................................................................................................213 Correcting Your Spelling .....................................................................................................215
 
 xiv
 
 Contents
 
 Checking an Individual Word ..................................................................................215 Checking the Entire Presentation .............................................................................216 Setting Spelling Options ........................................................................................... 217 Working with Custom Dictionaries ..........................................................................219 Editing the Custom Dictionary .......................................................................220 Creating a New Custom Dictionary ............................................................... 221 Setting the Editing Language ..............................................................................................222 Using AutoCorrect to Fix Common Problems ...................................................................223 Using AutoFormat As You Type .........................................................................................225 Using Smart Tags ................................................................................................................ 226 Using the Research Tools ....................................................................................................228 Looking up a Word in a Dictionary .........................................................................228 Finding Synonyms and Antonyms with the Thesaurus ...........................................229 Translating Text into Another Language ..................................................................231 Using Research Sites ................................................................................................. 232 Using Business and Financial Sites ...........................................................................233 Summary ..............................................................................................................................234
 
 Chapter 9: Creating and Formatting Tables . . . . . . . . . . . . . . . . . . . . . 235 Creating a New Table ......................................................................................................... 235 Creating a Table with the Insert Table Dialog Box ................................................. 236 Creating a Table from the Table Button .................................................................. 237 Drawing a Table ........................................................................................................237 Moving around in a Table ..................................................................................................239 Selecting Rows, Columns, and Cells ..................................................................................239 Editing a Table’s Structure ..................................................................................................240 Resizing the Overall Table ........................................................................................241 Inserting or Deleting Rows and Columns ................................................................242 Merging and Splitting Cells ......................................................................................243 Applying Table Styles ..........................................................................................................243 Formatting Table Cells ........................................................................................................245 Changing Row Height and Column Width ............................................................. 245 Table Margins and Alignment .................................................................................. 246 Applying Borders .......................................................................................................246 Applying Fills ............................................................................................................248 Filling Individual Cells ................................................................................... 248 Applying an Overall Table Fill .......................................................................249 Filling a Table with a Picture .........................................................................249 Applying a Shadow to a Table ................................................................................. 253 Applying a 3-D Effect to a Table ..............................................................................254 Changing Text Alignment .........................................................................................255 Changing Text Direction ...........................................................................................256 Using Tables from Word .................................................................................................... 256 Integrating Excel Cells into PowerPoint .............................................................................257 Summary ..............................................................................................................................259
 
 xv
 
 Contents
 
 Part II: Using Graphics and Multimedia Content
 
 261
 
 Chapter 10: Drawing and Formatting Objects . . . . . . . . . . . . . . . . . . . 263 Working with the Drawing Tools .......................................................................................263 About Vector Graphics ..............................................................................................263 Drawing Lines and Shapes ........................................................................................264 Straight or Curved Lines .................................................................................266 Freeform Polygons .......................................................................................... 266 Flow-Chart Connectors ...................................................................................267 Callouts ............................................................................................................268 Action Buttons .................................................................................................268 Choosing a Different Shape ......................................................................................268 Editing a Shape’s Points ............................................................................................268 Adding Text to a Shape ............................................................................................270 Selecting Objects .................................................................................................................271 Deleting Objects ..................................................................................................................274 Moving and Copying Objects .............................................................................................274 Within a Slide ........................................................................................................... 274 From One Slide to Another ......................................................................................275 From One Presentation to Another ..........................................................................275 To Another Program .................................................................................................275 Using the Office Clipboard .......................................................................................276 Understanding Object Formatting ......................................................................................277 Resizing Objects ..................................................................................................................278 Arranging Objects ................................................................................................................280 Rotating and Flipping Objects ..................................................................................280 Snapping Objects to a Grid ......................................................................................281 Nudging Objects ....................................................................................................... 282 Aligning or Distributing Objects .............................................................................. 282 Aligning an Object in Relation to the Slide ...................................................283 Aligning Two or More Objects with One Another ........................................284 Distributing Objects ........................................................................................284 Layering Objects ........................................................................................................285 Working with Object Groups ...................................................................................286 Applying Shape or Picture Styles ........................................................................................287 Using Shape Styles ....................................................................................................287 Applying Picture Styles .............................................................................................288 Understanding Color Selection ...........................................................................................289 Applying an Object Border .................................................................................................291 Border Attributes .......................................................................................................292 Creating a Semi-Transparent Border ........................................................................293 Applying an Object Fill .......................................................................................................293 Solid Fills ...................................................................................................................293 Gradient Fills .............................................................................................................294
 
 xvi
 
 Contents
 
 Applying a One-Color Gradient Preset ..........................................................294 Applying a Custom Gradient ..........................................................................294 Texture and Picture Fills ...........................................................................................298 Background Fills ....................................................................................................... 300 Applying Object Effects .......................................................................................................301 Preset ......................................................................................................................... 301 Shadow ......................................................................................................................301 Reflection ...................................................................................................................303 Glow and Soft Edges .................................................................................................304 Bevels .........................................................................................................................305 3-D Rotation and 3-D Formatting ............................................................................306 Applying 3-D Rotation ....................................................................................307 Applying 3-D Formatting ............................................................................... 309 Tips for Creating Common 3-D Objects ........................................................309 Summary ..............................................................................................................................310
 
 Chapter 11: Creating SmartArt Diagrams . . . . . . . . . . . . . . . . . . . . . . . 311 Understanding SmartArt Types and Their Uses .................................................................311 List .............................................................................................................................312 Process .......................................................................................................................312 Cycle ..........................................................................................................................312 Hierarchy ...................................................................................................................313 Relationship ...............................................................................................................314 Matrix ........................................................................................................................ 315 Pyramid ..................................................................................................................... 315 Picture ........................................................................................................................316 Inserting a Diagram .............................................................................................................316 Editing SmartArt Text .........................................................................................................317 Modifying SmartArt Structure .............................................................................................318 Inserting and Deleting Shapes ..................................................................................318 Adding Bullets ...........................................................................................................319 Promoting and Demoting Text .................................................................................320 Changing the Flow Direction ................................................................................... 320 Reordering Shapes .....................................................................................................320 Repositioning Shapes ................................................................................................ 320 Resetting a Graphic ...................................................................................................321 Changing to a Different Diagram Layout .................................................................321 Modifying a Hierarchy Diagram Structure .........................................................................322 Inserting and Deleting Shapes ..................................................................................322 Changing a Person’s Level in the Organization .......................................................323 Controlling Subordinate Layout Options .................................................................323 Formatting a Diagram .........................................................................................................325 Applying a SmartArt Style ........................................................................................ 325 Changing SmartArt Colors ........................................................................................326 Manually Applying Colors and Effects to Individual Shapes ..................................326
 
 xvii
 
 Contents
 
 Manually Formatting the Diagram Text ...................................................................327 Making a Shape Larger or Smaller ...........................................................................327 Resizing the Entire SmartArt Graphic Object ..........................................................328 Editing in 2-D ...........................................................................................................328 Changing the Shapes Used in the Diagram ............................................................. 329 Saving a SmartArt Diagram as a Picture .............................................................................330 Summary ..............................................................................................................................330
 
 Chapter 12: Using and Organizing Clip Art . . . . . . . . . . . . . . . . . . . . . 331 Choosing Appropriate Clip Art ...........................................................................................331 About the Clip Organizer ................................................................................................... 332 Inserting Clip Art on a Slide ...............................................................................................332 Clip Art Search Methods .....................................................................................................334 Using Multiple Keywords ......................................................................................... 334 Specify Which Media File Types to Find .................................................................334 Work with Found Clips ............................................................................................335 Working with Clip Art Collections .................................................................................... 336 Opening and Browsing the Clip Organizer ..............................................................337 Using the Clip Organizer to Insert Clip Art ............................................................ 338 Creating and Deleting Folders ..................................................................................338 Moving Clips Between Collections ...........................................................................339 Cataloging Clips ........................................................................................................339 Working with CIL or MPF Files .................................................................... 341 Deleting Clips from the Clip Organizer ...................................................................342 Inserting an Image from a Scanner .......................................................................... 342 Making Clips Available Offline .................................................................................343 Strategies for Organizing Your Clips ........................................................................343 Working with Clip Keywords and Information .......................................................344 Changing the Keywords for an Individual Clip .............................................344 Changing the Keywords for Multiple Clips at Once .....................................344 Browsing for More Clips on Office.com ...................................................................345 Modifying Clip Art ..............................................................................................................348 Recoloring a Clip .......................................................................................................348 Setting a Transparent Color ......................................................................................349 Deconstructing and Editing a Clip ...........................................................................349 Summary ..............................................................................................................................351
 
 Chapter 13: Working with Photographic Images . . . . . . . . . . . . . . . . . 353 Understanding Raster Graphics .......................................................................................... 353 Resolution ..................................................................................................................355 Resolution on Preexisting Graphics Files .......................................................355 Resolution on Graphics You Scan Yourself ....................................................356 Resolution on Digital Camera Photos ............................................................ 357 Color Depth ...............................................................................................................358 File Format ................................................................................................................358
 
 xviii
 
 Contents
 
 Importing Image Files into PowerPoint ..............................................................................360 Linking to a Graphic File ......................................................................................... 361 Acquiring Images from a Scanner ............................................................................ 362 Acquiring Images from a Digital Camera .................................................................364 Capturing and Inserting Screen Shots ......................................................................364 Sizing and Cropping Photos ...............................................................................................366 Sizing a Photo ........................................................................................................... 367 Cropping a Photo ......................................................................................................368 Resetting a Photo .......................................................................................................372 Adjusting and Correcting Photos ........................................................................................372 Applying Brightness and Contrast Corrections ........................................................372 Recoloring a Picture ..................................................................................................374 Setting a Transparent Color and Removing a Background ..................................... 375 Applying Artistic Effects ............................................................................................377 Applying Picture Styles and Effects ..........................................................................377 Compressing Images ........................................................................................................... 379 Reducing Resolution and Compressing Images in PowerPoint ...............................380 Reducing Resolution with a Third-Party Utility .......................................................381 Exporting a Photo from PowerPoint to a Separate File .....................................................381 Exporting a Graphic with Save As Picture ...............................................................381 Exporting a Graphic with the Clipboard ................................................................. 382 Exporting Entire PowerPoint Slides as Graphics .....................................................382 Creating a Photo Album Layout .........................................................................................383 Creating a New Photo Album ...................................................................................383 Modifying a Photo Album ........................................................................................ 384 Summary ..............................................................................................................................385
 
 Chapter 14: Working with Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387 Understanding Charts .........................................................................................................387 Parts of a Chart .........................................................................................................388 PowerPoint 2010 versus Legacy Charts ................................................................... 389 Starting a New Chart .......................................................................................................... 391 Working with Chart Data ...................................................................................................394 Plotting by Rows versus by Columns .......................................................................394 Redefining the Data Range ........................................................................................395 Chart Types and Chart Layout Presets ...............................................................................397 Working with Labels ...........................................................................................................398 Working with Chart Titles ........................................................................................400 Working with Axis Titles ..........................................................................................400 Working with Legends ..............................................................................................402 Adding Data Labels ...................................................................................................404 Adding a Data Table .................................................................................................405 Controlling the Axes ...........................................................................................................407 Using Axis Presets .....................................................................................................407 Setting Axis Scale Options ........................................................................................408 Setting a Number Format .........................................................................................411
 
 xix
 
 Contents
 
 Formatting a Chart ..............................................................................................................413 Clearing Manually Applied Formatting ....................................................................413 Formatting Titles and Labels ....................................................................................413 Applying Chart Styles ............................................................................................... 414 Formatting the Chart Area ........................................................................................415 Formatting the Legend ..............................................................................................415 Formatting Gridlines and Walls ...............................................................................415 Formatting the Data Series ....................................................................................... 416 Rotating a 3-D Chart ...........................................................................................................417 Working with Chart Templates ..........................................................................................418 Creating a Chart Template ........................................................................................418 Applying a Chart Template .......................................................................................418 Managing Template Files ..........................................................................................418 Summary ..............................................................................................................................419
 
 Chapter 15: Incorporating Content from Other Programs . . . . . . . . . . 421 Working with External Content: An Overview ..................................................................421 Copying Content from Other Programs .............................................................................422 Using the Clipboard ..................................................................................................423 Using Drag-and-Drop ................................................................................................425 Inserting Graphics from a File ..................................................................................426 Introducing OLE ................................................................................................................. 426 Linking and/or Embedding Part of a File ................................................................ 427 Embedding an Entire File .........................................................................................429 Embedding a New File ............................................................................................. 430 Working with Linked and Embedded Objects ..................................................................432 Opening and Converting Embedded Objects ..........................................................432 Editing a Linked or Embedded Object ....................................................................432 Changing How Links Update ...................................................................................433 Breaking a Link .........................................................................................................434 Changing the Referenced Location of a Link ...........................................................434 Exporting PowerPoint Objects to Other Programs ............................................................435 Summary ..............................................................................................................................435
 
 Chapter 16: Adding Sound Effects, Music, and Soundtracks . . . . . . . . 437 How PowerPoint Uses Sounds ............................................................................................437 Understanding Sound File Formats ..........................................................................438 Where to Find Sounds ..............................................................................................439 When to Use Sounds — and When Not to ..............................................................439 Inserting a Sound File as an Icon .......................................................................................440 Choosing a Sound from the Clip Art Task Pane .....................................................440 Choosing a Sound from a File ..................................................................................443 Configuring Sound Playback .............................................................................................. 444 Adjusting Basic Playback Settings .............................................................................444 Setting a Clip to Play on Mouse Click or Mouseover ............................................. 445 Fine-Tuning Playback Settings in the Animation Pane ........................................... 446 Controlling When a Clip Will Play ..........................................................................447
 
 xx
 
 Contents
 
 Delaying or Repeating a Sound ................................................................................448 Choosing the Starting and Ending Point for a Sound Clip .....................................449 Setting the Starting Point with Effect Options ...............................................450 Setting the Starting and Ending Point by Trimming .....................................450 Adjusting the Fade Duration ....................................................................................451 Setting a Clip to Continue across Multiple Slides ...................................................452 Specifying the Sound Volume .................................................................................. 453 Changing the Appearance of the Sound Icon ..........................................................454 Assigning a Sound to an Object .........................................................................................454 Adding a Digital Music Soundtrack ....................................................................................455 Adding a CD Audio Soundtrack .........................................................................................456 Adding the Insert CD Audio Command to the Quick Access Toolbar ..................456 Placing a CD Soundtrack Icon on a Slide ................................................................457 Controlling When a CD Track Plays ........................................................................459 Using the Advanced Timeline to Fine-Tune Sound Events ...............................................459 Recording Sounds ................................................................................................................461 Summary ..............................................................................................................................461
 
 Chapter 17: Incorporating Motion Video . . . . . . . . . . . . . . . . . . . . . . . 463 Understanding Video Types ................................................................................................463 Adobe Flash Media ................................................................................................... 464 Animated GIF ............................................................................................................464 Choosing a File Format for Your Video Recordings ................................................465 Balancing Video Impact with File Size and Performance ........................................465 Locating Video Clips .................................................................................................466 Placing a Video on a Slide ..................................................................................................467 Inserting a Video from a File ....................................................................................467 Managing Video Links .............................................................................................. 469 Inserting a Clip as an Object ....................................................................................469 Inserting a Video from the Clip Organizer ..............................................................470 Linking to an Internet Video ....................................................................................472 Managing Videos Between PCs and PowerPoint Versions .................................................473 Working with Older Presentations in PowerPoint 2010 .........................................473 Working with PowerPoint 2010 Presentations in Older Versions ..........................474 Changing the Video’s Formatting .......................................................................................475 Choosing the Size of the Video Clip Window .........................................................475 Setting the Initial Image (Poster Frame) .................................................................. 476 Choosing an External Poster Frame ...............................................................476 Choosing a Video Frame as the Poster Frame ..................................................476 Resetting the Poster Frame .............................................................................476 Applying Corrections and Color Washes .................................................................476 Applying Video Styles and Effects ............................................................................478 Compressing Media Clips .........................................................................................478 Specifying Playback Options ...............................................................................................479 Displaying or Hiding Playback Controls ..................................................................479 Choosing a Start Trigger ...........................................................................................480
 
 xxi
 
 Contents
 
 Making a Clip Play Automatically or On Click .............................................480 Playing the Clip on Mouseover ......................................................................480 Triggering Play by Clicking Another Object ..................................................481 Choosing Clip Playback Options ..............................................................................482 Controlling the Volume ............................................................................................483 Trimming the Clip ....................................................................................................483 Setting Fade In and Fade Out Durations .................................................................485 Setting a Bookmark ...................................................................................................485 Troubleshooting Video Problems ........................................................................................487 Troubleshooting Videos That Won’t Play ................................................................ 487 Troubleshooting Poor Playback Quality ...................................................................488 Summary ..............................................................................................................................488
 
 Chapter 18: Creating Animation Effects and Transitions . . . . . . . . . . . . 491 Assigning Transitions to Slides ...........................................................................................492 Setting Transition Effects and Timings .....................................................................492 More about Transition Sounds .................................................................................494 Rehearsing and Recording Transition Timings ........................................................ 495 Animating Slide Content .....................................................................................................497 Animation: A First Look ...........................................................................................497 Choosing an Animation Effect ..................................................................................499 Changing an Effect’s Direction ................................................................................. 500 Setting Animation Timing .........................................................................................500 Copying Animation ...................................................................................................502 Special Options for Text Animation .........................................................................502 Changing the Grouping Level ........................................................................ 502 Animating Each Individual Word or Letter ...................................................503 Removing an Animation Effect .................................................................................504 Assigning Multiple Animation Effects to a Single Object ........................................504 Reordering Animation Effects ...................................................................................505 Setting Animation Event Triggers .............................................................................505 Associating Sounds with Animations ....................................................................... 507 Making an Object Appear Differently after Animation ............................................508 Working with Motion Paths .....................................................................................509 Using a Preset Motion Path ............................................................................509 Editing a Motion Path .....................................................................................511 Drawing a Custom Motion Path .....................................................................512 Animating Parts of a Chart .......................................................................................512 Controlling Animation Timing with the Advanced Timeline ..................................516 Animation Tips ..........................................................................................................516 Layering Animated Objects .................................................................................................518 Summary ..............................................................................................................................519
 
 xxii
 
 Contents
 
 Part III: Interfacing with Your Audience
 
 521
 
 Chapter 19: Creating Support Materials . . . . . . . . . . . . . . . . . . . . . . . 523 The When and How of Handouts ......................................................................................523 Creating Handouts .............................................................................................................. 524 Choosing a Layout ....................................................................................................524 Printing Handouts .....................................................................................................525 Setting Printer-Specific Options ................................................................................528 Using the Handout Master ........................................................................................530 Setting the Number of Slides Per Page .................................................................... 530 Using and Positioning Placeholders ......................................................................... 532 Setting Handout and Slide Orientation ....................................................................533 Formatting Handouts ................................................................................................534 Creating Speaker Notes .......................................................................................................535 Typing Speaker Notes ...............................................................................................535 Changing the Notes Page Layout ............................................................................. 536 Printing Notes Pages .................................................................................................537 Printing an Outline ............................................................................................................. 538 Exporting Handouts or Notes Pages to Word ................................................................... 538 Changing the Margins in Word ................................................................................540 Change the Table Alignment ....................................................................................540 Change Alignment Within a Cell .............................................................................540 Resize Rows and Columns ........................................................................................541 Turn On/Off Cell Borders .........................................................................................541 Apply a Background ..................................................................................................541 Resize the Graphics ...................................................................................................542 Summary ..............................................................................................................................543
 
 Chapter 20: Preparing for a Live Presentation . . . . . . . . . . . . . . . . . . . 545 Starting and Ending a Show ...............................................................................................545 Using the On-Screen Show Controls ..................................................................................546 Moving from Slide to Slide .......................................................................................548 Jumping to Specific Slides ........................................................................................549 Blanking the Screen .................................................................................................. 550 Using the On-Screen Pen ....................................................................................................551 Hiding Slides for Backup Use .............................................................................................553 Hiding and Unhiding Slides .....................................................................................553 Showing a Hidden Slide During a Presentation .......................................................554 Using Custom Shows ..........................................................................................................554 Ideas for Using Custom Shows .................................................................................556 Creating Custom Shows ............................................................................................557 Editing Custom Shows ..............................................................................................558 Copying Custom Shows ............................................................................................559 Deleting Custom Shows ............................................................................................559
 
 xxiii
 
 Contents
 
 Displaying a Custom Show .......................................................................................559 Navigating to a Custom Show ........................................................................559 Navigating Back to the Main Show ................................................................560 Creating a Hyperlink to a Custom Show .......................................................560 Using a Custom Show as the Main Presentation .....................................................563 Creating and Using Sections ...............................................................................................564 Creating a Section Break ...........................................................................................564 Renaming a Section ...................................................................................................565 Deleting a Section ..................................................................................................... 565 Reordering Sections ...................................................................................................565 Giving a Presentation on a Different Computer .................................................................566 Copying a Presentation to CD ..................................................................................566 Creating a CD Containing Multiple Presentation Files ............................................568 Setting Copy Options ................................................................................................569 Copying a Presentation to Other Locations .............................................................570 Working with Audio-Visual Equipment .............................................................................571 Presenting with Two Screens ....................................................................................571 Configuring Display Hardware for Multi-Screen Viewing .......................................572 Setting Up a Presentation for Two Screens ..............................................................573 Presenting with Two Screens Using Presenter View ................................................574 Summary ..............................................................................................................................575
 
 Chapter 21: Designing User-Interactive or Self-Running Presentations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 577 Understanding User Interactivity ........................................................................................578 Navigational Control Basics ................................................................................................579 Types of Navigational Controls ................................................................................ 579 Evaluating Your Audience’s Needs ...........................................................................580 Creating Text Hyperlinks ....................................................................................................581 Typing a Bare Hyperlink ...........................................................................................581 Creating a Friendly Text Hyperlink ......................................................................... 582 Choosing the Hyperlink Address ............................................................................. 583 Creating a Link to a Slide in This Presentation .............................................584 Creating a Link to a Web or FTP Site ...........................................................585 Creating a Link to a File on Your Hard Disk or Network ............................585 Creating a Link to an Application for Creating a New Document ...............586 Creating a Link to an E-Mail Address ............................................................588 Editing or Removing Hyperlink ............................................................................... 589 Creating Graphical Hyperlinks ...........................................................................................590 Creating a Graphical Hyperlink with Action Settings ............................................. 590 Creating a Graphical Hyperlink with Insert Hyperlink ...........................................591 Using Action Buttons ..........................................................................................................591 Placing an Action Button on a Slide ........................................................................ 592 Adding Text to a Blank Action Button .....................................................................595 Formatting and Changing the Shape of an Action Button ......................................596 Creating Your Own Action Buttons ......................................................................... 596
 
 xxiv
 
 Contents
 
 Creating Self-Running Presentations ...................................................................................597 Recording Narration and Timings ......................................................................................598 Setting Up the Microphone ...................................................................................... 599 Recording the Presentation .......................................................................................600 Re-Recording Narration for Certain Slides ...............................................................601 Removing Narration ..................................................................................................602 Using Kiosk Mode ...............................................................................................................602 Setting Up a Secure System ................................................................................................603 Securing Your Hardware ...........................................................................................604 Making Sure the Presentation Continues to Run .....................................................604 Summary ..............................................................................................................................605
 
 Chapter 22: Preparing a Presentation for Mass Distribution . . . . . . . . 607 Working with File Properties ............................................................................................. 607 Changing a File’s Properties ..................................................................................... 607 Removing Personal Information from a File ............................................................609 Checking for Compatibility and Usability ..........................................................................612 Assessing Prior-Version Compatibility ......................................................................612 Checking Accessibility ...............................................................................................613 Compressing Media ...................................................................................................614 Limiting User Access to a Presentation ..............................................................................615 Finalizing a Presentation ...........................................................................................615 Encrypting a File with a Password ...........................................................................616 Restricting Permissions ............................................................................................. 616 Setting Up Information Rights Management ..................................................616 Restricting Access to the Presentation ............................................................617 Removing Restrictions .....................................................................................619 Publishing a Presentation on a CD or DVD .......................................................................619 Copying to Other Locations ..................................................................................... 621 Including Multiple Presentations ..............................................................................622 Setting Copy Options ................................................................................................622 Using a Packaged CD ................................................................................................623 Converting a Presentation to a Video File ......................................................................... 624 Making a Movie DVD of a Presentation .............................................................................625 Broadcasting a Slide Show ..................................................................................................626 Working with the PowerPoint Viewer ................................................................................626 Downloading the PowerPoint Viewer .......................................................................627 Playing a Presentation with the PowerPoint Viewer ................................................627 Summary ..............................................................................................................................627
 
 Chapter 23: Sharing and Collaborating . . . . . . . . . . . . . . . . . . . . . . . . 629 Working with Comments ................................................................................................... 629 Adding Comments ....................................................................................................629 Printing Comments ...................................................................................................630 Reviewing and Deleting Comments ..........................................................................630 Comparing and Merging Presentations .............................................................................. 632 Sharing Your Presentation File on a LAN ..........................................................................633
 
 xxv
 
 Contents
 
 Saving to a Network Drive ....................................................................................... 633 Sharing a Folder on the Network .............................................................................633 Folder Sharing in Windows 7 with a Homegroup ........................................634 Folder Sharing in Windows 7 without a Homegroup ...................................634 Folder Sharing in Windows Vista .................................................................. 635 Folder Sharing in Windows XP ......................................................................637 Sending a Presentation via E-Mail ......................................................................................638 Sharing a Presentation with Windows Live ....................................................................... 639 Creating a SharePoint Slide Library ....................................................................................642 Creating a Slide Library ............................................................................................643 Placing Slides into a Slide Library from PowerPoint ...............................................643 Placing Slides into a Slide Library from the SharePoint Web Interface ..................645 Working with Slide Properties in a Library .............................................................645 Setting Properties for a Single Slide ...............................................................645 Setting Properties for Multiple Slides at Once ...............................................646 Pulling Slides from the Library to PowerPoint ........................................................646 Summary ..............................................................................................................................647
 
 Chapter 24: Customizing PowerPoint . . . . . . . . . . . . . . . . . . . . . . . . . 649 Setting Program Defaults .....................................................................................................649 Configuring the Trust Center ............................................................................................. 649 Setting Up Trusted Locations ...................................................................................654 Working with Trusted Publishers ............................................................................ 656 Trusted Document and Protected View Settings ..................................................... 656 Add-Ins ......................................................................................................................657 ActiveX Settings .........................................................................................................657 Macro Settings ...........................................................................................................658 Message Bar ...............................................................................................................658 File Block Settings .....................................................................................................659 Privacy Options .........................................................................................................659 Customizing the Ribbon .....................................................................................................660 Minimizing the Ribbon .............................................................................................660 Displaying or Hiding Ribbon Tabs ...........................................................................660 Creating or Deleting a Tab or a Custom Group ......................................................661 Creating a Custom Tab ...................................................................................661 Creating a Custom Group .............................................................................. 662 Adding or Removing Commands .............................................................................663 Adding a Command ........................................................................................663 Removing a Command ................................................................................... 664 Renaming or Reordering Tabs ..................................................................................664 Resetting Customizations ..........................................................................................664 Importing and Exporting Customization Settings ................................................... 665 Exporting Customization ................................................................................665 Importing Customization ................................................................................665
 
 xxvi
 
 Contents
 
 Customizing the Quick Access Toolbar .............................................................................666 Adding Common Commands ...................................................................................666 Adding Already-Available Commands to the QAT ..................................................666 Removing Commands from the QAT .......................................................................667 Adding Other Commands to the QAT .....................................................................667 Managing Add-Ins ...............................................................................................................668 Enabling/Disabling COM Add-Ins ............................................................................670 Enabling/Disabling Smart Tags .................................................................................670 Enabling/Disabling PowerPoint Add-Ins .................................................................. 670 Customizing the Status Bar .................................................................................................670 Summary ..............................................................................................................................671
 
 Part IV: Project Labs
 
 673
 
 Lab 1: Presenting Content without Bulleted Lists . . . . . . . . . . . . . . . . 675 Lab 1A: Using Shapes as Text Boxes ..................................................................................675 Lab 1B: Converting Bullets to SmartArt .............................................................................688
 
 Lab 2: Adding Sound and Movement to a Presentation . . . . . . . . . . . . 691 Lab Lab Lab Lab Lab
 
 2A: Fading Text and Graphics In and Out .................................................................691 2B: Replacing One Picture with Another ....................................................................698 2C: Zooming In on a Picture ...................................................................................... 701 2D: More Animation Practice ......................................................................................702 2E: Using Transitions and Soundtracks ......................................................................706
 
 Lab 3: Creating a Menu-Based Navigation System . . . . . . . . . . . . . . . . 709 The Scenario ........................................................................................................................709 Lab 3A: Making Room for a Navigation Bar ......................................................................709 Lab 3B: Creating a Navigation Bar .....................................................................................718 Lab 3C: Creating a Graphical Navigation System ..............................................................722
 
 Lab 4: Creating a Classroom Game . . . . . . . . . . . . . . . . . . . . . . . . . . . 729 The Scenario ........................................................................................................................729 Lab 4A: Making the Game Board .......................................................................................729 Lab 4B: Creating the Question Slides .................................................................................735 Lab 4C: Creating the Answer Slides ...................................................................................739 Lab 4D: Linking Up the Game Board ................................................................................743
 
 Appendix: What’s on the CD-ROM? . . . . . . . . . . . . . . . . . . . . . . . . . . 749 Files on This CD .................................................................................................................749 Templates and Backgrounds .....................................................................................749 Project Lab Files ........................................................................................................751 System Requirements ..........................................................................................................751 Using the CD .......................................................................................................................751 Technical Support ...............................................................................................................752
 
 Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 753
 
 xxvii
 
 S
 
 ome books zoom through a software program so fast it makes your head spin. You’ll come out dizzy, but basically able to cobble together some sort of result, even if it doesn’t look quite right. This is not one of those books.
 
 The PowerPoint 2010 Bible is probably the only PowerPoint book you will ever need. In fact, it might even be the only book on giving presentations you’ll ever need. No, seriously! I mean it. As you probably guessed by the heft of the book, this is not a quick-fix shortcut to PowerPoint expertise. Instead, it’s a thoughtful, thorough educational tool that can be your personal trainer now and your reference text for years to come. That’s because this book covers PowerPoint from ‘‘cradle to grave.’’ No matter what your current expertise level with PowerPoint, this book brings you up to the level of the most experienced and talented PowerPoint users in your office. You might even be able to teach those old pros a thing or two! But this book doesn’t stop with PowerPoint procedures. Creating a good presentation is much more than just clicking a few dialog boxes and typing some text. It requires knowledge and planning — lots of it. That’s why this book includes a whole chapter on planning a presentation, and another whole chapter on the practical issues involved in presenting one. You learn things like the following: 
 
 How to select the best color schemes for selling and informing
 
 
 
 How to gauge the size of the audience and the meeting room when selecting fonts
 
 
 
 How to arrange the tables and chairs in the meeting room to encourage (or discourage) audience participation
 
 
 
 How to choose what to wear for a live presentation
 
 
 
 How to overcome stage fright
 
 And lots more! When you finish this book, you will not only be able to build a presentation with PowerPoint, but you’ll also be able to explain why you made the choices you did, and you’ll deliver that presentation smoothly and with confidence. If you are planning a presentation for remote delivery (for example, posting it on a Web site or setting up a kiosk at a trade show), you’ll find lots of help for these situations too. In fact, an entire section of the book is devoted to various nontraditional presentation methods, such as live Internet or network delivery, trade show booths, and interactive presentation distribution on a disk or CD.
 
 xxix
 
 Preface
 
 How This Book Is Organized This book is organized into parts, which are groups of chapters that deal with a common general theme. Here’s what you’ll find: 
 
 Part I: Building Your Presentation. In this part, you start building a robust, content-rich presentation by choosing a template, entering your text, and applying text formatting.
 
 
 
 Part II: Using Graphics and Multimedia Content. This part teaches you how to import and create various types of graphical and multimedia content including clip art, diagrams, photos, charts, sound effects, movies, and music. You’ll also learn here how to create movement with animation effects and transitions.
 
 
 
 Part III: Interfacing with Your Audience. This part helps you prepare your presentation for various delivery scenarios, including printing handouts for a live audience, running a live show on a computer screen, designing visual aids for user-interactive or self-running presentations, and sharing a collaborating with others.
 
 
 
 Part IV: Project Labs. This part provides four step-by-step walkthroughs that demonstrate how to create some of the most powerful and sought-after PowerPoint effects and projects, including creating navigation systems, classroom games, complex animations, and graphically presented text.
 
 What’s on the companion CD-ROM The CD-ROM included with PowerPoint 2010 Bible contains more than 500 PowerPoint templates and backgrounds that you can use to design your own PowerPoint presentations. If you aren’t familiar with how to choose a background or template for your presentation, be sure to read Chapter 3 in this book, which discusses templates, and Chapter 5, which includes the backgrounds discussion, before attempting to use the CD-ROM. Please see the CD-ROM Appendix for more information on the professional designers who supplied the templates for your use. The CD-ROM also contains author files for use in the Project Labs in Part IV.
 
 Special Features Every chapter in this book opens with a quick look at what’s in the chapter and closes with a summary. Along the way, you also find icons in the margins to draw your attention to specific topics and items of interest. Here’s what the icons mean:
 
 Cross-Reference These icons point you to chapters or other sources for more information on the topic under discussion. 
 
 Note Notes provide extra information about a topic, perhaps some technical tidbit or background explanation. 
 
 xxx
 
 Preface
 
 Tip Tips offer ideas for the advanced user who wants to get the most out of PowerPoint. 
 
 Caution Cautions point out how to avoid the pitfalls that beginners commonly encounter. 
 
 Good luck with PowerPoint 2010! I hope you have as much fun reading this book as I had writing it. If you would like to let me know what you thought of the book, good or bad, you can e-mail me at [email protected]. I’d like to hear from you!
 
 xxxi
 
 Part I Building Your Presentation IN THIS PART Chapter 1 A First Look at PowerPoint
 
 Chapter 6 Formatting Text
 
 Chapter 2 What Makes a Great Presentation?
 
 Chapter 7 Formatting Paragraphs and Text Boxes
 
 Chapter 3 Creating and Saving Presentation Files Chapter 4 Creating Slides and Text Boxes Chapter 5 Working with Layouts, Themes, and Masters
 
 Chapter 8 Correcting and Improving Text Chapter 9 Creating and Formatting Tables
 
 A First Look at PowerPoint
 
 P
 
 owerPoint 2010 is a member of the Microsoft Office 2010 suite of programs. A suite is a group of programs designed by a single manufacturer to work well together. Like its siblings — Word (the word processor), Excel (the spreadsheet), Outlook (the personal organizer and e-mail manager), and Access (the database) — PowerPoint has a well-defined role. It creates materials for presentations. A presentation is any kind of interaction between a speaker and audience, but it usually involves one or more of the following visual aids: 35mm slides, overhead transparencies, computer-based slides (either local or at a Web site or other network location), hard-copy handouts, and speaker notes. PowerPoint can create all of these types of visual aids, plus many other types that you’ll learn about as you go along. Because PowerPoint is so tightly integrated with the other Microsoft Office 2010 components, you can easily share information among them. For example, if you have created a graph in Excel, you can use that graph on a PowerPoint slide. It goes the other way, too. You can, for example, take the outline from your PowerPoint presentation and copy it into Word, where you can dress it up with Word’s powerful document formatting commands. Virtually any piece of data in any Office program can be linked to any other Office program, so you never have to worry about your data being in the wrong format. PowerPoint also accepts data from almost any other Windows-based application, and can import a variety of graphics, audio, and video formats. In this chapter you’ll get a big-picture introduction to PowerPoint 2010, and then we’ll fire up the program and poke around a bit to help you get familiar with the interface. You’ll find out how to use the tabs and panes, and how to get help and updates from Microsoft.
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 IN THIS CHAPTER Who uses PowerPoint and why? What’s new in PowerPoint 2010? Learning your way around PowerPoint Changing the view Zooming in and out Displaying and hiding screen elements Working with window controls Using the help system and getting updates
 
 Part I: Building Your Presentation
 
 Who Uses PowerPoint and Why? PowerPoint is a popular tool for people who give presentations as part of their jobs, and also for their support staff. With PowerPoint, you can create visual aids that help get the message across to an audience, whatever that message may be and whatever format it may be presented in. Although the traditional kind of presentation is a live speech presented at a podium, advances in technology have made it possible to give several other kinds of presentations, and PowerPoint has kept pace nicely. The following list outlines the most common PowerPoint formats: 
 
 Podium: For live presentations, PowerPoint helps the lecturer emphasize key points through the use of overhead transparencies, 35mm slides, or computer-based shows.
 
 
 
 Kiosk shows: These are self-running presentations that provide information in an unattended location. You have probably seen such presentations listing meeting times and rooms in hotel lobbies and as sales presentations at trade show booths.
 
 
 
 CDs and DVDs: You can package a PowerPoint presentation on a CD or DVD and distribute it with a press release, a marketing push, or a direct mail campaign. The presentation can be in PowerPoint format, or can be converted to Web format or even a movie clip, for distribution.
 
 
 
 Internet formats: You can use PowerPoint to create a show that you can present live over a network or the Internet with a service such as PowerPoint Live, while each participant watches from his or her own computer. You can even store a self-running or interactive presentation on a Web site in a variety of formats and make it available for the public to download and run on a PC.
 
 When you start your first PowerPoint presentation, you may not be sure which delivery method you will use. However, it’s best to decide the presentation format before you invest too much work in your materials, because the audience’s needs are different for each medium.
 
 Cross-Reference You learn more about planning your presentation in Chapter 2. 
 
 Most people associate PowerPoint with sales presentations, but PowerPoint is useful for people in many other lines of work as well. The following sections present a sampling of how real people just like you are using PowerPoint in their daily jobs.
 
 Sales More people use PowerPoint for selling goods and services than for any other reason. Armed with a laptop computer and a PowerPoint presentation, a salesperson can make a good impression on a client anywhere in the world. Figure 1-1 shows a slide from a sample sales presentation. Sales possibilities with PowerPoint include the following: 
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 Live presentations in front of clients with the salesperson present and running the show. This is the traditional kind of sales pitch that most people are familiar with.
 
 Chapter 1: A First Look at PowerPoint
 
 
 
 Self-running presentations that flip through the slides at specified intervals so that passersby can read them or ignore them as they wish. These types of presentations are great for grabbing people’s attention at trade show booths.
 
 
 
 User-interactive product information demos distributed on CD/DVD that potential customers can view at their leisure on their own PCs. This method is very inexpensive, because you can create a single presentation and distribute it by mail to multiple customers.
 
 FIGURE 1-1
 
 PowerPoint offers unparalleled flexibility for presenting information to potential customers.
 
 Cross-Reference See Chapter 20 to learn about controlling a live presentation. You create a self-running or user-interactive presentation in Chapter 21. 
 
 Marketing The distinction between sales and marketing can be rather blurred at times, but marketing generally refers to the positioning of a product in the media rather than its presentation to a particular company or individual. Marketing representatives are often called upon to write advertising copy, generate camera-ready layouts for print advertisements, design marketing flyers and shelf displays, and produce other creative selling materials.
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 Part I: Building Your Presentation
 
 PowerPoint is not a drawing program per se, and it can’t substitute for one except in a crude way. However, by combining the Office 2010 clip art collection and drawing tools with some well-chosen fonts and borders, a marketing person can come up with some very usable designs in PowerPoint. Figure 1-2 shows an example. You learn about clip art in Chapter 12. You can also integrate video clips in PowerPoint presentations that can tell the story of your product; see Chapter 17 for more information.
 
 FIGURE 1-2
 
 PowerPoint can generate camera-ready marketing materials, although they can’t substitute for the tools that professional advertising companies use.
 
 Human Resources Human resources personnel often find themselves giving presentations to new employees to explain the policies and benefits of the company. A well-designed, attractive presentation gives the new folks a positive impression of the company they have signed up with, starting them off on the right foot. One of the most helpful features in PowerPoint for the human resources professional is the Organization Chart tool. With it, you can easily diagram the structure of the company and make changes whenever necessary with a few mouse clicks. Figure 1-3 shows an organization chart on
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 a PowerPoint slide. You can also create a variety of other diagram types. Organization charts and other diagrams are covered in Chapter 11. FIGURE 1-3
 
 Microsoft’s Organization Chart lets you easily create organizational diagrams from within PowerPoint.
 
 Education and Training Most training courses include a lecture section in which the instructor outlines the general procedures and policies. This part of the training is usually followed up with individual, hands-on instruction. PowerPoint can’t help much with the latter, but it can help make the lecture portion of the class go smoothly. If you have access to a scanner, you can scan in diagrams and drawings of the objects you are teaching the students to use. You can also use computer-generated images, such as screen captures and video clips, to teach people about software. PowerPoint’s interactive controls even let you create quizzes that each student can take on-screen to gauge his or her progress. Depending on the button the student clicks, you can set up the quiz to display a ‘‘Yes, you are correct!’’ or ‘‘Sorry, try again’’ slide. See Figure 1-4. For details about this procedure, see Chapter 21 and Lab 4 in the Project Labs section at the end of the book.
 
 7
 
 Part I: Building Your Presentation
 
 FIGURE 1-4
 
 Test the student’s knowledge with a user-interactive quiz in PowerPoint.
 
 Hotel and Restaurant Management Service organizations such as hotels and restaurants often need to inform their customers of various facts but need to do so unobtrusively so that the information will not be obvious except to those looking for it. For example, a convention center hotel might provide a list of the meetings taking place in its meeting rooms, or a restaurant might show pictures of the day’s specials on a video screen in the waiting area. In such unattended situations, a self-running (kiosk) presentation works best. Typically the computer box and keyboard are hidden from passersby, and the monitor displays the information.
 
 Cross-Reference You learn more about kiosk setups in Chapter 21. 
 
 Clubs and Organizations Many nonprofit clubs and organizations, such as churches and youth centers, operate much the same way as for-profit businesses and need sales, marketing, and informational materials. But clubs and organizations often have special needs too, such as the need to recognize
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 volunteers for a job well done. Office online provides a Certificate template that’s ideal for this purpose. Figure 1-5 shows a certificate generated in PowerPoint. Another popular use for PowerPoint is to project the lyrics of a song on a big screen for sing-alongs at churches and meetings. FIGURE 1-5
 
 With PowerPoint, you can easily create certificates and awards.
 
 What’s New in PowerPoint 2010? PowerPoint 2010 is very much like PowerPoint 2007 in its basic functionality. It uses a tabbed Ribbon across the top, rather than a traditional menu system, and employs dialog boxes and a Quick Access Toolbar in the same ways that 2007 did. This doesn’t mean that there aren’t changes and improvements, though! The following sections outline the major differences you will see when you upgrade from PowerPoint 2007 to PowerPoint 2010.
 
 Backstage View The File tab in the upper left corner of the PowerPoint window replaces the Office button from PowerPoint 2007. Clicking it opens a full-screen File menu system, also known as Backstage view.
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 From Backstage view, you can select file operations such as saving and printing, customizing the interface, and sharing your work with others. Figure 1-6 shows Backstage view. To leave Backstage view, click any other tab.
 
 FIGURE 1-6
 
 Backstage view (a.k.a. the File menu) provides access to various file management and customization commands. Click a different tab to exit Backstage View
 
 Click a section name to display its controls
 
 Better Support for Video Import and Editing One of the features most asked for in PowerPoint has been support for more video file formats, and PowerPoint 2010 has delivered it. PowerPoint 2010 supports a wide variety of formats including QuickTime, Flash, Windows Media, and MP4. You can now also link video clips from online sources such as YouTube. Not only can you import motion video from a larger variety of sources than in earlier versions, but you can also edit videos directly from within PowerPoint. For example, you can change the brightness and contrast of a video, trim it to show only certain parts, add a bookmark in the video clip (which you can then hyperlink to, to jump to a particular spot in the video quickly), and more. Figure 1-7 shows the Format tab in PowerPoint 2010’s Video Tools.
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 FIGURE 1-7
 
 Enhanced video tools enable you to modify the video clip without leaving PowerPoint.
 
 Output to Video and DVD Another feature in high demand has been the ability to output a presentation directly to popular video formats. In the past, people have had to resort to third-party solutions, but PowerPoint 2010 includes this capability built-in. You can now output your presentation to Windows Media Video (.wmv) format, which can be played back by Windows Media Player or a variety of other utilities.
 
 Collaboration Collaborating with others on a draft presentation is now easier to do. PowerPoint now includes a Compare feature that includes revision tracking. With revision tracking you can see who has made what changes to the presentation, and review each change individually to accept or reject it, as shown in Figure 1-8.
 
 Other Changes Besides the major changes you’ve learned about in the preceding sections, there are also a number of smaller but still important improvements, including these: 
 
 New photo editing tools allow you to apply artistic filters to pictures, remove backgrounds, and crop with more precision.
 
 
 
 New transition effects are available in PowerPoint 2010, and they are now easier to apply, thanks to the new Transitions tab on the Ribbon.
 
 
 
 You can now insert math equations into a presentation with the Microsoft Office Equation Editor. Equation editing was revamped in some of the other Office applications in Office 2007, but PowerPoint is only now getting the new and improved equation interface.
 
 
 
 You can customize the Ribbon by adding, removing, and rearranging commands and tabs. This is a new feature across all of the Office 2010 applications, and very welcome to power users who like to control their working environment on-screen.
 
 
 
 Presentation broadcasting is much improved in PowerPoint 2010 because of its integration with the Web-based PowerPoint Live service.
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 FIGURE 1-8
 
 You can track changes to a presentation draft to organize the work of multiple collaborators.
 
 Comment
 
 Learning Your Way around PowerPoint Now that you have seen some of the potential uses for PowerPoint and toured the new features, let’s get started using the program. PowerPoint is one of the easiest and most powerful presentation programs available. You can knock out a passable presentation in a shockingly short time by skimming through the chapters in Parts I and II of the book, or you can spend some time with PowerPoint’s advanced features to make a complex presentation that looks, reads, and works exactly the way you want.
 
 Starting and Exiting PowerPoint You can start PowerPoint just like any other program in Windows: from the Start menu. Follow these steps: 1. Click the Start button. The Start menu opens. 2. Click All Programs.
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 3. Click Microsoft Office. 4. Click Microsoft PowerPoint 2010. The program starts. If you have opened PowerPoint before, a shortcut to it might appear in the Recently Used Programs list, which is directly above the All Programs command on the Start menu. If you use other applications more frequently than PowerPoint, PowerPoint may scroll off this list and you therefore have to access it via the All Programs menu.
 
 Tip If you don’t want to worry about PowerPoint scrolling off the list of the most frequently used programs on the Start menu, right-click PowerPoint’s name on the Start menu and choose Pin to Start Menu. PowerPoint will then appear on the list at the top of the left column of the Start menu, as shown in Figure 1-9. To remove it from there later, right-click it and choose Unpin from Start Menu.  FIGURE 1-9
 
 A shortcut to PowerPoint might appear on the top level of the Start menu. If you have Windows 7, recently opened PowerPoint files appear here.
 
 Right-click PowerPoint and choose Pin to Start Menu
 
 When you are ready to leave PowerPoint, select File ➪ Exit or click the Close (X) button in the top-right corner of the PowerPoint window. (The File button is the orange tab in the top-left corner.) If you have any unsaved work, PowerPoint asks if you want to save your changes. Because you have just been playing around in this chapter, you probably do not have anything to save yet. (If you do have something to save, see Chapter 3 to learn more about saving.) Otherwise, click No to decline to save your changes, and you’re outta there.
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 Understanding the Screen Elements PowerPoint’s interface is typical of any Windows program in many ways, but it also has some special Office 2010–specific features as well. The PowerPoint window contains these elements, pointed out in Figure 1-10: 
 
 Title bar: Identifies the program running (PowerPoint) and the name of the active presentation. If the window is not maximized, you can move the window by dragging the title bar.
 
 
 
 Ribbon: Functions as a combination of menu bar and toolbar, offering tabbed ‘‘pages’’ of buttons, lists, and commands. The next section describes it in more detail.
 
 
 
 File tab: Opens the File menu (Backstage view), from which you can open, save, print, and start new presentations.
 
 
 
 Quick Access Toolbar: Contains shortcuts for some of the most common commands. You can add your own favorites here as well.
 
 
 
 Minimize button: Shrinks the application window to a bar on the Windows taskbar; you click its button on the taskbar to reopen it.
 
 
 
 Maximize/Restore button: If the window is maximized (full screen), it changes to windowed (not full screen). If the window is not maximized, clicking here maximizes it.
 
 
 
 Close button: Closes the presentation. You may be prompted to save your changes, if you made any.
 
 
 
 Work area: Where active PowerPoint slide(s) appear. Figure 1-10 shows it in Normal view, but other views are available that make the work area appear differently.
 
 Cross-Reference See the section ‘‘Changing the View’’ later in this chapter for details.  
 
 Status bar: Reports information about the presentation and provides shortcuts for changing the view and the zoom.
 
 Note Because this isn’t a Windows book, Windows controls are not covered in detail here. However, if you’re interested in learning more about Windows-based programs in general, pick up Windows 7 For Dummies or The Windows 7 Bible, also published by Wiley. Windows Vista and Windows XP versions of these books are also available. 
 
 Working with the Ribbon As mentioned earlier in the chapter, PowerPoint 2010’s user interface is based on the Ribbon, which is a bar across the top of the window that contains tabbed pages of commands and buttons. Rather than opening a menu and selecting a command, you click a tab and then click a button or open a list on that tab.
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 FIGURE 1-10
 
 The PowerPoint window is a combination of usual Windows features and unique Office 2010 elements. Quick Access Toolbar
 
 Title bar
 
 Minimize button
 
 Maximize/ Restore button
 
 Close button
 
 File tab
 
 Ribbon
 
 Work area
 
 Status bar
 
 Here are some important terms you need to know when working with tabs: 
 
 Ribbon: The whole bar, including all of the tabs.
 
 
 
 File tab: A tab-like button that opens Backstage view, from which you can choose to start a new presentation, save, print, and perform other file-related activities. See Figure 1-10 for this button’s location.
 
 
 
 Quick Access Toolbar: A small toolbar adjacent to the Office button from which you can select commonly used commands.
 
 Tip To add a command to the Quick Access Toolbar, right-click the toolbar and choose Add to Quick Access Toolbar. To remove the command from there, right-click the command icon and choose Remove from Quick Access Toolbar. 
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 Tab: A tabbed page of the Ribbon. Figure 1-11 shows the Home tab, for example.
 
 
 
 Contextual tab: A tab that appears only when certain content is selected, such as a graphic or a chart. The context name appears above the tab name. In Figure 1-11, Drawing Tools is the context name for the Format tab.
 
 FIGURE 1-11
 
 The Ribbon is PowerPoint 2010’s primary user interface. Tabs
 
 Contextual tab
 
 Groups
 
 Dialog box launcher
 
 
 
 Group: A section of a tab. The Home tab shown in Figure 1-11 has the following groups: Clipboard, Slides, Font, Paragraph, Drawing, and Editing.
 
 
 
 Dialog box launcher: A small icon in the bottom-right corner of a group, from which you can open a dialog box related to that group.
 
 Note To find out what a toolbar button does, point the mouse at it. A ScreenTip pops up explaining it. 
 
 Working with Collapsible Tab Groups Within a tab, groups can expand or collapse depending on the width of the PowerPoint window. When the window is large enough (somewhere around 1100 pixels), everything within each group is fully expanded, so that each item has its own button. When the window is smaller, groups start collapsing so that all groups remain visible. At first, large buttons get smaller and stack vertically; if that’s not enough, then groups collapse into single large buttons with drop-down lists from which you can select the individual commands. Figure 1-12 shows the same tab in three different widths for comparison.
 
 Caution Because of the Ribbon’s collapsing ability, the exact steps for performing certain procedures depend on the active PowerPoint window’s width. A small window may require an extra step of opening a button’s menu to select a command, for example. For a large window, each command appears directly on the tab. This book assumes an average window size of 1024 x 768 pixels; if you run PowerPoint at a smaller resolution, you may occasionally have an extra step to access a command. 
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 FIGURE 1-12
 
 The size of the PowerPoint window determines how much the groups are collapsed or expanded on the Ribbon.
 
 Working with Backstage View When you open Backstage view by clicking the File tab, a multilayered menu system appears. Many of the commands along the left side of the screen are categories that open submenus when you click them. For example, in Figure 1-13, the Share command has been selected, revealing additional choices. The top-level categories and commands in Backstage view are: 
 
 Save: Saves the current presentation.
 
 
 
 Save As: Saves the current presentation and prompts you for file name and location information, even if the file has been previously saved.
 
 
 
 Open: Displays the Open dialog box, from which you can select a file to open.
 
 
 
 Close: Closes the active presentation.
 
 
 
 Info: Displays information about the current presentation, including its properties. Commands are available for working with versions, permissions, and sharing.
 
 
 
 Recent: Displays a list of recently opened presentations, from which you can quickly reopen one.
 
 
 
 New: Displays a list of templates available for starting a new presentation.
 
 
 
 Print: Provides access to printing options, including setting a print range, choosing a printer, and specifying settings like color and collation.
 
 
 
 Save & Send: Offers access to features for distributing the presentation via e-mail or fax, changing the presentation type, creating PDF and XPS files, and publishing/packaging the presentation.
 
 
 
 Help: Opens a list of Help options, including links to the PowerPoint help file, online resources, and updates.
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 Options: Click here to open a dialog box where you can customize the interface, also described in Chapter 24.
 
 
 
 Exit: Choose this command to exit PowerPoint, as you learned earlier in the chapter.
 
 FIGURE 1-13
 
 In Backstage view, most of the main commands open a submenu or a dialog box.
 
 Working with Dialog Boxes PowerPoint sometimes uses dialog boxes to prompt you for more information. When you issue a command that can have many possible variations, a dialog box appears so you can specify the particulars. A dialog box can be modal or non-modal. A modal dialog box must be closed before you can continue working on the presentation. A non-modal dialog box can be left open indefinitely as you work. Most of the dialog boxes in PowerPoint 2010 are non-modal. Figure 1-14 illustrates some of the controls you may encounter in PowerPoint’s dialog boxes: 
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 Option buttons: Each section of the dialog box can have only one option button chosen at once. When you select one option button, the previously selected one becomes deselected, like on a car radio. Click the one you want.
 
 
 
 Increment buttons: Placed next to a text box, these buttons allow you to increment the number in the box up or down by one digit per click.
 
 
 
 Drop-down list: Click the down arrow next to one of these to open the list, and then click your selection from the menu that appears.
 
 
 
 Command button: Click one of these big rectangular buttons to jump to a different dialog box. OK and Cancel are also command buttons; OK accepts your changes and Cancel rejects them.
 
 In Figure 1-14, there are categories along the left side of the dialog box. Click a category to change to a different ‘‘page’’ of options. You might also sometimes see tabs at the top of a dialog box, which serve the same purpose.
 
 Cross-Reference Dialog boxes that open or save files have some special controls and icons all their own, but you learn about those in more detail in Chapter 3, where you also learn to open and save your files. 
 
 FIGURE 1-14
 
 The Format Shape dialog box illustrates several types of controls.
 
 Drop-down list
 
 Option buttons
 
 Check box
 
 Increment buttons
 
 Command button
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 Changing the View A view is a way of displaying your presentation on-screen. PowerPoint comes with several views because at different times during the creation process, it is helpful to look at the presentation in different ways. For example, when you add a graphic to a slide, you need to work closely with that slide, but when you rearrange the slide order, you need to see the presentation as a whole. PowerPoint offers the following views: 
 
 Normal: A combination of several resizable panes, so you can see the presentation in multiple ways at once. Normal is the default view.
 
 
 
 Slide Sorter: A light-table-type overhead view of all the slides in your presentation, laid out in rows, suitable for big-picture rearranging.
 
 
 
 Notes Page: A view with the slide at the top of the page and a text box below it for typed notes. (You can print these notes pages to use during your speech.)
 
 
 
 Slide Show: The view you use to show the presentation on-screen. Each slide fills the entire screen in its turn.
 
 
 
 Reading View: A simplified version of Slide Show view, which appears in a window rather than full-screen. This view is new in PowerPoint 2010.
 
 Cross-Reference This chapter covers only the five regular views. The Master views are discussed in Chapter 5. 
 
 There are two ways to change a view: Click a button on the View tab, or click one of the view buttons in the bottom-right corner of the screen, as shown in Figure 1-15. All of the views are available in both places except the Notes Page, which you can access only from the View tab, and Slide Show, which you can access only from the buttons or from the Slide Show tab (From Beginning or From Current Slide).
 
 Tip When you save, close, and reopen a file, PowerPoint opens the same view in which you left the file. To have the files always open in a particular view, choose File ➪ Options ➪ Advanced, and open the Open All Documents Using This View list and select the desired view. The options on this list include some custom versions of Normal view that have certain panes turned off. For example, you can open all documents in Normal – Outline and Slide view to always start with the Notes pane turned off. 
 
 Normal View Normal view, shown in Figure 1-16, is a very flexible view that contains a little bit of everything. In the center is the active slide, below it is a Notes pane, and to its left is a dual-use pane with two tabs: Slides and Outline. (Figure 1-15 shows the Slides tab, and Figure 1-16 shows the Outline tab.) When the Outline tab is selected, the text from the slides appears in an outline form.
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 When the Slides tab is selected, thumbnail images of all the slides appear (somewhat like Slide Sorter view, which you will see later in this chapter).
 
 FIGURE 1-15
 
 Select a view from the View tab or from the viewing controls in the bottom-right corner of the screen.
 
 View buttons
 
 Normal Slide Sorter
 
 Slide Show Reading
 
 Each of the panes in Normal view has its own scroll bar, so you can move around in the outline, the slide, and the notes independently of the other panes. You can resize the panes by dragging the dividers between the panes. For example, to give the notes area more room, point the mouse pointer at the divider line between it and the slide area so that the mouse pointer becomes a double-headed arrow, and then hold down the left mouse button as you drag the line up to a new spot. The Slides/Outline pane is useful because it lets you jump quickly to a specific slide by clicking on it. For example, you can click on any of the slide thumbnails on the Slides tab to display it in the Slide pane, as shown in Figure 1-15. You can also click on some text anywhere in the outline to jump to the slide containing that text, as shown in Figure 1-16.
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 FIGURE 1-16
 
 Normal view, the default, offers access to the outline, the slide, and the notes all at once.
 
 Slides/Outline pane
 
 Slide pane
 
 Note pane
 
 Tip In Microsoft Word, an Outlining toolbar is available when you are working on an outline. In PowerPoint, some of those same tools are available, but in a different location. You can right-click anywhere in the Outline pane to access those tools on a context menu, such as expanding and collapsing outline levels and reordering items. 
 
 You can turn the Slides/Outline pane off completely by clicking the X button in its top-right corner. This gives maximum room to the Slides pane. When you turn it off, the Notes pane disappears too. To get the extra panes back, reapply Normal view.
 
 Slide Sorter View If you have ever worked with 35mm slides, you know that it can be helpful to lay the slides out on a big table and plan the order in which to show them. You rearrange them, moving this one here, that one there, until the order is perfect. You might even start a pile of backups that you will not show in the main presentation, but will hold back in case someone asks a pertinent question. That’s exactly what you can do with Slide Sorter view, as shown in Figure 1-17. It
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 lays out the slides in miniature, so you can see the big picture. You can drag the slides around and place them in the perfect order. You can also return to Normal view to work on a slide by double-clicking the slide. FIGURE 1-17
 
 Use the Slide Sorter view for a birds-eye view of the presentation.
 
 Slide Show View When it’s time to rehearse the presentation, nothing shows you the finished product quite as clearly as Slide Show view does. In Slide Show view, the slide fills the entire screen. You can move from slide to slide by pressing the Page Up or Page Down keys, or by using one of the other movement methods available (see Figure 1-18).
 
 Cross-Reference You learn about these other movement methods in Chapter 20. 
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 You can right-click in Slide Show view to display a menu that enables you to control the show without leaving it. To leave the slide show, choose End Show from the menu or just press the Esc key. FIGURE 1-18
 
 Slide Show view lets you practice the presentation in real life. Previous slide or animation Open slide navigation menu
 
 Next slide or animation Open pointer control menu
 
 Tip When entering Slide Show view, the method you use determines which slide you start on. If you use the Slide Show View button in the bottom-right corner of the screen, the presentation will start with whatever slide you have selected. (You can also press Shift+F5 to do this, or choose Slide Show ➪ From Current Slide.) If you use the Slide Show ➪ From Beginning command, or press F5, the presentation will start at the beginning. 
 
 Notes Page View When you give a presentation, your props usually include more than just your brain and your slides. You typically have all kinds of notes and backup material for each slide — figures on last quarter’s sales, sources to cite if someone questions your data, and so on. In the old days of framed overhead transparencies, people used to attach sticky notes to the slide frames for this purpose and hope that nobody asked any questions that required diving into the four-inch-thick stack of statistics they brought. Today, you can type your notes and supporting facts directly in PowerPoint. As you saw earlier, you can type them directly into the Notes pane below the slide in Normal view. However, if you have a lot of notes to type, you might find it easier to work with Notes Page view instead. Notes Page view is accessible only from the View tab. In this view, you see a single slide (uneditable) with an editable text area below it called the notes placeholder, which you can use to type your notes. See Figure 1-19. You can refer to these notes as you give an on-screen presentation, or you can print notes pages to stack neatly on the lectern next to you during the big event. If your notes pages run off the end of the page, PowerPoint even prints them as a separate page. If you have trouble seeing the text you’re typing, zoom in on it, as described in the next section.
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 FIGURE 1-19
 
 Notes Page view offers a special text area for your notes, separate from the slides.
 
 Zooming In and Out If you need a closer look at your presentation, you can zoom the view in or out to accommodate almost any situation. For example, if you have trouble placing a graphic exactly at the same vertical level as some text in a box next to it, you can zoom in for more precision. You can view your work at various magnifications on-screen without changing the size of the surrounding tools or the size of the print on the printout. In Normal view, each of the panes has its own individual zoom. To set the zoom for the Slides/Outline pane only, for example, select it first; then choose a zoom level. Or to zoom only in the main workspace (the Slide pane), click it first. In a single-pane view such as Notes Page or Slide Sorter, a single zoom setting affects the entire work area. The larger the zoom number, the larger the details on the display. A zoom of 10% would make a slide so tiny that you couldn’t read it. A zoom of 400% would make a few letters on a slide so big they would fill the entire pane.
 
 25
 
 Part I: Building Your Presentation
 
 The easiest way to set the zoom level is to drag the Zoom slider in the bottom-right corner of the PowerPoint window, or click its plus or minus buttons to change the zoom level in increments, as shown in Figure 1-20.
 
 FIGURE 1-20
 
 Zoom in or out to see more or less of the slide(s) at once. Current Zoom
 
 Zoom slider
 
 Decrease Zoom
 
 Fit to Window
 
 Increase Zoom
 
 To resize the current slide so that it is as large as possible while still fitting completely in the Slides pane, click the Fit Slide to Current Window button, or Choose View ➪ Fit to Window. Another way to control the zoom is with the Zoom dialog box. Choose View ➪ Zoom to open it. (You can also open that dialog box by clicking the % next to the Zoom slider in the lower right corner of the screen.) Make your selection, as shown in Figure 1-21, by clicking the appropriate button, and then click OK. Notice that you can type a precise zoom percentage in the Percent text box. You can specify any percentage you like, up to 400%. (Some panes and views will not go higher than 100%.)
 
 FIGURE 1-21
 
 You can zoom with this Zoom dialog box rather than the slider if you prefer.
 
 Enabling Optional Display Elements PowerPoint has a lot of optional screen elements that you may (or may not) find useful, depending on what you’re up to at the moment. The following sections describe them.
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 Ruler Vertical and horizontal rulers around the slide pane can help you place objects more precisely. To toggle them on or off, select or deselect the Ruler check box on the View tab, as shown in Figure 1-22. Rulers are available only in Normal and Notes Page views. FIGURE 1-22
 
 Gridlines and the ruler help align objects on a slide. Toggle Gridlines on/off
 
 Toggle Rulers on/off
 
 Horizontal ruler
 
 Vertical ruler
 
 Gridlines
 
 The rulers help with positioning no matter what content type you are working with, but when you are editing text in a text frame they have an additional purpose as well. The horizontal ruler shows the frame’s paragraph indents and any custom tab stops, and you can drag the indent markers on the ruler just as you can in Word.
 
 Note The ruler’s unit of measure is controlled from the Regional Settings in the Control Panel in Windows. 
 
 Tip The vertical ruler is optional. To disable it while retaining the horizontal ruler, choose File ➪ Options, click Advanced, and in the Display section, clear the Show Vertical Ruler check box. 
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 Gridlines Gridlines are non-printing dotted lines at regularly spaced intervals that can help you line up objects on a slide. Figure 1-22 shows gridlines (and the ruler) enabled. To turn gridlines on or off, use either of these methods: 
 
 Press Shift+F9.
 
 
 
 On the View tab, in the Show group, select or deselect the Gridlines check box.
 
 Choose Home ➪ Align ➪ View Gridlines. There are many options you can set for the gridlines, including whether objects snap to it, whether the grid is visible, and what the spacing should be between the gridlines. To set grid options, follow these steps: 1. On the Home tab, in the Drawing group, choose Arrange ➪ Align ➪ Grid Settings, or right-click the slide background and choose Grid and Guides. The Grid and Guides dialog box opens (see Figure 1-23). 2. In the Snap To section, select or deselect these check boxes: 
 
 Snap Objects to Grid: Specifies whether or not objects will automatically align with the grid.
 
 
 
 Snap Objects to Other Objects: Specifies whether or not objects will automatically align with other objects.
 
 3. In the Grid Settings section, enter the amount of space between gridlines desired. 4. Select or deselect the Display Grid On Screen check box to display or hide the grid. (Note that you can make objects snap to the grid without the grid being displayed.) 5. Click OK.
 
 FIGURE 1-23
 
 Set grid options and spacing.
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 Guides Guides are like gridlines except they are individual lines, rather than a grid of lines, and you can drag them to different positions on the slide. As you drag a guide, a numeric indicator appears to let you know the ruler position, as shown in Figure 1-24. Use the Grid and Guides dialog box shown in Figure 1-24 to turn guides on/off, or press Alt+F9. FIGURE 1-24
 
 Guides are movable, non-printing lines that help with alignment. Vertical line (being dragged)
 
 Horizontal line
 
 You can create additional sets of guide lines by holding down the Ctrl key while dragging a guide (to copy it). You can have as many horizontal and vertical guides as you like, all at positions you specify.
 
 Color/Grayscale/Pure Black and White Views Most of the time you will work with your presentation in color. However, if you plan to print the presentation in black and white or grayscale (for example, on black-and-white handouts), you should check to see what it will look like without color.
 
 Tip This Color/Grayscale/Pure Black and White option is especially useful when you are preparing slides that will eventually be faxed, because a fax is pure black and white in most cases. Something that looks great on a color screen could look like a shapeless blob on a black-and-white fax. It doesn’t hurt to check. 
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 Click the Grayscale or the Pure Black and White button on the View tab to switch to one of those views. When you do so, a Grayscale or Black and White tab becomes available, as shown in Figure 1-25. From its Setting group, you can fine-tune the grayscale or black-and-white preview. Choose one that shows the object to best advantage; PowerPoint will remember that setting when printing or outputting the presentation to a grayscale or black-and-white source. FIGURE 1-25
 
 Select a grayscale or a black-and-white preview type.
 
 When you are finished, click the Back to Color View button on the Grayscale tab. Changing the Black and White or Grayscale settings doesn’t affect the colors on the slides; it only affects how the slides will look and print in black and white or grayscale.
 
 Opening a New Display Window Have you ever wished you could be in two places at once? Well, in PowerPoint, you actually can. PowerPoint provides a way to view two spots in the presentation at the same time by opening a new window. To display a new window, display the View tab and click New Window in the Window group. Then use Arrange All or Cascade to view both windows at once. You can use any view with any window, so you can have two slides in Normal view at once, or Slide Sorter and Notes Pages view, or any other combination. Both windows contain the same presentation, so any changes you make in one window are reflected in the other window.
 
 Arranging Windows When you have two or more windows open, whether they are for the same presentation or different ones, you need to arrange them for optimal viewing. You saw earlier in this chapter how to resize a window, but did you know that PowerPoint can do some of the arranging for you? When you want to arrange the open windows, do one of the following: 
 
 Tile: On the View tab, click Arrange All to tile the open windows so there is no overlap.
 
 
 
 Cascade: On the View tab, click Cascade to arrange the open windows so that the title bars cascade from upper-left to lower-right on the screen. Click a title bar to activate a window.
 
 These commands do not apply to minimized windows. If you want to include a window in the arrangement, make sure you restore it from its minimized state first.
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 Switching among Windows If you have more than one window open and can see at least a corner of the window you want, click it to bring it to the front. If you have one of the windows maximized, on the other hand, or if another window is obscuring the one you want, click Switch Windows (on the View tab) and select the window you want to view.
 
 Using the Help System The PowerPoint Help system is like a huge instruction book in electronic format. You can look up almost any PowerPoint task you can imagine and get step-by-step instructions for performing it. To open the PowerPoint Help window, choose File ➪ Help ➪ Microsoft Office Help, or press F1, or click the Help icon (the question mark) in the upper-right corner of the PowerPoint window, as shown in Figure 1-26. FIGURE 1-26
 
 Get help with PowerPoint via the PowerPoint Help window. Type a word or phrase here to search for
 
 Click here to open the PowerPoint Help Window
 
 Browse Help by topic
 
 Connection status
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 To look up information in the Help system, you can: 
 
 Click one of the topics on the default Browse PowerPoint 2010 Help page shown in Figure 1-26, and then keep clicking subtopics to narrow down the search until you arrive at what you want.
 
 
 
 Type a keyword or phrase in the Search box, and then click Search or press Enter to find all Help articles that contain it.
 
 Tip Much of the Office 2010 Help system relies on an Internet connection. By default, Office 2010 applications automatically connect to Microsoft’s servers online to gather additional Help information. If you have a slow Internet connection, and find that searches are slow, try disabling online Help so that PowerPoint just uses the Help files installed on your PC. To do this, from the PowerPoint Help window, click the connection status indicator (see Figure 1-26), and from the menu that appears, choose Show Content Only From This Computer. 
 
 When you browse or search the Help system, a list of articles matching the topic or search term appears. Click an article to read it. Figure 1-27 shows an article on saving files, for example. FIGURE 1-27
 
 A typical article in the Help system contains some background information and step-by-step instructions.
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 The PowerPoint Help window’s toolbar contains the buttons shown in Table 1-1.
 
 TABLE 1-1
 
 Help Toolbar Buttons Button(s)
 
 Name
 
 Description
 
 Back and Forward
 
 These are just like in Internet Explorer; Back goes back to a previously viewed topic and Forward goes forward again afterward.
 
 Stop
 
 Stops Web content from loading. Useful if it is loading very slowly and you want to give up.
 
 Refresh
 
 Reloads content from the Web.
 
 Home
 
 Returns to the default list of topics (Figure 1-6).
 
 Print
 
 Prints the currently displayed article.
 
 Change Font Size
 
 Opens a menu from which you can select the size of the text that appears in the Help system. This setting also affects text in Internet Explorer.
 
 Show Table of Contents
 
 Toggles an extra pane to the left of the main Help window that contains the top-level list of topics.
 
 Keep on Top
 
 Keeps the Help window on top of all other windows.
 
 ,
 
 Using PowerPoint Support Resources Microsoft provides a variety of support tools for PowerPoint in addition to the Help system. You can diagnose problems with your PowerPoint installation, for example, download updates, register your copy of PowerPoint, and more. To access these tools, follow these steps: 1. Choose File ➪ Help. 2. Click the button for the option you want to access. These are summarized in Table 1-2.
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 TABLE 1-2
 
 PowerPoint Support Resources Resource
 
 Description
 
 Getting Started
 
 Connects to the Office Web site and displays information about PowerPoint’s basic features.
 
 Contact Us
 
 Opens a Web page listing contact information for Microsoft.
 
 Options
 
 Opens the PowerPoint Options dialog box (covered fully in Chapter 24), the same as if you had chosen File ➪ Options.
 
 Check for Updates
 
 Connects to the Office Web site, runs a utility that evaluates the dates on your current Office files, and downloads and installs updates if available.
 
 Understanding Product Activation All Office 2010 products must be activated after a certain number of days or a certain number of uses. This is a simple matter if you have an Internet connection. Every time you start an Office 2010 application, a reminder to activate appears. Follow the prompts to activate it. You do not have to give any personal information. So what is this activation, and why is it required? Activation locks your copy of Office (or PowerPoint, if you bought it separately) to the hardware configuration in your computer, so that it can’t be installed on any other PC. The activation utility surveys a sampling of your PC’s hardware (around a dozen different components), and based on their models, serial numbers, and so on, it comes up with a number. Then it combines that number mathematically with the 24-digit installation key code you entered when you installed the software, to produce a unique number that represents that particular copy of Office combined with that particular PC. It then sends that number off to an activation database at Microsoft, along with the original installation key code. So how does this prevent illegal software copying? Two ways. One is that the installation key code is locked to that hardware ID, so that if you install the same copy on a different PC, it can’t be activated there. (This is not the case for some corporate and volume-licensed copies.) The other is that it prevents you from radically changing the hardware in the PC without contacting Microsoft for reactivation authorization. For example, you could not take the hard disk out of the PC and put it in another PC without reactivating Office. It is this second point that has been an issue of conflict between Microsoft and users, because many users like to tinker with their hardware and they do not want to have to contact Microsoft every time they make hardware changes. According to Microsoft documentation, the change of
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 one or two pieces of hardware will not trigger the need for reactivation, but your experience may differ. Even if you are prompted to reactivate, you can usually reactivate a legitimate installation via phone with no problems. There are two situations in which you might not have to activate: 
 
 When you buy a new PC with Office preinstalled. Office will already have been activated, so you do not have to go through the process.
 
 
 
 If you work for a company or attend a school that has a licensing agreement with Microsoft for a certain number of copies. You might have a version of Office that does not contain the activation requirement.
 
 When you go through the activation process, you are also asked whether you want to register your copy of the software. Activation by itself sends no identifying information about you or your PC to Microsoft; if you want to be on the Microsoft mailing list for update information, you must go through the additional process of registration.
 
 Adjusting Privacy Settings In some situations, it is advantageous for your copy of PowerPoint to communicate with Microsoft over the Internet. For example, when you use the Help system, you get better results if you are connected, and when inserting clip art, you have more images to choose from if you are connected. It’s a two-way street: your copy of PowerPoint can also help Microsoft by sending information to the company about your usage habits. For example, when Microsoft is developing a new version of PowerPoint, they look at usage data to determine which features of the program people are using the most and the least. This program for gathering user data is the Customer Experience Improvement Program, and participation in it is optional. To control whether — and how — your copy of PowerPoint interacts online with Microsoft, follow these steps to configure Privacy Options: 1. Choose File ➪ Options. 2. Click Trust Center, and then click the Trust Center Settings button. The Trust Center dialog box opens. 3. Click Privacy Options, and then select or deselect any of the check boxes in the Privacy Options section. See Figure 1-28. To get information about each of the options, point to the ‘‘i’’ symbol to its right. 4. Click OK, and then OK again to close all open dialog boxes.
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 FIGURE 1-28
 
 Choose how your copy of PowerPoint will interact with Microsoft via the Internet.
 
 Point at an icon for more information
 
 Summary This chapter provided an introduction to PowerPoint. You learned about PowerPoint 2010’s new features, how to navigate the new user interface, how to control the view of the PowerPoint window, and how to get help and support. In the next chapter, you’ll learn about the ‘‘soft skills’’ involved in planning and executing a successful presentation.
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 W
 
 ow! What a great presentation! That’s what you want your audience to come away thinking, right?
 
 IN THIS CHAPTER
 
 Most people won’t be nit-picky enough to pinpoint exactly what they loved about the experience. Nobody is likely to say, ‘‘Weren’t the colors in that pie chart on slide 43 artfully chosen?’’ or ‘‘Did you see his tie? I wonder where I can buy one just like it.’’ Instead, you’ll leave your audience with an overall impression that they gather from a host of little details, from the color scheme on your slides to the anecdotes and jokes you tell.
 
 Qualities of an effective presentation
 
 You can turn off your computer for this chapter, because you won’t need it to follow along. In this chapter, I’ll present some strategies for planning the best presentation ever. I’ll provide an 11-point action plan for building your presentation file, and address some of the ‘‘soft’’ topics that can make or break a show, such as how to arrange a room, what to wear, where to stand, and more.
 
 Choosing your attire
 
 Qualities of an Effective Presentation What separates an effective presentation from an ineffective one? No, it’s not just a gut feeling; there are proven attributes for which you can strive. The rest of this chapter elaborates on these points, but here’s a quick overview of what to work on.
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 Keeping the audience interested Managing stage fright
 
 Part I: Building Your Presentation
 
 An effective presentation: 
 
 Is designed and formatted appropriately for the audience and the medium.
 
 
 
 Is tightly focused on its subject, with extraneous facts trimmed away or hidden for backup use.
 
 
 
 Uses the right PowerPoint theme, with colors and fonts chosen to reinforce the message of the presentation.
 
 
 
 Includes the right amount of text on each slide, without overcrowding.
 
 
 
 Uses artwork purposefully to convey information and create an overall visual impression.
 
 
 
 Uses charts rather than raw columns of numbers to present financial or numeric information.
 
 
 
 Employs sound and video to create interest where needed, but does not allow the effects to dominate the show.
 
 
 
 Uses animations and transitions if appropriate for the audience and message, but does not allow them to dominate.
 
 
 
 Offers the audience handouts that contain the information they will want to take with them.
 
 
 
 Leaves time at the end for a question-and-answer session so the audience members can clarify any points they were confused about.
 
 Now that you know what the goal is, how do you get there? The following section outlines a precise, step-by-step action plan for developing a presentation that has these qualities.
 
 Developing Your Presentation Action Plan Can you guess what the single biggest problem is when most people use PowerPoint? Here’s a hint: It’s not a problem with the software at all. It’s that they don’t think things through carefully before they create their presentation, and then they have to go back and make major modifications later. You’ve probably heard the saying, ‘‘If you don’t have time to do it right, how are you going to find time to do it over?’’ This sentiment is certainly applicable to creating presentations. In the following sections, I outline a strategy for creating the appropriate PowerPoint presentation right from the start. By considering the issues addressed here, you can avoid making false assumptions about your audience and their needs, and so avoid creating a beautiful presentation with some horrible flaw that makes it unusable. By spending a half-hour or so in this chapter, you can save yourself literally days in rework later.
 
 Step 1: Identifying Your Audience and Purpose Before you can think about the presentation you need to create, you must first think of your audience. As you probably already know from real-life experience, different audiences respond to different presentation types. For example, a sales pitch to a client requires a
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 very different approach than an informational briefing to your coworkers. Ask yourself these questions: 
 
 How many people will be attending the presentation? The attendance makes a difference because the larger the group, the larger your screen needs to be so that everyone can see. If you don’t have access to a large screen, you have to make the lettering and charts big and chunky so that everyone can read your presentation.
 
 
 
 What is the average age of the attendees? Although it’s difficult to generalize about people, it’s especially important to keep your presentation light and entertaining when you’re presenting to a very young audience (teens and children). Generally speaking, the older the audience, the more authoritative you need to be.
 
 
 
 What role will the audience take in relation to the topic? If you are rolling out a new product or system, the managerial staff will likely want a general overview of it, but the line workers who will actually be operating the product need a lot of details. Generally speaking, the higher the level of managers, the more removed they will be from the action, and the fewer details of operation they need.
 
 
 
 How well does the audience already know the topic? If you are presenting to a group that knows nothing about your topic, you want to keep things basic and make sure that you define all of the unfamiliar terms. In contrast, with a group of experts, you are likely to have many follow-up questions after the main presentation, and so you should plan on having some hidden backup slides ready in anticipation of those questions. See Chapter 20 for more on hiding slides for backup use.
 
 
 
 Does the audience care about the topic? If the topic is personally important to the attendees (such as information on their insurance benefits or vacation schedule), they will likely pay attention even if your presentation is plain and straightforward. However, if you must win them over, you need to spend more time on the bells and whistles.
 
 
 
 Are the attendees prejudiced either positively or negatively toward the topic? Keeping in mind the audience’s preconceived ideas can make the difference between success and failure in some presentations. For example, knowing that a client hates sales pitches can help you to tailor your own presentation to be out of the ordinary.
 
 
 
 Are the attendees in a hurry? Do your attendees have all afternoon to listen to you, or do they need to get back to their regular jobs? Nothing is more frustrating than sitting through a leisurely presentation when you’re watching precious minutes tick away. Know your audience’s schedule and their preference for quick versus thorough coverage.
 
 Next, think about what you want the outcome of the presentation to be. Although you might want more than one outcome, you should try to identify the primary one as your main goal. Some outcomes to consider include the following: 
 
 Audience feels good about the topic: Some presentations are strictly cheerleading sessions, designed to sway the audience’s opinion. Don’t discount this objective — it’s a perfectly legitimate reason to make a presentation! For example, suppose a new management staff has taken over a factory. The new management team might want to reassure the workers that everything is going to be okay. A feel-good, Welcome to the Team presentation, complete with gimmicks such as company T-shirts or hats, can go a long way in this regard.
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 Audience is informed: Sometimes you need to convey information to a group of people, and no decision is involved on their part. For example, suppose your company has switched insurance carriers and you want to let all of the employees know about their new benefits. An informational presentation can cover most of the common questions and save your human resources people a lot of time in answering the same questions over and over.
 
 
 
 Audience members make individual decisions: This presentation is a kind of sales pitch in which you are pitching an idea or product to a group, but each person says yes or no individually. For example, suppose you are selling timeshare vacation condos. You may give a presentation to a group of 100 people in an attempt to sell your package to at least a few members of the group. This presentation type can also have an informational flavor; you are informing people about their choices without pushing one choice or the other. For example, if your employees have a choice of health plans, you might present the pros and cons of each plan and then leave it to each employee to make a selection.
 
 
 
 Audience makes a group decision: This is the kind of presentation that scares a lot of people. You face a group of people who will confer and make a single decision, based on the information you present. Most sales pitches fall into this category. For example, you might be explaining your product to a group of managers to try to get their company to buy it.
 
 Think about these factors carefully and try to come up with a single statement that summarizes your audience and purpose. Here are some examples: 
 
 I am presenting to 100 factory workers to explain their new health insurance choices and teach them how to fill out the necessary forms.
 
 
 
 I am presenting to a group of six to ten mid-level managers, trying to get them to decide as a group to buy my product.
 
 
 
 I am presenting to a group of 20 professors to convince at least some of them to use my company’s textbooks in their classes.
 
 
 
 I am presenting to individual Internet users to explain how my company’s service works.
 
 Let’s take that first example. Figure 2-1 shows some notes that a presenter might make when preparing to explain information about employee benefits enrollment to a group of factory workers. Jot down your own notes before moving to step 2.
 
 Step 2: Choosing Your Presentation Method You essentially have three ways to present your presentation to your audience, and you need to pick the way that you’re going to use up front. These methods include speaker-led, self-running, and user-interactive. Within each of those three broad categories, you have some additional choices. Before you start creating the presentation in PowerPoint, you should know which method you are going to use because it makes a big difference in the text and other objects that you put on the slides.
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 FIGURE 2-1
 
 Make notes about your presentation’s purpose and audience.
 
 Speaker-Led Presentations The speaker-led presentation is the traditional type of presentation: You stand up in front of a live audience (or one connected through teleconferencing) and give a speech. The slides that you create in PowerPoint become your support materials. The primary message comes from you, and the slides and handouts are just helpers. With this kind of presentation, your slides don’t have to tell the whole story. Each slide can contain just a few main points, and you can flesh out each point in your discussion. In fact, this kind of presentation works best when your slides don’t contain a lot of information, because people pay more attention to you, the speaker, if they’re not trying to read at the same time. For example, instead of listing the top five reasons to switch to your service, you might have a slide that just reads: Why Switch? Five Reasons. The audience has to listen to you to find out what the reasons are. This kind of presentation also requires some special planning. For example, do you want to send each audience member home with handouts? If so, you need to prepare them. They may or may not be identical to your PowerPoint slides; that’s up to you. You also need to learn how to handle PowerPoint’s presentation controls. It can be really embarrassing to be fiddling with the computer controls in the middle of a speech, and so you should practice, practice, practice ahead of time.
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 Cross-Reference Handouts and other support materials (such as cards for speaker notes) are covered in Chapter 19. For more on PowerPoint presentation controls, see Chapter 20. 
 
 Self-Running Presentations With a self-running presentation, all of the rules change. Instead of using the slides as teasers or support materials, you must make the slides carry the entire show. All of the information must be right there, because you won’t be looking over the audience’s shoulders with helpful narration. In general, self-running presentations are presented to individuals or very small groups. For example, you might set up a kiosk in a busy lobby or a booth at a trade show and have a brief but constantly running presentation of perhaps five slides that explains your product or service. Because there is no dynamic human being keeping the audience’s attention, self-running presentations must include attention-getting features. Sounds, video clips, interesting transitions, and prerecorded narratives are all good ways to attract viewers. You must also consider the timing in a self-running presentation. Because there is no way for a viewer to tell the presentation, ‘‘Okay, I’m done reading this slide; bring on the next one,’’ you must carefully plan how long each slide will remain on-screen. This kind of timing requires some practice!
 
 Cross-Reference Part III explains how to use sounds, videos, and other moving objects in a presentation to add interest. Chapter 21 deals with timing issues that are associated with a self-running presentation, as well as how to record voice-over narration. 
 
 User-Interactive Presentations A user-interactive presentation is like a self-running presentation, except that the viewer has some input. Rather than standing passively by, the viewer can tell PowerPoint when to advance a slide. Depending on the presentation’s setup, viewers may also be able to move around in the presentation (perhaps to skip over topics that do not interest them) and request more information. This type of presentation is typically addressed to a single user at a time, rather than a group, and is usually distributed over the Internet, a company intranet, or via CD. The user runs the presentation using either PowerPoint or a free program called PowerPoint Viewer that you can provide for download. You can also translate a PowerPoint presentation to HTML format (the native format for World Wide Web pages), so that anyone with a Web browser can view it. However, presentations may lose some of their features when you save them in Web format, so consider the decision carefully.
 
 Cross-Reference Chapter 21 explains how to place action buttons on slides so that the viewer can control the action. Chapter 22 covers some of the issues involved in preparing a presentation for mass distribution. 
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 Step 3: Choosing Your Delivery Method Whereas the presentation method is the general conceptual way that the audience interacts with the information, the delivery method is the way that you deliver that interaction. It’s a subtle but important difference. For example, suppose that you have decided to use a speaker-led presentation method. That’s the big picture, but how will you deliver it? Will you present from a computer, or use 35mm slides, or overhead transparencies, or just plain old handouts? All of these methods fall under the big umbrella of ‘‘speaker-led.’’ PowerPoint gives you a lot of options for your delivery method. Some of these options are more appropriate for speaker-led shows, while others can be used for any presentation method. Here are some of the choices: 
 
 Computer show through PowerPoint: You can use PowerPoint’s Slide Show view to play the slides on a computer screen. If necessary, you can also hook up a large, external monitor to the PC so that the audience can see it better. This setup requires that PowerPoint (or the PowerPoint Viewer utility) be installed on the computer at the presentation site. This method works for speaker-led, self-running, or user-interactive shows.
 
 
 
 Computer show through a Web site: You can save your presentation in Web format and then publish it to a Web site. You can use this method for speaker-led, self-running, or user-interactive shows, and no special software is required — just a Web browser. However, you lose some of the cool graphical effects, including some transitions and animation effects. Web delivery is used mostly for self-running or user-interactive shows.
 
 
 
 Computer show on CD: You can create a CD that contains both the presentation and the PowerPoint Viewer utility. The presentation starts automatically when the viewer inserts the CD into a PC. This method is most useful for self-running or user-interactive shows
 
 
 
 Broadcast: You can broadcast your presentation on the Internet, so that others can view it on their own computers in real-time. Presentation broadcasting has been improved in PowerPoint 2010, and is covered in Chapter 22.
 
 
 
 Video clip: You can output your presentation to a movie file that can be played using a variety of media players. Videos can be distributed on CD or DVD, online, or via e-mail.
 
 
 
 Overhead transparencies: You can create overhead transparencies, which are just clear sheets, on most printers. During your presentation, you place them on an overhead projector one at a time.
 
 Caution Be careful that the transparencies that you buy are designed for your printer! For example, inkjet transparencies will melt in a laser printer.  
 
 35mm slides: A somewhat outdated method, but still viable if computer equipment is unavailable. 35mm slides look good, and transport well in carousels, but you lose all your special effects, such as animation and sounds.
 
 
 
 Paper: If there is no projection media available, then your last resort is to distribute your slides to the audience on paper. If you give them handouts, these handouts should be a supplement to an on-screen show, and not the main show themselves.
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 Cross-Reference Chapter 19 covers printing, both on paper and on transparencies. See Chapter 21 for more on self-running presentations. 
 
 Step 4: Choosing a Theme That Matches Your Medium PowerPoint comes with so many themes and templates that you’re sure to find one that is appropriate for your situation. A theme is a set of design settings: background, fonts, colors, and graphic effects. PowerPoint 2010 has many built-in themes that are available in every presentation, and you can also create your own themes and use themes that others have created and stored in theme files. A template is a full-fledged PowerPoint file that has been designated as a sample from which you can create new presentations. It contains everything that a presentation requires, including sample slides. A template can also contain multiple themes that are piggybacked onto slide masters within the template. When you start a new presentation, you do so from a template, and you inherit any themes and sample slides in that template, in addition to having the built-in themes available.
 
 Tip You aren’t stuck with the color scheme or design that comes with a particular theme or template. As you learn in Chapter 5, you can apply different color, font, and effects themes separately from the overall theme. 
 
 What’s the best theme to use? What are the best colors? It all depends on the situation, and on your presentation medium. If you are lucky enough to have access to a computer-based presentation system, you can show your slides on a PC monitor or TV screen. Some large meeting facilities even have projectors that let you project the image onto very large screens. Here are some guidelines for formatting for presenting on a computer screen:
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 Fonts: The image on a computer screen is usually nice and sharp, and so you can use any font. However, you should first test your presentation on the computer and projector from which you’ll be presenting, as some fonts may look more jagged than others. If you are presenting to a large group on a small screen, make sure that you keep all of the lettering rather large. Also make sure that the font is available on the presentation computer; if it’s not there, your text and bullets may not look the way you anticipated.
 
 
 
 Text color: Go for contrast. Both dark text on a light background and light text on a dark background work well.
 
 
 
 Background color: Dark backgrounds such as dark blue, green, or purple are a good choice if the room is not too dark. Light backgrounds can add ambient light to the room, which can sometimes be helpful. You are also free to use gradients, shading, patterns, pictures, and other special backgrounds because all of these elements display nicely on most monitors.
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 Content: You can go all out with your content. Not only can you include both text and graphics, but also animations, transitions, sounds, and videos.
 
 If you are showing the presentation on a large screen (either with a computerized projector or 35mm slides), the following suggestions may be helpful: 
 
 Fonts: You can use almost any readable font. If your audience will sit far away from the screen, stick with plain fonts such as Arial and Times New Roman for the body text.
 
 
 
 Text color: Go for contrast. Try light text on a dark background. My personal favorite for large-format screens is bright yellow text on a navy blue background.
 
 
 
 Background color: Keep it dark — but not black. Light colors make the screen too bright. Dark blues, greens, and purples are all good choices. Stick with solid backgrounds to compensate for any image distortion that occurs on-screen. You should avoid patterned, shaded, or clip art backgrounds.
 
 
 
 Content: You can use any combination of text and graphics with success, but it has to be static. Animations and transitions don’t work with 35mm slides. For example, if you have a bulleted list, don’t build the bulleted list one bullet at a time from slide to slide. It looks awkward.
 
 Using a non-computerized overhead projector, like the one your teacher may have had in grade school, is never anyone’s first choice. However, sometimes it may be all that is available. An overhead projector image is medium-sized (probably about 36 x36 ), but often of poor quality. You will probably be fighting with room lighting, and so your slides may appear washed out. Here are some tips for preparing slides that you will be showing with overhead projectors: 
 
 Fonts: For headings, choose chunky block fonts, such as Arial Black, that can stand up to a certain amount of image distortion. For small type, choose clear, easy-to-read fonts such as Arial or Times New Roman.
 
 
 
 Text color: Black letters on a light background stand out well. Avoid semi-dark lettering, such as medium-blue, because it easily washes out under an overhead projector’s powerful light.
 
 
 
 Background color: Avoid dark backgrounds. You probably will not position each slide perfectly on the overhead projector, and the white space around the edges is distracting if your transparencies have a dark background. Consider using a simple white background when you know that you’re going to be using transparencies, and especially when you want to write on the transparencies.
 
 
 
 Content: Keep it simple. Overheads are best when they are text-heavy, without a lot of fancy extras or clip art. The overhead projector is an old technology, and slides that are too dressy seem pretentious.
 
 Step 5: Developing the Content Your slides should say to the audience, ‘‘I had you in mind when I created this,’’ and, ‘‘Relax; I’m a professional, and I know what I’m doing.’’ Good-looking, appropriate slides can give the audience a sense of security, and can lend authority to your message. On the other hand, poorly
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 done or inconsistent slides can tell the audience, ‘‘I just slapped this thing together at the last minute,’’ or, ‘‘I don’t really know what I’m doing.’’ Only after you have made all of the decisions in steps 1 through 4 can you start developing your content in a real PowerPoint presentation. Now comes the work of writing the text for each slide, which most people prefer to do in Normal view. Type the text on the outline or on the text placeholder on the slide itself, and you’re ready to roll. Developing your content may include more than just typing text. For example, your content may include charts that you created in PowerPoint or imported from another program such as Excel, pictures, and other elements.
 
 Avoiding Information Overload When presenting, you want to give the audience exactly the information that they need and no more. You don’t want them to leave clutching their heads and saying, ‘‘Wow! That was too much to absorb!’’ or, ‘‘What a waste of time!’’ You may have a great deal of information that you need to convey to the audience in a very short time. To ensure that they absorb it all without feeling overwhelmed, here are a few ideas: 
 
 Before you give your presentation, analyze it closely to make sure that you only cover the essential topics. By trimming some nonessential topics, you make more room to cover the important themes in enough detail.
 
 
 
 Don’t try to cram every detail onto your slides. Use the slides for general talking points, and then fill in the discussion with your speech.
 
 
 
 Use SmartArt to replace bullets. As you will learn in Chapter 11, you can easily use the new SmartArt diagrams in PowerPoint 2010 in place of a plain bulleted list to make the information more memorable and easier to understand.
 
 
 
 Provide detailed handouts that elaborate on your slides. Ensure that the audience receives them at the beginning of the presentation. Then, refer to the handouts throughout the presentation, letting the audience know that they can read all of the details later.
 
 
 
 Summarize at the end of the presentation with a few simple slides. These should contain bullet points that outline what the audience should have learned. You might even want to use interim summary slides throughout a complex presentation.
 
 Cross-Reference Chapter 4 guides you through the process of creating slides and text boxes. You learn about graphical content in Part II of this book. In Lab 1, you learn how to present content without bulleted lists. 
 
 Step 6: Creating the Visual Image The term visual image refers to the overall impression that the audience gets from watching the presentation. You can create a polished, professional impression by making small tweaks to your presentation after you have decided on the content.
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 You can enhance the visual image by making minor adjustments to the slide’s design. For example, you can give a dark slide a warmer feel by using bright yellow instead of white for lettering. Repositioning a company logo and making it larger may make the headings look less lonely. You can use WordArt effects to dress up some text and make it look more graphical. A product picture is more attractive in a larger size or with a different-colored mat around it. All of these little touches take practice and experience. Audiences like consistency. They like visual elements that they can rely on, such as a repeated company logo on every slide, accurate page numbering on handouts, and the title appearing in exactly the same spot on every slide. You can create a consistent visual image by enforcing these rules in your presentation development. It’s easier than you might think, because PowerPoint provides a slide master specifically for images and text that should appear on each slide.
 
 Cross-Reference You’ll work with slide masters and learn more about the benefits of consistency in Chapter 5. 
 
 Step 7: Adding Multimedia Effects If you’re creating a self-running presentation, multimedia effects are extremely important for developing audience interest. Flashy videos and soundtracks can make even the most boring topic fun to hear about, especially for young audiences. How about a trumpet announcing the arrival of your new product on the market, or a video of your CEO explaining the reasoning behind the recent merger?
 
 Caution Even if you are going to be speaking live, you still might want to incorporate some multimedia elements into your show. However, be careful not to let them outshine you or to appear gratuitous. Be aware of your audience (see step 1), and remember that older and higher-level managers want less flash and more substance. 
 
 All kinds of presentations can benefit from slide animations and transitions. Animations are simple movements of the objects on a slide. For example, you can make the bullet points on a list fly onto the page one at a time, and discuss each one on its own. When the next bullet flies in, the previous ones can turn a different color so that the current one stands out. You might also animate a picture of a car so that it appears to ‘‘drive onto’’ the slide, accompanied by the sound of an engine revving. You can also animate charts by making data series appear one at a time, so that it looks like the chart is building. Transitions are animated effects for moving from slide to slide. The most basic and boring transition is to simply remove one slide from the screen and replace it with another. However, you can also use many alternative effects such as zooming the new slide in, sliding it from the top, bottom, left, or right, or creating a fade-in transition effect.
 
 Cross-Reference Chapters 16 and 17 deal with the mechanics of placing sound and video clips into a presentation and controlling when and how they play. You can learn about animations and transitions in Chapter 18. 
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 Step 8: Creating the Handouts and Notes This step is applicable only to speaker-led presentations. With a live audience, you may want to provide handouts so that they can follow along. You can make handouts verbatim copies of your slides, or abbreviated versions with only the most basic information included as a memory-jogger. Handouts can be either black and white or in color, and PowerPoint provides several handout formats. For example, you can print from one to nine slides per printout, with or without lines for the audience to write additional notes.
 
 Tip A continual debate rages in the professional speakers’ community over when to give out handouts. Some people feel that if you distribute handouts beforehand, people will read them and then not listen to the presentation. Others feel that if you distribute handouts after the presentation, people will frantically try to take their own notes during the presentation or will not follow the ideas as easily. There’s no real right or wrong answer, it seems, and so you should distribute them whenever it makes the most sense for your situation. 
 
 As the speaker, you may need your own special set of handouts with your own notes that the audience should not see. PowerPoint calls these Notes Pages, and there is a special view for creating them. (You can also enter notes directly into the Notes pane in Normal view.)
 
 Cross-Reference Notes are covered, along with handouts, in Chapter 19, which also guides you through selecting the appropriate size and format, as well as working with your printer to get the best results for your handouts. 
 
 Step 9: Rehearsing the Presentation No matter which type of presentation you are creating (speaker-led, self-running, or user-interactive), you need to rehearse it. However, the goals for rehearsing are different for each type.
 
 Rehearsing a Live Presentation When you rehearse a live presentation, you check the presentation slides to ensure that they are complete, accurate, and in the right order. You may need to rearrange them and hide some of them for backup-only use. You should also rehearse using PowerPoint’s presentation controls, which display each slide on a monitor and let you move from slide to slide, take notes, assign action items, and even draw directly on a slide. Make sure that you know how to back up, how to jump to the beginning or end, and how to display one of your backup slides.
 
 Cross-Reference You can learn about navigation skills in Chapter 20. 
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 Rehearsing a Self-Running Presentation With a speaker-led presentation, the presenter can fix any glitches that pop up, or explain away any errors. With a self-running presentation, you don’t have that luxury. The presentation itself is your emissary. Therefore, you must go over it repeatedly, checking it many times to make sure that it is perfect before distributing it. Nothing is worse than a self-running presentation that doesn’t run, or one that contains an embarrassing error. The most important feature in a self-running presentation is timing. You must make the presentation pause for the correct amount of time so that the audience can read the text on each slide. The pause must be long enough so that even slow readers can catch it all, but short enough so that fast readers do not become bored. You can now see how difficult this can be to make perfect. PowerPoint has a Rehearse Timings feature that is designed to help you with this task. It lets you show the slides and advance them manually after the correct amount of time has passed. The Rehearse Timings feature records how much time you spend on each slide, and gives you a report so that you can modify the timing if necessary. For example, you may be working on a presentation that is supposed to last ten minutes, but with your timings, it comes out to only nine minutes. You can add additional time for each slide to stretch it out to last the full ten minutes. You may also want to record voice-over narration for your presentation. You can also rehearse this, to make sure that the voice matches the slide that it is supposed to describe (which is absolutely crucial, as you can imagine!).
 
 Cross-Reference Chapter 18 covers the Rehearse timings feature; Chapter 21 covers voice-over narration. 
 
 Rehearsing a User-Interactive Presentation In a user-interactive presentation, you provide the readers with on-screen buttons that they can click to move through the presentation, so that timing is not an issue. The crucial factor with a user-interactive presentation is link accuracy. Each button on each slide is a link. When your readers click a button for the next slide, it must take them to the next slide and not to somewhere else. And if you include a hyperlink to a Web address on the Internet, when the readers click it, the Web browser should open and that page should appear. If the hyperlink contains a typo and the readers see File Not Found instead of the Web page, the error reflects poorly on you. Chapter 21 covers creating and inserting these links. If you are planning to distribute your presentation through the Internet, you have a big decision to make. You can distribute the presentation in its native PowerPoint format and preserve all of its more exciting features, such as animations and videos. However, not everyone on the Internet owns a copy of PowerPoint, and so you are limiting your audience. Although PowerPoint supplies a free program, called the PowerPoint Viewer that you can post for downloading on your Web page, not everyone will take the time to download and install it, and so you may turn off potential viewers before you start.
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 Another option is to save the presentation in HTML (Web) format. When you save in HTML format, you convert each of the slides to a Web page, and you add links (if you didn’t already have them) that move the viewer from slide to slide. You lose some of the animations, transitions, sounds, videos, animated graphics, and other extras, but you retain your text and most static elements of the presentation. The advantage is that everyone with a Web browser can view your presentation with no special downloads or setup. Finally, you can save the presentation as a video (movie) clip and make that available online.
 
 Cross-Reference You learn more about preparing a presentation for the Internet, using either method, in Chapter 21. For more on saving a movie clip and making it available online, see Chapter 17. 
 
 Step 10: Giving the Presentation For a user-interactive or self-running presentation, giving the presentation is somewhat anticlimactic. You just make it available and the users watch it. Yawn. However, for a speaker-led presentation, giving the speech is the highlight, the pinnacle, of the process. If you’ve done a good job rehearsing, you are already familiar with PowerPoint’s presentation controls. You should be prepared to back up, to skip ahead, to answer questions by displaying hidden slides, or to pause the whole thing (and black out the screen) so that you can hold a tangential discussion.
 
 Cross-Reference Chapter 20 covers all of these situations in case you need to review them. 
 
 What remains now? Nothing, except for setting up the room and overcoming your stage fright. Later in this chapter, you’ll get some tips about using a meeting room most effectively and being a dynamic speaker. Check them out — and then go get ‘em!
 
 Step 11: Assessing Your Success and Refining Your Work If giving a presentation is a one-time thing for you — great. It’s over, and you never have to think about it again. However, it is more likely that you will have to give another presentation someday, somewhere, and so you shouldn’t drive the experience out of your mind just yet. Perhaps you learned something that might be useful to you later. Immediately after the presentation, while it is still fresh in your mind, jot down your responses to the following questions. Then keep them on file to refer to later, the next time you have to do a presentation!
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 Did the colors and design of the slides seem appropriate?
 
 
 
 Could everyone in the audience read the slides easily?
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 Did the audience look mostly at you, at the screen, or at the handouts? Was that what you intended?
 
 
 
 Did the audience take notes as you were speaking? If so, did you give them handouts with note-taking lines to write on?
 
 
 
 Was the length of the presentation appropriate? Did the audience become bored or restless at any point?
 
 
 
 Were there any slides that you wished you had prepared but didn’t?
 
 
 
 Were there any slides that you would omit if you were doing it over?
 
 
 
 Did your speaker notes give you enough help that you could speak with authority?
 
 
 
 Did the transitions and animations add to the entertainment value, or were they distracting or corny?
 
 
 
 Did the sound and video clips play with adequate quality? Were they appropriate and useful?
 
 Choosing and Arranging the Room Are you giving a live presentation? The choice of room — and its arrangement — can make a big difference in your success. If you have any say in it, make sure that you get an appropriate size room for the presentation. For example, a room that is too small makes people feel uncomfortable and seems crowded, whereas a room that is too large can create a false formality and distance that can cause people to lose focus. You also don’t want to have to shout to be heard.
 
 Caution To avoid having to shout during your presentation, make sure that there is a working sound system, with a microphone and amplifier available, if necessary. If possible, check this detail a few days ahead of time, to avoid scrambling for one at the last minute. 
 
 Next, make sure that tables and chairs are set up appropriately. Figures 2.2 through 2.5 illustrate several setups, each of which is appropriate for a certain kind of presentation: 
 
 For a classroom setting where the audience will take a lot of notes, give them something to write on, as shown in Figure 2-2. This arrangement works well when the audience will be listening to and interacting with you, but not with one another.
 
 
 
 If the audience is not expected to take notes while you are giving the speech, consider an auditorium setup, as shown in Figure 2-3. This arrangement is also good for fitting a lot of people into a small room. (This is also known as theater-style seating.)
 
 
 
 If you want the audience to interact in small groups, you should set up groups where people can see each other and still see you. Figure 2-4 shows a small-group arrangement.
 
 
 
 To make it easier for the entire group to interact with one another as a whole, use a U-shape, as shown in Figure 2-5.
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 FIGURE 2-2
 
 In a classroom arrangement, each audience member has plenty of room to write and work. Presenter
 
 FIGURE 2-3
 
 An auditorium setup (or theater-style seating) fits a lot of people into a small space; it’s great for large company meetings. Presenter
 
 FIGURE 2-4
 
 Having small groups clustered around tables encourages discussion and works well for presentations that incorporate hands-on activities. Presenter
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 FIGURE 2-5
 
 Arrange the room in a U-shape if you want participants to have discussions as a large group. Presenter
 
 Choosing Your Attire The outfit that you choose for the presentation should depend on the expectations of the audience and the message that you want to send to them. Before you decide what to wear, ask yourself, ‘‘What will the audience be wearing?’’ Choose one of these classifications: 
 
 Very informal: Jeans, shorts, T-shirts
 
 
 
 Informal: Nice jeans, polo shirts
 
 
 
 Business casual: Dress slacks and oxfords, with or without a tie, for men; dress slacks or a skirt and a dressy, casual shirt (sweater, silk blouse, vest) for women
 
 
 
 Business: Dress slacks and a shirt and tie, with or without a jacket, for men; dress or skirt (blazer optional) for women
 
 
 
 Business formal: Suit and tie for men; suit or conservative dress for women
 
 Now, shape your own choice of attire, depending on the impression that you want to convey. To convey authority, dress one level above your audience. Use this attire any time your audience does not know who you are and when you need to establish yourself as the leader or the expert. (Most teachers fall into this category.) For example, if your audience is dressed informally, you should wear a dress shirt and tie (for men) or a skirt and sweater (for women). (If you’re female and will be seated on a stage, you might want pants or a very long skirt.) However, you should not dress more than two levels above your audience because it makes them feel intimidated. For example, if you are presenting to factory workers who are dressed in very informal clothing, you should not wear a business suit. To convey teamwork and approachability, dress at the same level as the audience, or slightly (no more than one level) above. For example, if you are a CEO visiting a factory that you manage, the workers already recognize your authority — you don’t have to prove it. Instead, you want to
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 appear approachable, and so if they are wearing informal clothing, you might wear dress slacks and a dress shirt (but no tie) for a man, or slacks and a sweater for a woman. Avoid dressing below the audience’s level. This is almost never a good idea. If you do not know what the audience will be wearing, err on the side of formality. It is better to look a little stiff than it is to look less professional than your audience.
 
 Keeping the Audience Interested There are no miracle cures here — some people are naturally better, more interesting speakers than others. However, there are definite steps that all speakers can take to stack the odds in their favor when it comes to giving a successful live presentation.
 
 Speech Techniques Here are some strategies for improving your speaking style:
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 Plant your feet firmly; don’t pace. Pacing makes you appear nervous, and people have to constantly follow you with their eyes. However, you should keep your upper body mobile, and should not be afraid to use arm gestures.
 
 
 
 Use gestures to support your voice. If you are talking about three different points, then hold up fingers to illustrate one, two, and three points. If you are talking about bringing things together, bring your hands together in front of you to illustrate. Don’t freeze your hands at your sides.
 
 
 
 Don’t memorize your speech. If someone asks a question, it will throw you off and you’ll forget where you were.
 
 
 
 Conversely, don’t read the speech word for word from your notes. Notes should contain keywords and facts, but not the actual words that you will say.
 
 
 
 Don’t talk with your face in your notes. Make eye contact with an audience member before you begin speaking.
 
 
 
 Pick a few people in the audience, in different places in the room, and make direct eye contact with each of them, in turn, as you speak. Talk directly to a single person for the duration of the point that you are making and then move on. Also, don’t forget to smile!
 
 
 
 Don’t be afraid to pause. Speaking slowly, with pauses to look at your notes, is much more preferable than rushing through the presentation. Keep in mind that pauses that might seem very long to you really aren’t.
 
 
 
 Don’t stare at or read your slides. Focus your attention on your audience, and pay as little attention to the support materials as possible while you speak. You want to engage directly with your audience to deliver your message in your own words.
 
 
 
 Emphasize verbs and action words in your presentation. Remember that the verb is the most powerful element in the sentence.
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 Content Tips Consider these content techniques: 
 
 If the audience is not in a hurry and you are not rushed for time in your presentation, start with some kind of icebreaker, like an anecdote or joke.
 
 Caution Be careful with humor. Analyze the joke that you plan to tell from all angles, making very sure that it does not offend any race, ethnic group, gender, sexual orientation, or class of workers. It is much worse to tell a joke that hurts someone’s feelings — even one person — than it is to tell none at all.  
 
 Include the audience in interactive exercises that help to firm up their understanding of the topic.
 
 
 
 Ask questions to see whether the audience understood you, and give out small prizes to the people who give correct answers. Nothing energizes an audience into participation more than prizes, even if they are cheap giveaways like key chains and bandannas.
 
 
 
 If possible, split the presentation into two or more sessions, with a short break and question-and-answer period between each session.
 
 
 
 During the Q&A portion, turn off the slide projector, overhead, or computer screen so that people focus on you and on the question, not on the previous slide. If turning off the equipment isn’t practical, consider inserting a simple Q&A Session title slide or a blank slide that displays during the Q&A.
 
 Managing Stage Fright Even if you’re comfortable with the PowerPoint slides that you’ve created, you still might be a little nervous about the actual speech that you’re going to give. This is normal. In fact, a study from a few years ago showed that public speaking is the number-one fear among businesspeople. Fear of death came in second. That should tell you something. It’s okay to be a little bit nervous because it gives you extra energy and an edge that can actually make your presentation better. However, if you’re too nervous, it can make you seem less credible. One way to overcome stage fright is to stop focusing on yourself, and instead focus on your audience. Ask yourself what the audience needs and how you are going to supply that need. Become their caretaker. Dedicate yourself to making the audience understand you. The more you think of others, the less you think of yourself.
 
 Summary Although this chapter had little to do with PowerPoint per se, it focused on making successful presentations using your PowerPoint slides as a tool. The information that you learned here can help a beginning presenter look more experienced, or help a more experienced presenter polish his or her skills to perfection.
 
 55
 
 Creating and Saving Presentation Files
 
 I
 
 f you’re an experienced Windows and PowerPoint user, starting new presentations and saving files may be second nature to you. If so — great! You may not need this chapter. On the other hand, if you aren’t entirely certain about some of the finer points, such as saving in different formats or locations, stick around.
 
 IN THIS CHAPTER Starting a new presentation Saving your work
 
 Even people who consider themselves ‘‘advanced’’ users may benefit from this chapter, because it looks at some of the unique advanced saving features of Office applications and explains how to secure files with passwords.
 
 Setting passwords for file access
 
 Starting a New Presentation
 
 Setting file properties
 
 You can start a blank presentation from scratch, or you can base the new presentation on a template or on another presentation. Using a template or existing presentation can save you some time. However, if you have a specific vision you’re going for, starting a presentation from scratch gives you a clean canvas to work from.
 
 Starting a Blank Presentation from Scratch When you start PowerPoint, a new blank presentation begins automatically with one slide. Just add your content to it, add more slides if needed, change the formatting (as you’ll learn in upcoming chapters), and go for it. If you need to start another blank presentation, follow these steps: 1. Choose File ➪ New. The available templates and themes appear, on which you can base the new work, as shown in Figure 3-1. 2. Blank Presentation is already selected. Click Create.
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 FIGURE 3-1
 
 Select Blank Presentation from Backstage view.
 
 Tip Press the Ctrl+N shortcut key to start a new blank presentation. 
 
 Starting a Presentation from a Template or Theme A template is a file that contains starter settings — and sometimes starter content — on which you can base new presentations. Templates vary in their exact offerings, but can include sample slides, a background graphic, custom color and font themes, and custom positioning for object placeholders. When selecting a template, you can choose from these categories:
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 Sample Templates: Microsoft-provided templates and presentations that come preinstalled with PowerPoint.
 
 
 
 Sample Themes: Microsoft-provided theme files, which are the same as the themes that you can later apply to a presentation from the Design tab.
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 My Templates: Templates that you have created and saved yourself, and templates that you previously downloaded from Microsoft Office Online.
 
 
 
 Microsoft Office Online templates: Microsoft-provided templates that you download from Microsoft on an as-needed basis.
 
 
 
 Recent templates: Shortcuts to recently-used templates. This lets you easily reselect the same template you have used before.
 
 
 
 New from Existing: Shortcuts to existing presentations, which you can use as a basis for new ones. This is useful when you want to create a new version of a presentation without interfering with the original.
 
 Note Notice in Figure 3-1 that, in addition to Sample Templates, there are Themes . Themes are not templates, but they are similar. Chapter 1 explains the difference. You can start a new presentation based on a theme as an alternative to using a template. Such a presentation starts with defined color, font, and effect settings, but no sample slides. 
 
 Using a Sample Template There are only a few sample templates stored on your hard disk, because Microsoft assumes that most people have an always-on Internet connection these days. Each sample template demonstrates a special-purpose type of presentation, such as a photo album, pitchbook, or quiz show. If you are interested in standard corporate presentation templates, you might prefer to look at the online offerings instead. Follow these steps to start a presentation based on a sample template: 1. Choose File ➪ New. Icons for the various types of samples appear. 2. Click Sample Templates. Icons for the installed sample templates appear. 3. Click a template to see a preview of it. 4. Select the template you want and click Create. A new presentation opens based on that template.
 
 Using an Online Template The bulk of the templates for presentations are available online. You can access the library of online templates without leaving PowerPoint. Follow these steps: 1. Choose File ➪ New. 2. In the Office.com Templates section, click the category of template you want. 3. Depending on the category you choose, a subcategory list might appear in the center pane. If it does, click the subcategory that you want. For example, if you choose More Categories, you’ll find an Office 2007 Document Themes category. 4. Click a template to see a preview of it. 5. Select the template that you want and click Download. A new presentation opens based on that template.
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 Tip Spend some time exploring the templates available via the Office.com Templates section. There are many categories here! For example, Design Slides has templates that don’t contain any sample content — just design elements. 
 
 Using a Saved Template When you start a new presentation with an online template, as in the preceding section, PowerPoint copies that template to your hard disk so you can reuse it in the future without connecting to the Internet. It is stored, along with any custom template you have created, in the My Templates folder. To access these downloaded and custom templates, follow these steps: 1. Choose File ➪ New. 2. Click My Templates. A New Presentation dialog box appears which contains templates that you have downloaded or created, as shown in Figure 3-2. 3. Click OK. A new presentation opens based on that template.
 
 Tip To quickly access templates you have previously used, choose Recent Templates, and then double-click the template to reuse. To remove an item from the Recently Used Templates list, right-click the item and choose Remove Template. To clear the whole list at once, right-click any entry and choose Remove All Recent Templates. 
 
 FIGURE 3-2
 
 Choose a previously used or custom template.
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 Basing a New Presentation on an Existing One If you already have a presentation that’s similar to the new one you need to create, you can base the new presentation on the existing one. Follow these steps to use an existing presentation as a template: 1. Choose File ➪ New. 2. Click New from Existing. The New from Existing Presentation dialog box opens, as shown in Figure 3-3. FIGURE 3-3
 
 Select an existing presentation to use as a template.
 
 3. Navigate to the location containing the existing presentation and select it. When you select a presentation, the Open button changes to a Create New button. 4. Click Create New.
 
 Basing a New Presentation on Content from Another Application PowerPoint can open files in several formats other than its own, so you can start a new presentation based on some work you have done elsewhere. For example, you can open a Word outline in PowerPoint. The results might not be very attractive — but you can fix that later with some text editing, slide layouts, and design changes.
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 To open a file from another application, do the following: 1. Choose File ➪ Open. The Open dialog box appears. 2. Click the File Type button (or Files of Type in Windows XP) and choose the file type. For example, to open a text file, choose All Outlines, as shown in Figure 3-4. FIGURE 3-4
 
 Select a data file from some other program as the basis of a new presentation.
 
 File Type button
 
 3. Select the desired file, and then click Open. 4. Save your work as a PowerPoint file by choosing File ➪ Save As.
 
 Cross-Reference See the section ‘‘Saving Your Work’’ for more details on saving. 
 
 Saving Your Work PowerPoint is typical of most Windows programs in the way that it saves and opens files. The entire PowerPoint presentation is saved in a single file, and any graphics, charts, or other elements are incorporated into that single file. The first time you save a presentation, PowerPoint opens the Save As dialog box, prompting you for a name and location. Thereafter, when you save that presentation, PowerPoint uses the same settings and does not prompt you for them again.
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 Saving for the First Time If you haven’t previously saved the presentation you are working on, Save and Save As do the same thing: They open the Save As dialog box. From there, you can specify a name, file type, and file location. Follow these steps: 1. Choose File ➪ Save. The Save As dialog box appears. 2. Enter a filename in the File Name box, as shown in Figure 3-5.
 
 FIGURE 3-5
 
 Save your work by specifying a name for the presentation file.
 
 Note If you have Windows Vista, the Save As dialog box might not show the existing content of the current location by default. To view it, click the Browse Folders arrow in the bottom-left corner of the dialog box. 
 
 Cross-Reference To save in a different location, see the section ‘‘Changing Drives and Folders.’’ To save in a different format, see the section ‘‘Saving in a Different Format.’’ 
 
 3. Click Save. Your work is saved.
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 Filenames can be up to 255 characters. For practical purposes, however, keep the names short. You can include spaces in the filenames and most symbols except , ?, *, /, and \. However, if you plan to post the file on a network or the Internet at some point, you should avoid using spaces; use the underscore character instead to simulate a space, if necessary. Filenames that use exclamation points have also reportedly caused problems, so beware of that. Generally, it is best to avoid punctuation marks in filenames.
 
 Tip If you want to transfer your presentation file to a different computer and show it from there, and that other computer does not have the same fonts as your PC, you should embed the fonts in your presentation so that the desired fonts are available on the other PC. To embed fonts from the Save As dialog box, click the Tools button, choose Save Options, and select the Embed Fonts in the File check box. This option makes the saved file larger than normal, so choose it only when necessary. For more information on advanced saving features, see the section ‘‘Specifying Save Options.’’ 
 
 Saving Subsequent Times After you have saved a presentation once, you can resave it with the same settings (same file type, name, and location) in any of the following ways: 
 
 Choose File ➪ Save.
 
 
 
 Press Ctrl+S.
 
 
 
 Click the Save button on the Quick Access Toolbar.
 
 If you need to save your presentation under a different name, as a different file type, or in a different location, use the Save As command instead. This reopens the Save As dialog box, as in the preceding steps, so that you can save differently. The originally saved copy will remain under the original name, type, and location.
 
 Tip If you frequently use Save As, you may want to place a button for it on the Quick Access Toolbar. To do this, right-click the Save As command and choose Add to Quick Access Toolbar. 
 
 Changing Drives and Folders By default, all files in PowerPoint (and all of the Office applications) are saved to the Documents folder or library (or My Documents under Windows XP) for the current user. Each user has his or her own version of this folder, so that each person’s documents are kept separate depending on who is logged in to the PC. The Documents folder is a convenient save location for beginners, because they never have to worry about changing the drive or folder. However, more advanced users will sometimes want to save files to other locations. These other locations can include flash drives, other hard disks in
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 the same PC, hard disks on other PCs in a network, hard disks on Web servers on the Internet, or writeable CDs.
 
 Tip Each user has a My Documents folder in his or her own profile. The actual location of that folder depends on the Windows version. For example, in Windows Vista or Windows 7, if Mary is logged in, the path would be C:\Users\Mary\My Documents. In Windows XP, the path would be C:\Documents and Settings\Mary\My Documents. If your usual PowerPoint files seem to be missing at some point, make sure you are logged in under your usual username. If you are using Windows 7, the Documents shortcut in the Libraries list actually refers to a library rather than a single folder, and multiple folders may be associated with the Documents library. No matter — just navigate to the location you want to use. 
 
 Throughout all of the Office programs, the dialog boxes that save and open files are different depending on the operating system you are using.
 
 Changing the Save Location (Windows 7) In Windows 7, the storage locations, and the interface for accessing these locations, are different from earlier versions of Windows. The navigation pane on the left side of the Save As dialog box is home to several collapsible/ expandable categories. Double-click a category to open it and then make selections from within it (see Figure 3-6). You can choose from the following categories: 
 
 Favorites: Shortcuts for popular locations such as Downloads and Desktop appear in the Favorites list, and you can also add your own shortcuts here.
 
 Tip Add your own favorite locations to the Favorites list by dragging their icons into it.  
 
 Libraries: Libraries are virtual folders that organize locations by the types of files they contain. This is a new feature in Windows 7. Double-click Libraries and then click through a category such as Documents or Pictures.
 
 
 
 HomeGroup: Windows 7 has a new home networking feature called HomeGroup; if you use it to set up your network, you can browse other network computers by clicking here.
 
 
 
 Computer: Browse the complete drive and folder listing for your local PC here.
 
 You can also navigate via the Address bar (this applies to both Windows 7 and Windows Vista). The Address bar shows the path to the currently displayed location. You can jump directly to any of those levels by clicking the name there. This is similar to the Up One Level feature from Windows XP–style dialog boxes, except you are not limited to going up a single level at a time — you can go directly up to any level. You can also click the right-pointing arrow to the right of any level to see a menu of other folders within that location, and jump to any of them from the menu, as shown in Figure 3-7.
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 FIGURE 3-6
 
 In Windows 7, the Save As dialog box contains a number of shortcuts for navigation in the left pane.
 
 Jump quickly to favorite locations
 
 Browse libraries (new in Windows 7)
 
 Browse the local Homegroup network (new in Windows 7) Browse the local computer’s drives
 
 FIGURE 3-7
 
 Click an arrow on the Address bar to see a menu of locations at the chosen level within the current path.
 
 Changing the Save Location (Windows Vista) Windows Vista’s Save As dialog box offers some navigation locations that are slightly different from the ones in Windows 7, as shown in Figure 3-8. Here’s a summary: 
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 Favorite Links list: This area displays shortcuts for popular locations such as Documents and Desktop. Double-click a shortcut here to jump to the desired location.
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 FIGURE 3-8
 
 Jump to a desired location using the Favorite Links and/or Folders lists. Favorite links list Folder list
 
 Address bar
 
 Click here to expand and contract the dialog box 
 
 Folders list: This area displays a folder tree of locations, similar to the folder list in a Windows Explorer window, or to the Computer listing in the Windows 7 version of the dialog box. See Figure 3-8. To display the Folders list if it does not already appear, click the up arrow to the right of Folders (below the Favorite Links list). To hide the Folders list, click the down arrow (which replaces the up arrow).
 
 Tip Drag the divider line between the Favorite Links and Folders lists to adjust their relative sizes. Drag the vertical divider line between the lists and the file listing to make the Favorite Links and Folders panes wider or narrower. You can also enlarge the whole Save As dialog box, if necessary, by dragging its border. 
 
 Changing the Save Location (Windows XP) Under Windows XP, the Save In list shows the top-level locations on the system, including each drive, My Documents, and My Network Places. Open the list, as shown in Figure 3-9, and select
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 the location in which you want to start. Then double-click folder icons in the file listing to drill down to the location in which you want to save. To go back up one level, click the Up One Level button. See Figure 3-9. Along the left side of the Save As dialog box is the Places Bar. It’s roughly equivalent to the Favorite Links list in Windows Vista. You can click a folder to jump to the desired location to save a file. FIGURE 3-9
 
 Select a top-level location from the Save In list and then double-click folders to work your way through to the desired location. Up one level button
 
 Places Bar
 
 Tip If you consistently want your PowerPoint files saved into a different folder, change the default file location. Choose File ➪ Options and click Save. Then type a new file location in the Default File Location text box. You cannot browse for it; you must know the full path name. Separate the parts of the path with \ symbols, like this: C:\Books\PowerPoint\PPBible. 
 
 Saving in a Different Format PowerPoint 2007 and higher has an XML-based file format. XML (eXtensible Markup Language) is a text-based coding system similar to HTML that describes formatting by using inline bracketed codes and style sheets. XML-based data files are smaller than the data files from earlier
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 PowerPoint versions, and they support all of the latest PowerPoint features. For best results, use this format whenever possible. There are also several variants of this format for specialty uses. For example, there’s a macro-enabled version with a .pptm extension. There are also ‘‘show’’ variants (.ppsx and .ppsm) that open in Slide Show view by default, and template variants (.potx and .potm) that function as templates. However, not everyone has PowerPoint 2007 or higher. You can download a compatibility pack for earlier PowerPoint versions that will allow them to accept the new files, but you can’t assume that everyone who has an earlier version of PowerPoint will download it. Therefore you might need to save presentations in other file formats in order to share files with other people. The available formats are shown in Table 3-1. In the Save As dialog box, open the Save As Type drop-down list and select the desired format, as shown in Figure 3-10.
 
 FIGURE 3-10
 
 Choose a different format, if necessary, from the Save As Type drop-down list.
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 TABLE 3-1
 
 PowerPoint Save As Formats Presentations: Format
 
 Extension
 
 Usage Notes
 
 PowerPoint Presentation
 
 .pptx
 
 The default; use in most cases. Can open only in PowerPoint 2007 or 2010 (or on an earlier version with compatibility pack installed).
 
 PowerPoint Macro-Enabled Presentation
 
 .pptm
 
 Same as above, except it supports the storage of VBA or macro code.
 
 PowerPoint 97–2003 Presentation
 
 .ppt
 
 A backward-compatible format for sharing files with users of PowerPoint 97, 2000, 2002 (XP), or 2003.
 
 PDF
 
 .pdf
 
 Produces files in Adobe PDF format, which is a hybrid of a document and a graphic. It shows each page exactly as it will be printed, and yet allows the user to mark up the pages with comments and to search the document text. You must have a PDF reader such as Adobe Acrobat to view PDF files.
 
 XPS Document
 
 .xps
 
 Much the same as PDF except it’s a Microsoft format. Windows Vista and higher comes with an XPS viewer application.
 
 PowerPoint Template
 
 .potx
 
 A 2007-format template file.
 
 PowerPoint Macro-Enabled Template
 
 .potm
 
 A 2007-format template file that supports the storage of VBA or macro code.
 
 PowerPoint 97–2003 Template
 
 .pot
 
 A backward-compatible template file, also usable with PowerPoint 97, 2000, 2002 (XP), or 2003.
 
 PowerPoint Show
 
 .ppsx
 
 Just like a regular PowerPoint file, except it opens in Slide Show view by default; useful for distributing presentations to the audience on disk.
 
 PowerPoint Macro-Enabled Show
 
 .ppsm
 
 Same as above, except it supports the storage of VBA or macro code.
 
 PowerPoint 97–2003 Show
 
 .pps
 
 Same as a regular backward-compatible presentation file, except it opens in Slide Show view by default.
 
 PowerPoint Add-in
 
 .ppam
 
 A file that contains executable code (usually VBA) that extends PowerPoint’s capabilities.
 
 PowerPoint 97–2003 Add-in
 
 .ppa
 
 Same as above, except the add-in is backward-compatible.
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 Presentations: Format
 
 Extension
 
 Usage Notes
 
 PowerPoint XML Presentation
 
 .xml
 
 A presentation in XML format, suitable for integrating into an XML information storage system.
 
 Windows Media Video
 
 .wmv
 
 A video version of the presentation (new in PowerPoint 2010).
 
 Office Theme
 
 .thmx
 
 Somewhat like a template, but it contains only theme settings (fonts, colors, and effects). Use this if you don’t want to save any of the content. Theme files can be used to supply the colors, fonts, and effects to Word and Excel files too.
 
 GIF Graphics Interchange Format
 
 .gif
 
 Static graphic. GIFs are limited to 256 colors.
 
 JPEG File Interchange Format
 
 .jpg
 
 Static graphic. JPG files can be very small, making them good for Web use. A lossy format, so picture quality may not be as good as with a lossless format.
 
 PNG Portable Network Graphics Format
 
 .png
 
 Static graphic. Similar to GIF, except without the color depth limitation. Uses lossless compression; takes advantage of the best features of both GIF and JPG.
 
 TIFF Tagged Image File Format
 
 .tif
 
 Static graphic. TIF is a high-quality file format suitable for slides with high-resolution photos. A lossless compression format.
 
 Device Independent Bitmap
 
 .bmp
 
 Static graphic. BMP is the native format for Windows graphics, including Windows background wallpaper.
 
 Windows Metafile
 
 .wmf
 
 Static graphic. A vector-based format, so it can later be resized without distortion. Not Mac-compatible.
 
 Enhanced Windows Metafile
 
 .emf
 
 Enhanced version of WMF; not compatible with 16-bit applications. Also vector-based and non-Mac-compatible.
 
 Outline/RTF
 
 .rtf
 
 Text and text formatting only; excludes all non-text elements. Only text in slide placeholders will be converted to the outline. Text in the Notes area is not included.
 
 PowerPoint Picture Presentation
 
 .pptx
 
 Saves all the slides as pictures and puts them into a new blank presentation.
 
 OpenDocument Presentation
 
 .odp
 
 A presentation that conforms to the new OpenDocument standard for exchanging data between applications.
 
 Graphics/Other:
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 Tip If you consistently want to save in a different format from PowerPoint 2007, choose File ➪ Options and click Save. Then, choose a different format from the Save Files in This Format drop-down list. This makes your choice the default in the Save As Type drop-down list in the Save As dialog box. Not all of the formats are available here; your choices are PowerPoint Presentation (the default), PowerPoint Macro-Enabled Presentation, PowerPoint Presentation 97–2003, and OpenDocument Presentation. 
 
 Table 3-1 lists a lot of choices, but don’t let that overwhelm you. You have three main decisions to make: 
 
 PowerPoint 2007/2010 format or backward-compatible with PowerPoint 97–2003. Unless compatibility is essential, go with the newer format because you get access to all of the new features. (See Table 3-2 to learn what you’ll lose with backward-compatibility.) If you use a backward-compatible format, some of the features described in this book work differently or aren’t available at all.
 
 TABLE 3-2
 
 PowerPoint 2010 Features Not Supported in the PowerPoint 97–2003 File Format Feature
 
 Issues
 
 SmartArt Graphics
 
 Converted to uneditable pictures
 
 Charts (except Microsoft Graph charts)
 
 Converted to editable OLE objects, but the chart might appear different
 
 Custom Slide Layouts
 
 Converted to multiple masters
 
 Drop Shadows
 
 Soft shadows converted to hard shadows
 
 Equations
 
 Converted to uneditable pictures
 
 Heading and body fonts
 
 Converted to non-theme formatting
 
 New effects: • 2-D or 3-D WordArt text • Gradient outlines for shapes or text • Strikethrough and double-strikethrough • Gradient, picture, and texture fills on text • Soft edges, reflections, some types of shadows • Most 3-D effects
 
 Converted to uneditable pictures
 
 Themes
 
 Converted to non-theme formatting
 
 Theme colors
 
 Converted to non-theme colors
 
 Theme effects
 
 Converted to non-theme effects
 
 Theme fonts
 
 Converted to non-theme fonts
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 Macro-enabled or not. If you plan to record and store macros, use a macro-enabled format; if not, use a file format that does not include macro support, for a slightly safer file (because a file cannot carry viruses if it can’t carry macro code).
 
 Cross-Reference See Chapter 24 to learn how to record macros.  
 
 Regular presentation or PowerPoint Show. The ‘‘show’’ variant starts the presentation in Slide Show view when it is loaded in PowerPoint; that’s the only difference between it and a regular presentation. You can build your presentation in a regular format, and then save in show format right before distribution. PowerPoint shows can be opened and edited in PowerPoint the same as any other file.
 
 Most of the other choices from Table 3-1 are special-purpose and not suitable for everyday use. The following sections explain some of those special file types.
 
 Saving Slides as Graphics If you save your presentation in one of the graphic formats shown in the Graphics/Other section of Table 3-1, the file ceases to be a presentation and becomes a series of unrelated graphic files, one per slide. If you choose one of these formats, you’re asked whether you want to export the current slide only or all slides. If you choose all slides, PowerPoint creates a new folder in the selected folder with the same name as the original presentation file and places the graphics files in it.
 
 Tip The Picture Presentation format, new in PowerPoint 2010, does something unique: it converts each slide to an image, and then places the images in a new presentation file. This is one way to make sure your slides are not edited by anyone who uses the presentation. 
 
 Saving Slide Text Only If you want to export the text of the slides to some other application, consider the Outline/RTF format, which creates an outline similar to what you see in the Outline pane in PowerPoint. This file can then be opened in Word or any other application that supports RTF text files. Only text in placeholders is exported, though, not text in manually inserted text boxes.
 
 Specifying Save Options The Save Options enable you to fine-tune the saving process for special needs. For example, you can employ Save Options to embed fonts, to change the interval at which PowerPoint saves AutoRecover information, and more. There are two ways to access the Save options: 
 
 Choose File ➪ Options and click Save.
 
 
 
 From the Save As dialog box, click Tools ➪ Save Options.
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 The PowerPoint Options dialog box appears, as shown in Figure 3-11. FIGURE 3-11
 
 Set Save Options to match the way you want PowerPoint to save your work.
 
 Then set any of the options desired. Click OK when you are finished. Table 3-3 summarizes the Save Options. One of the most important features described in Table 3-3 is AutoRecover, which is turned on by default. This means if a system error or a power outage causes PowerPoint to terminate unexpectedly, you do not lose all of the work you have done. The next time you start PowerPoint, it opens the recovered file and asks if you want to save it.
 
 Caution AutoRecover is not a substitute for saving your work the regular way. It does not save in the same sense that the Save command does; it only saves a backup version as PowerPoint is running. If you quit PowerPoint normally, that backup version is erased. The backup version is available for recovery only if PowerPoint terminates abnormally (because of a system lockup or a power outage, for example). 
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 TABLE 3-3
 
 Save Options Feature
 
 Purpose
 
 Save Files in This Format
 
 Sets the default file format to appear in the Save As dialog box. Your choices are a regular presentation, a macro-enabled presentation, or a 97-2003 backward-compatible presentation.
 
 Save AutoRecover Info Every Minutes
 
 PowerPoint saves your work every few minutes so that if the computer has problems and causes PowerPoint to terminate abnormally, you do not lose much work. Lower this number to save more often (for less potential data loss) or raise it to save less often (for less slowdown/delay related to repeated saving).
 
 AutoRecover File Location
 
 Specify the location in which AutoRecover drafts should be saved. By default, it is C:\Users\username\AppData\Roaming\Microsoft\PowerPoint.
 
 Default File Location
 
 Specify the location that you want to start from when saving with the Save As dialog box. By default, it is your Documents (or My Documents) folder.
 
 Save Checked-Out Files To
 
 Sets the location in which any drafts will be saved that you have checked out of a Web server library such as SharePoint. If you choose The Server Drafts Location on This Computer, then you must specify what that location will be in the Server Drafts Location box. If you choose to save to the Office Document Cache, it’s not an issue because every save goes immediately back to the server.
 
 Show Detailed Changes When a Merge Occurs
 
 Shows full information about what was changed when you merge two PowerPoint files that are stored on a shared document management server.
 
 Embed Fonts in the File
 
 Turn this on if you are saving a presentation for use on a different PC that might not have the fonts installed that the presentation requires. You can choose to embed the characters in use only (which minimizes the file size, but if someone tries to edit the presentation they might not have all of the characters out of the font that they need), or to embed all characters in the font set. Unlike the others, this setting applies only to the current presentation file.
 
 Setting Passwords for File Access If a presentation contains sensitive or confidential data, you can encrypt the file and protect it with a password. Encryption is a type of ‘‘scrambling’’ done to the file so that nobody can see it, either from within PowerPoint or with any other type of file-browsing utility. You can enter two separate passwords for a file: the Open password and the Modify password. Use an Open password to prevent unauthorized people from viewing the file at all. Use a Modify password to prevent people from making changes to the file.
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 You can use one, both, or neither of the password types. For example, suppose you have a personnel presentation that contains salary information. You might use an Open password and distribute that password to a few key people in the Human Resources department who need access to it. But then you might use a Modify password to ensure that none of those people make any changes to the presentation as they are viewing it. For the Open password, you can specify an encryption method and strength. Many encryption codes are available, and the differences between them are significant mostly to high-end technical users. However, if you do have a preference, you can choose it when you choose the Open password. To manage a file’s passwords and other security settings, follow these steps: 1. Begin to save the file as you normally would from the Save As dialog box. 2. In the Save As dialog box, click Tools, and choose General Options. The General Options dialog box opens, as shown in Figure 3-12. FIGURE 3-12
 
 Set a password to prevent unauthorized access.
 
 3. If you want an Open password, enter it in the Password to Open box. 4. If you want a Modify password, enter it in the Password to Modify box. (You don’t have to use both an Open and a Modify password; you can use just one or the other if you like.) 5. (Optional) If you want your personal information stripped from the file, such as your name removed from the Author field of the Properties box, select the Remove Automatically Created Personal Information from This File On Save check box. 6. (Optional) If desired, adjust the macro security level for PowerPoint (all files, not just this one) by clicking the Macro Security button and making changes to the settings in the Trust Center; then click OK to return to the General Options dialog box.
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 7. Click OK. 8. If you specified a password in step 3, a confirmation box appears for it. Retype the same password and click OK. 9. If you specified a password in step 4, a confirmation box appears for it. Retype the same password and click OK. 10. Continue saving as you normally would. When you (or someone else) open the file, a Password prompt appears. The Open password must be entered to open the presentation file. The Modify password will not work. After that hurdle, if you have set a separate Modify password, a prompt for that appears. Your choices are to enter the Modify password, to cancel, or to click the Read-Only option to open the presentation in Read-Only mode.
 
 Caution If you add a Modify password to a PPTX file and then save it as a PPTX file, it can be opened and edited in PowerPoint 2003 or earlier with the compatibility pack installed that allows opening of PPTX files. However, if you save the file in PowerPoint 2010 as a PowerPoint 97–2003 file (PPT file), it cannot be edited in earlier versions. 
 
 Closing and Reopening Presentations You can have several presentation files open at once and switch freely between them, but this can bog down your computer’s performance somewhat. Unless you are doing some cut-and-paste work, it’s best to have only one presentation file open — the one you are actively working on. It’s easy to close and open presentations as needed.
 
 Closing a Presentation When you exit PowerPoint, the open presentation file automatically closes, and you’re prompted to save your changes if you have made any. If you want to close a presentation file without exiting PowerPoint, follow these steps: 1. Choose File ➪ Close. If you have not made any changes to the presentation since the last time you saved, you’re done. 2. If you have made any changes to the presentation, you’re prompted to save them. If you don’t want to save your changes, click Don’t Save, and you’re done. 3. If you want to save your changes, click Save. If the presentation has already been saved once, you’re done. 4. If the presentation has not been saved before, the Save As dialog box appears. Type a name in the File Name text box and click Save.
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 Opening a Presentation To open a recently used presentation, choose Office ➪ Recent. Up to 22 can appear by default (see Figure 3-13). FIGURE 3-13
 
 Open the presentation via the Office menu.
 
 Tip To pin a certain file to the Office menu’s list so that it never scrolls off, click the push-pin icon to the right of the file’s name on the menu. You can increase or decrease the number of recently used files that appear on the Recent list. Choose File ➪ Options, click Advanced, and in the Display section, set the Number of Documents in the Recent Documents List. You can right-click an entry on the Recent Files list for additional options, such as Open as Copy. 
 
 If the presentation you want to open does not appear on the Recent list, follow these steps to find and open it:
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 1. Choose File ➪ Open. The Open dialog box appears. 2. Choose the file you want. If necessary, change the location to find the file.
 
 Cross-Reference See the section ‘‘Changing Drives and Folders’’ earlier in this chapter if you need help. 
 
 3. Click Open. The presentation opens. To open more than one presentation at once, hold down the Ctrl key as you click each file you want to open. Then, click the Open button and they all open in their own windows. For more information, see the ‘‘Working with Multiple Presentations’’ section later in this chapter. The Open button in the Open dialog box has its own drop-down list from which you can select commands that open the file in different ways. See Figure 3-14, and refer to Table 3-4 for an explanation of the available options.
 
 FIGURE 3-14
 
 The Open button’s menu contains several special options for opening a file.
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 TABLE 3-4
 
 Open Options Open Button Setting
 
 Purpose
 
 Open
 
 The default; simply opens the file for editing.
 
 Open Read-Only
 
 Allows changes but prevents those changes from being saved under the same name.
 
 Open as Copy
 
 Opens a copy of the file, leaving the original untouched.
 
 Open in Browser
 
 Applicable only for Web-based presentations; opens it for viewing in a Web browser. PowerPoint 2010 does not save in Web format, so it applies only to Web-based presentations created in earlier versions of PowerPoint.
 
 Open in Protected View
 
 Opens the file in an uneditable view. This option not only prevents you from saving any changes to the file, but it also prevents you from making changes.
 
 Open and Repair
 
 Opens the file, and identifies and repairs any errors it finds in it.
 
 Show Previous Versions
 
 Applicable only if the presentation file is stored on an NTFS volume under Windows Vista or Windows 7. See the next section for details.
 
 Opening a File from a Different Program Just as you can save files in various program formats, you can also open files from various programs. PowerPoint can detect the type of file and convert it automatically as you open it, so you do not have to know the exact file type. (For example, if you have an old PowerPoint file with a .ppt extension, you don’t have to know what version it came from.) The only problem is with files that don’t have extensions that PowerPoint automatically recognizes. In that case, you must change the File Type setting in the Open dialog box to All Files so that the file to be opened becomes available on the file list, as shown in Figure 3-15. This change is valid for only this one use of the Open dialog box; the file type reverts to All PowerPoint Presentations, which is the default, the next time you open it.
 
 Caution PowerPoint opens only presentation files and text-based files such as Word outlines. If you want to include graphics from another program in a PowerPoint presentation, insert them using the Picture command on the Insert tab. Do not attempt to open them with the Open dialog box. 
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 FIGURE 3-15
 
 To open files from different programs, change the File Type setting to All Files.
 
 Working with Multiple Presentations You will usually work with only one presentation at a time. But occasionally you may need to have two or more presentations open at once — for example, to make it easier to copy text or slides from one presentation to another. To open another presentation, choose File ➪ Open and select the one you want, the same as usual. When more than one presentation is open, you can switch among them by selecting the one you want to see from the taskbar in Windows. Alternatively, you can click the Switch Windows button on the View tab and select any open presentation from there as shown in the following figure.
 
 Switch between open windows of all applications — not just PowerPoint — by pressing Alt+Esc repeatedly to cycle through them, or by holding down the Alt key and pressing Tab to browse thumbnails of open windows.
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 Finding a Presentation File to Open If you have forgotten where you saved a particular presentation file, you’re not out of luck. The Open dialog box (under Windows Vista and Windows 7) includes a Search box that can help you locate it, as shown in Figure 3-16. FIGURE 3-16
 
 Use the Search box in the Open dialog box (Windows Vista and Windows 7 only) to look for a file. Type search word here
 
 Results matching search
 
 To search for a file, follow these steps: 1. Choose File ➪ Open to display the Open dialog box. 2. Navigate to a location that you know the file is in. For example, if you know it is on the C: drive, display the top-level listing for the C: drive. 3. Click in the Search box and type part of the filename (if you know it) or a word or phrase used in the file. 4. Press Enter. A list of files that match that specification appears. 5. Open the file as you normally would.
 
 Note You can also use the Search utility from outside of PowerPoint. In Windows, click Start and choose Search. Although the Search utilities are different in each version of Windows, they all can find a file by name, content, author, date, or many other properties. 
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 Setting File Properties File properties are facts about each file that can help you organize them. If you have a lot of PowerPoint files, using file properties can help you search intelligently for them using the Search feature you learned about in the preceding section. For example, you can specify an author, a manager, and a company for each file, and then search based on those values. To view the document’s properties, click the File button to open Backstage view. The document’s properties appear in the right pane. You can set a file’s properties by doing the following: 1. Click File to open Backstage view. 2. Click Properties (on the right side of the Info section), and on the menu that appears, click Show Document Panel. A Properties Ribbon appears above the presentation window. 3. Fill in any information you want to store about the presentation, as shown in Figure 3-17. 4. Click the down arrow to the right of Document Properties in the Properties Ribbon, and choose Advanced Properties. The Properties dialog box for the file appears. 5. Click the Summary tab, and confirm or change any information there. This is the same information that you entered in the Properties Ribbon, with the addition of a couple of other fields, as shown in Figure 3-18. 6. Click the Custom tab, shown in Figure 3-19, and choose any additional fields you need and set values for them. For example, click the Client field on the Name list, and type a value for it in the Value text box. Repeat this for any of the other custom fields. 7. Review the information on the Statistics and Contents tab if desired. (You can’t change that information.) 8. Click OK. Now you can use the contents of the properties fields when performing a search.
 
 FIGURE 3-17
 
 Enter information to store in the file’s properties.
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 FIGURE 3-18
 
 The Summary tab has many of the same fields as the Ribbon.
 
 FIGURE 3-19
 
 The Custom tab enables you to set custom properties based on your tracking needs.
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 Managing Files from Within PowerPoint To save yourself some time, you can perform certain file management tasks without leaving PowerPoint. Any dialog box that enables you to select a file to open, such as the Open dialog box, or enables you to save a file, such as the Save As dialog box, can also be used to copy, delete, and rename files.
 
 Creating a New Folder When saving files, you might want to create a new folder to put them in. To create a new folder in a Windows Vista or Windows 7–style dialog box, click New Folder in the command bar. Figure 3-20 shows the Save As dialog box in Windows 7, which looks similar to the one in Windows Vista. To create a new folder in Windows XP, click the New Folder button in the row of buttons that appears across the top of the Save As dialog box, as shown in Figure 3-21.
 
 Copying a Presentation One way to copy a presentation is to open it and then save it under a different name. (You learned to do this earlier in this chapter.) But here’s a method that enables you to copy without having to first open the file: 1. From the Open dialog box, select the file you want to copy. (You can also use the Save As dialog box.) 2. Right-click the file and choose Copy from the shortcut menu. 3. If necessary, change to a different drive and/or folder. 4. Right-click an empty area in the list of files. 5. Choose Paste from the shortcut menu. The file appears. If you pasted it into the same folder as the original, the new one has the words — Copy at the end of its name to differentiate it. Rename it if desired.
 
 Cross-Reference For more on renaming files, see the section ‘‘Renaming a Presentation’’ later in this chapter. 
 
 6. Click Cancel to close the dialog box.
 
 Deleting a Presentation Just as you can copy a file, you can delete a presentation file from Windows itself, bypassing PowerPoint altogether. Just select the file in Windows Explorer and press the Delete key, or drag it to the Recycle Bin on the Windows desktop.
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 FIGURE 3-20
 
 Create a new folder from a Windows 7 or Windows Vista–style dialog box. Click here to create a new folder
 
 Type a name for the new folder
 
 To delete a file from within PowerPoint, select it from the Save As or Open dialog box and press the Delete key on the keyboard or right-click it and choose Delete. (Or in a Windows XP–style dialog box, you can click the Delete button on the toolbar.) You cannot delete a file that is currently open.
 
 Note If you accidentally delete a file, you can get it back if you deleted it from Windows; just open the Recycle Bin and drag it back out. 
 
 Renaming a Presentation To rename a file from within the Save As or Open dialog boxes, click it and then press F2, or right-click it and choose Rename from the shortcut menu. Then type the new name and press Enter. If you have the display of file extensions for known file types turned off in Windows (the default), you do not need to type the .pptx extension when renaming files. In fact, if you do type it, the file may end up with a double extension, like myfile.pptx.pptx. On the other hand,
 
 86
 
 Chapter 3: Creating and Saving Presentation Files
 
 FIGURE 3-21
 
 Create a new folder from a Windows XP–style dialog box. Delete New Folder
 
 if you have the display of file extensions turned on, you must type the file extension while renaming a file.
 
 Tip To change the setting that governs whether or not file extensions are displayed, open a Windows Explorer window and then: 
 
 Windows 7: Choose Organize ➪ Folder and Search Options
 
 
 
 Windows Vista: Choose Organize ➪ Folder and Search Options
 
 
 
 Windows XP: Choose Tools ➪ Folder Options
 
 Then click the View tab and select or clear the Hide Extensions for Known File Types check box. 
 
 Mapping a Network Drive Mapping a network drive assigns a drive letter to a folder on a remote PC. This might be useful if you save frequently to a network location and you don’t want to have to wade through multiple levels of folders each time to find it. (In Windows XP, you can accomplish the same thing by creating a shortcut in My Network Places.)
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 To map the currently displayed folder as a network drive, open the Tools menu from either the Open or Save As dialog box and choose Map Network Drive. This opens a dialog box that lets you associate a drive letter with the location.
 
 Summary This chapter made you a master of files. You can now confidently create new presentations, and save, open, close, and delete PowerPoint presentation files. You can also save files in different formats, search for missing presentations, and lots more. This is rather utilitarian knowledge and not very much fun to practice, but later you will be glad you took the time to learn it, when you have important files you need to keep safe. In the next chapter, you learn about slide layouts and text-based presentations. You also learn how to create your own layouts, and how to use the Outline pane to create the text that will form the basis of your message.
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 P
 
 owerPoint makes it easy to create consistent, attractive slides that use standard preset layouts. You just choose the layout that you want for a particular slide and then fill in its placeholders with text, graphics, or other content. In this chapter, you’ll learn how to build a simple text-based presentation by creating new slides and entering text on them. You’ll learn how to import content from other programs, and how to create, size, and position text boxes to hold the text for your presentation.
 
 IN THIS CHAPTER Creating new slides Inserting content from external sources Managing slides Using content placeholders Creating text boxes manually
 
 Creating New Slides
 
 Working with text boxes
 
 Different templates start a presentation with different numbers and types of slides. A blank presentation has only a single slide, and you must create any others that you want. There are several ways to create new slides. For example, you can type new text in the outline and then promote it to slide status, or you can add slides with the New Slide button that is on the Home tab. You can also copy existing slides, either within the same presentation or from other sources. The following sections outline these procedures in more detail.
 
 Creating New Slides from the Outline Pane As discussed in Chapter 1, the Outline pane shows the text from the presentation’s slides in a hierarchical tree, with the slide titles at the top level (the slide level) and the various levels of bulleted lists on the slides displaying as subordinate levels. Text that you type in the Outline pane appears on the slide, and vice versa, as shown in Figure 4-1.
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 FIGURE 4-1
 
 When you type text into the Outline pane, it automatically appears on the current slide.
 
 Note The Outline pane doesn’t actually show all of the text in all cases; see ‘‘Creating Text Boxes Manually’’ later in this chapter to find out why text in some text boxes does not appear in the Outline pane. 
 
 Follow these steps to create a new slide from the Outline pane: 1. Switch to Normal view and display the Outline pane (as in Figure 4-1) if it does not already appear. 2. Right-click the existing line on the Outline pane that the new slide should follow. 3. Click New Slide. A new line appears in the Outline pane, with a slide symbol to its left. 4. Type the title for the new slide. The title appears both in the Outline pane and on the slide. You can also create a new slide by starting a new line in the Outline pane and then promoting it to slide level by pressing Shift+Tab. Follow these steps to insert a new slide in this way: 1. Position the insertion point at the end of the last line of the slide that the new slide should follow, and press Enter to start a new line.
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 2. Press Shift+Tab to promote the new line to the highest level (press it multiple times if needed), so that a slide icon appears to its left. 3. Type the title for the new slide. The title appears both in the Outline pane and on the slide. After creating the slide, you can continue creating its content directly in the Outline pane. Press Enter to start a new line, and then use Tab to demote, or Shift+Tab to promote, the line to the desired level. You can also right-click the text and choose Promote or Demote. Promoting a line all the way to the top level changes the line to a new slide title.
 
 Creating a Slide from the Slides Pane Here’s a very quick method for creating a new slide, based on the default layout. It doesn’t get much easier than this: 1. In Normal view, in the Slides pane, click the slide that the new slide should follow. 2. Press Enter. A new slide appears using the Title and Content layout. You can also right-click the slide that the new one should follow and choose New Slide. The drawback to creating a slide in either of these ways is that you cannot specify the layout. To choose a layout other than the default one, see the next section.
 
 Creating a Slide from a Layout A slide layout is a layout guide that tells PowerPoint what placeholder boxes to use on a particular slide and where to position them. Although slide layouts can contain placeholders for text, they also contain graphics, charts, tables, and other useful elements. After you create a new slide with placeholders, you can click a placeholder to open whatever controls you need to insert that type of object.
 
 Cross-Reference See the section, ‘‘Using Content Placeholders’’ for more information on inserting objects. 
 
 When you create new slides using the outline method described in the preceding section, the new slides use the Title and Content layout, which consists of a slide title and a single, large placeholder box for content. If you want to use another layout, such as a slide with two adjacent but separate frames of content, you must either switch the slide to a different layout after its creation (using the Layout menu on the Home tab), or you must specify a different layout when you initially create the slide. To specify a certain layout as you are creating a slide, follow these steps: 1. In Normal or Slide Sorter view, select or display the slide that the new one should follow. You can select a slide by clicking its thumbnail image in Slide Sorter view or on the Slides pane in Normal view. You can also move the insertion point to the slide’s text in the Outline pane.
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 2. On the Home tab, do one of the following: 
 
 To add a new slide using the default Title and Content layout, click the top (graphical) portion of the New Slide button.
 
 
 
 To add a new slide using another layout, click the bottom (text) portion of the New Slide button and then select the desired layout from the menu, as shown in Figure 4-2.
 
 FIGURE 4-2
 
 Create a new slide, based on the layout of your choice.
 
 Click the top part for a default layout Click the bottom part to open the gallery
 
 Tip The layouts that appear on the menu come from the slide master. To customize these layouts, click Slide Master on the View tab. You will learn more about the slide master and about changing layouts in Chapter 5. 
 
 Copying Slides Another way to create a new slide is to copy an existing one in the same presentation. This is especially useful when you are using multiple slides to create a progression because one slide is typically identical to the next slide in a sequence, except for a small change. (You can also
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 build effects within a single slide using PowerPoint’s animation effects, as you will learn in Chapter 18.) There are several ways to copy one or more slides. One way is to use the Windows Clipboard, as in the following steps: 1. Select the slide or slides that you want to copy. See ‘‘Selecting Slides’’ later in this chapter for more information about selecting slides.
 
 Caution If you select from the Outline pane, make sure that you click the icon to the left of the slide’s title so that the entire slide is selected; if you select only part of the text on the slide, then only the selected part is copied. 
 
 2. Press Ctrl+C. You can also click the Copy button on the Home tab, or right-click the selection and click Copy. 3. Select the slide that the pasted slide or slides should follow. Alternately, in the Outline pane, click to place the insertion point where you want the insertion. 4. Press Ctrl+V. You can also click the Paste button on the Home tab, or right-click the destination and click Paste. PowerPoint also has a Duplicate Slides command that does the same thing as a copy-and-paste command. Although it may be a little faster, it gives you less control as to where the pasted copies will appear: 1. Select the slide or slides to be duplicated. 2. On the Home tab, click the bottom part of the New Slide button to open its menu. 3. Click Duplicate Selected Slides. As an alternative, you can right-click a slide (or a group of selected slides) in the Slides pane and choose Duplicate Slide. PowerPoint pastes the slides immediately after the last slide in the selection. For example, if you selected slides 1, 3, and 6, then the copies are placed after slide 6.
 
 Tip To make duplication even faster, you can place the Duplicate Selected Slides command on the Quick Access toolbar. To do that, right-click the command on the menu and choose Add to Quick Access Toolbar. 
 
 Inserting Content from External Sources Many people find that they can save a lot of time by copying text or slides from other programs or from other PowerPoint presentations to form the basis of a new presentation. There’s no need to reinvent the wheel each time! The following sections look at various ways to bring in content from external sources.
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 Copying Slides from Other Presentations There are several ways to copy slides from other presentations. You can: 
 
 Open the presentation, save it under a different name, and then delete the slides that you don’t want, leaving a new presentation with the desired slides ready for customization.
 
 
 
 Open two PowerPoint windows side-by-side and drag-and-drop slides between them.
 
 
 
 Open two PowerPoint presentations, copy slides from one of them to the Clipboard (Ctrl+C), and then paste them into the other presentation (Ctrl+V).
 
 
 
 Use the Reuse Slides feature in PowerPoint, as described next.
 
 To reuse slides from other presentations with the Reuse Slides feature, follow these steps: 1. On the Home tab, click the lower portion of the New Slide button to open its menu. 2. Click Reuse Slides. The Reuse Slides pane appears. 3. Click Open a PowerPoint File. OR Click the Browse button and then click Browse File. 4. In the Browse dialog box, select the presentation from which you want to copy slides, and click Open. Thumbnail images of the slides in the presentation appear in the Reuse Slides pane, as shown in Figure 4-3. 5. (Optional) If you want to keep the source formatting when copying slides, select the Keep Source Formatting check box at the bottom of the task pane. 6. (Optional) To see an enlarged image of one of the slides, move the mouse pointer over it. 7. Do any of the following: 
 
 To insert a single slide, click it.
 
 
 
 To insert all slides at once, right-click any slide and choose Insert All Slides.
 
 
 
 To copy only the theme (not the content), right-click any slide and choose Apply Theme to All Slides, or Apply Theme to Selected Slides.
 
 Inserting New Slides from an Outline All of the Microsoft Office applications work well together, and so it’s easy to move content between them. For example, you can create an outline for a presentation in Microsoft Word and then import it into PowerPoint. PowerPoint uses the heading styles that you assigned in Word to decide which items are slide titles and which items are slide content. The top-level headings (Heading 1) form the slide titles. To try this out, open Word, switch to Outline view (from the View tab), and then type a short outline of a presentation. Press Tab to demote, or Shift+Tab to promote, a selected line. Then save your work, go back to PowerPoint, and follow these steps to import it: 1. On the Home tab, click the lower portion of the New Slide button to open its menu.
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 2. Click Slides from Outline. The Insert Outline dialog box opens. 3. Select the file containing the outline text that you want to import. 4. Click Insert. PowerPoint imports the outline. If there were already existing slides in the presentation, they remain untouched. (This includes any blank slides, and so you might need to delete the blank slide at the beginning of the presentation after importing.) All of the Heading 1 lines from the outline become separate slide titles, and all of the subordinate headings become bullet points in the slides.
 
 FIGURE 4-3
 
 Choose individual slides to copy to the current presentation.
 
 Tips for Better Outline Importing Although PowerPoint can import any text from any Word document, you may not always get the results that you want or expect. For example, you may have a document that consists of a series of paragraphs with no heading styles applied. When you import this document into PowerPoint, it might look something like Figure 4-4.
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 FIGURE 4-4
 
 A Word document consisting mainly of plain paragraphs makes for an unattractive presentation.
 
 Figure 4-4 is a prime example of what happens if you don’t prepare a document before you import it into PowerPoint. PowerPoint makes each paragraph its own slide and puts all of the text for each one in the title placeholder. It can’t tell which ones are actual headings and which ones aren’t because there are no heading styles in use. The paragraphs are too long to fit on slides, and so they are truncated off the tops of the slides. Extra blank lines are interpreted as blank slides. Quite a train wreck, isn’t it? Figure 4-4 also illustrates an important point to remember: Regular paragraph text does not work very well in PowerPoint. PowerPoint text is all about short, snappy bulleted lists and headings. The better that you prepare the outline before importing it, the less cleanup you will need to do after importing. Here are some tips:
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 Non-headings in Word do not import into PowerPoint unless you use no heading styles at all in the document (as in Figure 4-4). Apply heading styles to the text that you want to import.
 
 
 
 Stick with basic styles only in the outline: for example, just Heading 1, Heading 2, and so on.
 
 
 
 Delete all blank lines above the first heading. If you don’t, you will have blank slides at the beginning of your presentation.
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 Strip off as much manual formatting as possible from the Word text, so that the text picks up its formatting from PowerPoint. To strip off formatting in Word, select the text and press Ctrl+spacebar.
 
 
 
 Do not leave blank lines between paragraphs. These will translate into blank slides or blank bulleted items in PowerPoint.
 
 
 
 Delete any graphic elements, such as clip art, pictures, charts, and so on. They will not transfer to PowerPoint anyway and may confuse the import utility.
 
 Importing from Other Text-Based Formats In addition to Word, PowerPoint also imports from plain-text files, from WordPerfect (5.× or 6.×), from Microsoft Works, and from Web pages. The procedure is the same as in the preceding steps. If the file does not appear in the Insert Outline dialog box, change the file type to the desired file type. If you are setting up a plain-text file for import, you obviously won’t have the outlining tools from Word at your disposal. Instead, you must rely on tabs. Each line that should be a title slide should start at the left margin; first-level bullet paragraphs should be preceded by a single tab; second-level bullets should be preceded by two tabs, and so on.
 
 Post-Import Cleanup After importing text from an outline, there will probably be a few minor corrections that you need to make. Run through this checklist: 
 
 The first slide in the presentation might be blank. If it is, then delete it.
 
 
 
 The Title Slide layout may not be applied to the first slide; apply that layout, if necessary. (You can use the Layout list on the Home tab.)
 
 
 
 A theme may not be applied; choose one from the Design tab, if necessary, or format your slide masters and layouts as desired.
 
 Cross-Reference See Chapter 5 for more information on working with themes.  
 
 Some of the text might contain manual formatting that interferes with the theme formatting and creates inconsistency. Remove any manual formatting that you notice. (One way to do this is to select all of the text in the Outline pane by pressing Ctrl+A and then stripping off the manual formatting by pressing Ctrl+spacebar or by clicking the Reset button in the Slides group on the Home tab.)
 
 
 
 If some of the text is too long to fit comfortably on a slide, change to a different slide layout, such as a two-column list, if necessary. You might also need to split the content into two or more slides.
 
 
 
 There might be some blank bullet points on some slides (if you missed deleting all of the extra paragraph breaks before importing). Delete these bullet points.
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 Opening a Word Document as a New Presentation Instead of importing slides from a Word document or other text-based document, as described in the preceding section, you can simply open the Word document in PowerPoint. PowerPoint starts a new presentation file to hold the imported text. This saves some time if you are starting a new presentation anyway, and you don’t have any existing slides to merge with the incoming content. To open a Word document in PowerPoint, follow these steps: 1. Choose File ➪ Open. The Open dialog box appears. 2. Change the file type to All Outlines. 3. Select the document. 4. Click Open. The document outline becomes a PowerPoint presentation, with all Heading 1 paragraphs becoming title slides.
 
 Caution You can’t open or insert a Word outline in PowerPoint if it is currently open in Word. This limitation is an issue only for Word files, not plain text or other formats. 
 
 Importing Text from Web Pages PowerPoint accepts imported text from several Web-page formats, including HTML and MHTML (Single File Web Page). It is helpful if the data is in an orderly outline format, or if it was originally created from a PowerPoint file, because there will be less cleanup needed. There are several ways to import from a Web page: 
 
 Open a Web-page file as you would an outline (see the preceding section), but set the file type to All Web Pages.
 
 
 
 Insert the text from the Web page as you would a Word outline (in the Home tab, click New Slide ➪ Slides from Outline).
 
 
 
 Reuse slides from a Web presentation as you would from any other presentation (in the Home tab, click New Slide ➪ Reuse Slides).
 
 Caution You should use one of the above methods rather than pasting HTML text directly into PowerPoint. This is because when you paste HTML text, you might get additional HTML tags that you don’t want, including cross-references that might cause your presentation to try to log onto a Web server every time you open it. 
 
 When importing from a Web page, don’t expect the content to appear formatted the same way that it was on the Web page. We’re talking strictly about text import here. The formatting on the Web page comes from HTML tags or from a style sheet, neither of which you can import. If you want an exact duplicate of the Web page’s appearance, take a picture of the page with the Shift+PrintScreen command, and then paste it into PowerPoint (Ctrl+V) as a graphic.
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 If you are importing an outline from an MHTML-format Web page that contains pictures, the pictures are also imported into PowerPoint. If importing from a regular HTML file, you cannot import the pictures.
 
 Tip If you need to show a live Web page from within PowerPoint, try Shyam Pillai’s free Live Web add-in, found at www.mvps.org/skp/liveweb.htm. 
 
 Managing Slides After inserting a few slides into a presentation, and perhaps building some content on them, you might decide to make some changes, such as rearranging, deleting, and so on. The following sections explain how to manage and manipulate the slides in a presentation.
 
 Selecting Slides Before you can issue a command that acts upon a slide or a group of slides, you must select the slides that you want to affect. You can do this from either Normal or Slide Sorter view, but Slide Sorter view makes it easier because you can see more slides at once. From Slide Sorter view, or from the Slides pane in Normal view, you can use any of these techniques to select slides: 
 
 To select a single slide, click it.
 
 
 
 To select multiple slides, hold down the Ctrl key as you click each one. Figure 4-5 shows slides 1, 3, and 6 selected, as indicated by the shaded border around the slides.
 
 
 
 To select a contiguous group of slides (for example, slides 1, 2, and 3), click the first slide, and then hold down the Shift key as you click the last one. All of the slides in between are selected as well.
 
 To cancel the selection of multiple slides, click anywhere outside of the selected slides. To select slides from the Outline pane in Normal view, click the slide icon to the left of the slide’s title; this selects the entire slide, as shown in Figure 4-6. It’s important to select the entire slide and not just part of its content before issuing a command such as Delete, because otherwise, the command only affects the portion that you selected.
 
 Deleting Slides You may want to get rid of some of the slides, especially if you created your presentation using a template that contained a lot of sample content. For example, the sample presentation may be longer than you need, or you may have inserted your own slides instead. Select the slide or slides that you want to delete, and then do either of the following: 
 
 Right-click the selection and choose Delete Slide.
 
 
 
 Press the Delete key on the keyboard.
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 FIGURE 4-5
 
 Select slides in Slide Sorter view by holding down the Ctrl key and clicking each slide.
 
 Selected slides
 
 Undoing Mistakes Here’s a command that can help you in almost all of the other chapters in this book: undoing. The Undo command allows you to reverse past actions. For example, you can use it to reverse all of the deletions that you made to your presentation in the preceding section. The easiest way to undo a single action is to click the Undo button on the Quick Access toolbar or press Ctrl+Z. You can click it as many times as you like; each time you click it, you undo one action.
 
 Tip By default, the maximum number of Undo operations is 20, but you can change this. Choose File ➪ Options, then click Advanced, and in the Editing Options section, change the Maximum Number of Undos setting. Keep in mind that if you set the number of undos too high, it can cause performance problems in PowerPoint. 
 
 You can undo multiple actions at once by opening the Undo button’s drop-down list, as shown in Figure 4-7. Just drag the mouse across the actions that you want to undo (you don’t need to
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 hold down the mouse button). Click when the desired actions are selected, and presto, they are all reversed. You can select multiple actions to undo, but you can’t skip around. For example, to undo the fourth item, you must undo the first, second, and third ones, as well. FIGURE 4-6
 
 Select slides in the Outline pane by clicking the slide icon to the left of the slide title.
 
 Slide icons
 
 The Redo command is the opposite of Undo. If you make a mistake with the Undo button, you can fix the problem by clicking the Redo button. Like the Undo button, it has a drop-down list, and so you can redo multiple actions at once. The Redo command is available only immediately after you use the Undo command. If Redo isn’t available, a Repeat button appears in its place. The Repeat command enables you to repeat the last action that you performed (and it doesn’t have to be an Undo operation). For example, you can repeat some typing, or some formatting. Figure 4-8 shows the Repeat button.
 
 Rearranging Slides The best way to rearrange slides is to do so in Slide Sorter view. In this view, the slides in your presentation appear in thumbnail view, and you can move them around on the screen to different positions, just as you would manually rearrange pasted-up artwork on a table. Although you
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 can also do this from the Slides pane in Normal view, you are able to see fewer slides at once. As a result, it can be more challenging to move slides around, for example, from one end of the presentation to another. To rearrange slides, use the following steps: 1. Switch to Slide Sorter view. 2. Select the slide that you want to move. You can move multiple slides at once if you like. 3. Drag the selected slide to the new location. The mouse pointer changes to a little rectangle next to the pointer arrow as you drag. A vertical line also appears where the slide will go if you release the mouse button at that point, as shown in Figure 4-9. 4. Release the mouse button. The slide moves to the new location.
 
 FIGURE 4-7
 
 Use the Undo button to undo your mistakes and the Redo button to reverse an Undo operation. Undo
 
 Redo
 
 FIGURE 4-8
 
 The Repeat button appears when Redo is not available, and enables you to repeat actions. Repeat
 
 102
 
 Chapter 4: Creating Slides and Text Boxes
 
 FIGURE 4-9
 
 As you drag a slide, its new position is indicated by a vertical line.
 
 Vertical line shows destination
 
 Slide being dragged
 
 You can also rearrange slides in the Outline pane in Normal view. This is not quite as easy as using Slide Sorter view, but it’s more versatile. Not only can you drag entire slides from place to place, but you can also move individual bullets from one slide to another. Follow these steps to move content in the Outline pane: 1. Switch to Normal view and display the Outline pane. 2. Position the mouse pointer over the slide’s icon. The mouse pointer changes to a four-headed arrow. 3. Click on the icon. PowerPoint selects all of the text in that slide. 4. Drag the slide’s icon to a new position in the outline and then release the mouse button. All of the slide’s text moves with it to the new location. There are also keyboard shortcuts for moving a slide up or down in the Outline pane that may be faster than clicking the toolbar buttons. You can press the Alt+Shift+Up arrow keys to move a slide up, and the Alt+Shift+Down arrow keys to move a slide down. These shortcuts work equally well with single bullets from a slide. Just click to the left of a single line to select it, instead of clicking the Slide icon in step 3.
 
 Using Content Placeholders Now that you know something about inserting and managing entire slides, let’s take a closer look at the content within a slide. The default placeholder type is a multipurpose content placeholder, as shown in Figure 4-10.
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 FIGURE 4-10
 
 A content placeholder can contain a variety of different elements. Text
 
 Table
 
 Picture
 
 Chart
 
 Clip Art
 
 Smart Art
 
 Movie
 
 Inserting Content into a Placeholder To type text into a content placeholder, click inside the placeholder box and start typing. You can enter and edit text as you would in any word-processing program. To insert any other type of content into a placeholder, click one of the icons shown in Figure 4-10. A dialog box opens to help you select and insert that content type.
 
 Cross-Reference Chapters 6 and 7 cover the various formatting that you can apply to text on a slide. You will learn about these various content types later in the book: 
 
 Tables: Chapter 9
 
 
 
 SmartArt: Chapter 11
 
 
 
 Clip Art: Chapter 12
 
 
 
 Pictures (from files): Chapter 13
 
 
 
 Charts: Chapter 14
 
 
 
 Movies: Chapter 17 
 
 A content placeholder can hold only one type of content at a time. If you click in the placeholder and type some text, the icons for the other content types disappear. To access them again, you must delete all of the text from the placeholder.
 
 Placeholders versus Manually Inserted Objects You can insert content on a slide independently of a placeholder by using the Insert tab’s buttons and menus. This technique allows you to insert an item in its own separate frame on any slide,
 
 104
 
 Chapter 4: Creating Slides and Text Boxes
 
 to coexist with any placeholder content. You can learn how to insert each content type in the chapters in which they are covered (see the preceding list).
 
 Creating Text Boxes Manually The difference between a placeholder-inserted object and a manually inserted one is most significant with text boxes. Although you might think that all text boxes are all alike, there are actually some significant differences between placeholder text boxes and manually inserted ones. Here are some of the characteristics of a text placeholder: 
 
 You cannot create new text placeholder boxes on your own, except in Slide Master view.
 
 Cross-Reference You learn how to use Slide Master view to create your own layouts that contain custom text placeholders in Chapter 5.  
 
 If you delete all of the text from a text placeholder, the placeholder instructions return (in Normal view).
 
 
 
 A text placeholder box has a fixed size on the slide, regardless of the amount or size of text that it contains. You can resize it manually, but if you reapply the layout, the placeholder box snaps back to the original size.
 
 
 
 AutoFit is turned on by default in a text placeholder, so that if you type more text than will fit, or resize the frame so that the existing text no longer fits, the text shrinks in size.
 
 
 
 The text that you type in a text placeholder box appears in the Outline pane.
 
 A manual text box, on the other hand, is one that you create yourself using the Text Box tool on the Insert tab. Here are some characteristics of a manual text box: 
 
 You can create a manual text box anywhere, and you can create as many as you like, regardless of the layout.
 
 
 
 If you delete all of the text from a manual text box, the text box remains empty or disappears completely. No placeholder instructions appear.
 
 
 
 A manual text box starts out small vertically, and expands as you type more text into it.
 
 
 
 A manual text box does not use AutoFit by default; the text box simply becomes larger to make room for more text.
 
 
 
 You cannot resize a manual text box so that the text that it contains no longer fits; PowerPoint refuses to make the text box shorter vertically until you delete some text from it. (However, you can decrease its horizontal width.)
 
 
 
 Text typed in a manual text box does not appear in the Outline pane.
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 Figure 4-11 shows two text placeholders (one empty) and a text box. Notice that the empty placeholder contains filler text to help you remember that it is there. Notice also that only the text from the placeholder appears in the Outline pane; the text-box text does not. Empty text boxes and placeholders do not show up in Slide Show view, so you do not have to worry about deleting any unneeded ones.
 
 FIGURE 4-11
 
 Two text placeholders and a text box.
 
 Text box content does not appear in outline
 
 Manually placed text box Text placeholder (in use)
 
 Text placeholder (empty)
 
 When Should You Use a Manual Text Box? Graphical content such as photos and charts can work well either in placeholders or as manually inserted objects. However, when it comes to text, you should stick with placeholders as often as possible. Placeholder text appears in the Outline pane, whereas text in a manually inserted text box does not. When the bulk of a presentation’s text is in manually created text boxes, the outline becomes less useful because it doesn’t contain the presentation text. In addition, when you change to a different formatting theme that includes different positioning for placeholders — for example, to accommodate a graphic on one side — the manual text boxes do not shift. As a result, they might end up overlapping the new background graphic with unattractive results. In a case such as this, you would need to manually go through each slide and adjust the positioning of each text box. However, there are times when a manually created text box is preferable or even necessary. For example, suppose that you have a schematic diagram of a machine and you need to label
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 some of the parts. Manually placed text boxes are perfect for these little snippets of text that are scattered over the surface of the picture. Manual text boxes are also useful for warnings, tips, and any other information that is tangential to the main discussion. Finally, if you want to vary the placement of the text on each slide (consciously circumventing the consistency provided by layouts), and you want to precisely position each box, then manual text boxes work well because they do not shift their position when you apply different themes or templates to the presentation.
 
 Tip If you insert text in a placeholder and then change the slide’s layout so that the slide no longer contains that placeholder (for example, if you switch to Title Only or Blank layout), the text remains on the slide, but it becomes an orphan. If you delete the text box, then it simply disappears; a placeholder does not reappear. However, it does not become a manual text box, because its content still appears in the Outline pane, while a manual text box’s content does not. 
 
 Creating a Manual Text Box To manually place a text box on a slide, follow these steps: 1. If necessary, reposition the existing placeholders or objects on the slide to make room for the new text box. 2. On the Insert tab, click Text Box. The mouse pointer turns into a vertical line. You can alternately use the Text Box icon in any of the Shapes galleries, such as the one on the Insert tab. 3. Do either of the following: 
 
 To create a text box that automatically enlarges itself horizontally as you type more text, but does not automatically wrap text to the next line, click once where you want the text to start, and begin typing.
 
 
 
 To create a text box with a width that you specify, and that automatically wraps text to the next line and grows in height as needed, click and drag to draw a box where you want the text box to be. Its height will initially snap back to a single line’s height, regardless of the height that you initially draw; however, it will grow in height as you type text into it.
 
 4. Type the text that you want to appear in the text box.
 
 Working with Text Boxes Text boxes (either placeholder or manual) form the basis of most presentations. Now that you know how to create them, and how to place text in them, let’s take a look at how to manipulate the boxes themselves.
 
 Cross-Reference Are you looking for information about formatting text boxes — perhaps to apply a background color or a border to one? See the formatting text boxes discussion in Chapter 7. 
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 Selecting Text Boxes On the surface, this topic might seem like a no-brainer. Just click it, right? Well, almost. A text box has two possible ‘‘selected’’ states. One state is that the box itself is selected, and the other is that the insertion point is within the box. The difference is subtle, but it becomes clearer when you issue certain commands. For example, if the insertion point is in the text box and you press Delete, PowerPoint deletes the single character to the right of the insertion point. However, if you select the entire text box and press Delete, PowerPoint deletes the entire text box and everything in it. To select the entire text box, click its border. You can tell that it is selected because the border appears as a solid line. To move the insertion point within the text box, click inside the text box. You can tell that the insertion point is there because you can see it flashing inside, and also because the box’s border now consists of a dashed line. Figure 4-12 shows the difference between the two borders. FIGURE 4-12
 
 The border of a text box is different when the box itself is selected (left) and when the insertion point is in the box (right).
 
 In the rest of this book, when you see the phrase ‘‘select the text box,’’ it means the box itself should be selected, and the insertion point should not appear in it. For most of the upcoming sections it does not make any difference, although in a few cases it does.
 
 Tip When the insertion point is flashing in a text box, you can press Esc to select the text box itself. 
 
 You can select more than one text box at once by holding down the Shift key as you click additional text boxes. This technique is useful when you want to select more than one text box, for example, so that you can format them in the same way, or so that you can resize them by the same amount.
 
 Sizing a Text Box The basic techniques for sizing text boxes in PowerPoint are the same for every object type (for that matter, they are also the same as in other Office applications). To resize a text box, or any object, follow these steps:
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 1. Position the mouse pointer over a selection handle for the object. The mouse pointer changes to a double-headed arrow. If you want to resize proportionally, make sure that you use a corner selection handle, and hold down the Shift key as you drag. 2. Click and drag the selection handle to resize the object’s border.
 
 Caution Allowing PowerPoint to manage placeholder size and position through layouts ensures consistency among your slides. When you start changing the sizes and positions of placeholders on individual slides, you can end up creating consistency problems, such as headings that aren’t in the same spot from slide to slide, or company logos that shift between slides. 
 
 You can also set a text box’s size from the Size group on the Drawing Tools Format tab. When the text box is selected, its current dimensions appear in the Height and Width boxes, as shown in Figure 4-13. You can change the dimensions within these boxes.
 
 FIGURE 4-13
 
 You can set an exact size for a text box from the Format tab’s Size group.
 
 Height Width Dialog box launcher
 
 You can also set the size of a text box from the Size and Position dialog box: 1. Click the dialog box launcher in the Size group on the Drawing Tools Format tab, as shown in Figure 4-13. The Format Shape dialog box opens with the Size tab displayed. 2. On the Size tab, set the height and width for the text box, as shown in Figure 4-14. To keep the size proportional, select the Lock Aspect Ratio check box in the Scale section before you start adjusting the height or width. 3. (Optional) Click Close to close the dialog box.
 
 Tip The Format Shape dialog box is non-modal . This means that you can leave it open and continue to work on your presentation. It also means that any changes that you make in this dialog box are applied immediately; there is no Cancel button in the dialog box to cancel your changes. To reverse a change, you can use the Undo command (Ctrl+Z). 
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 FIGURE 4-14
 
 You can adjust the size of the text box from the Format Shape dialog box.
 
 Positioning a Text Box To move an object, simply drag it by any part of its border other than a selection handle. Select the object, and then position the mouse pointer over a border so that the pointer turns into a four-headed arrow. Then drag the object to a new position. With a text box, you must position the mouse pointer over a border and not over the inside of the frame; with all other object types, you don’t have to be that precise; you can move an object by dragging anywhere within it. To set an exact position, use the Format Shape dialog box: 1. Click the dialog box launcher in the Size group on the Drawing Tools Format tab, as shown in Figure 4-13. The Format Shape dialog box opens. 2. On the Position tab, shown in Figure 4-15, set the horizontal and vertical position, and the point from which it is measured. By default, measurements are from the top-left corner of the slide. 3. (Optional) Click Close to close the dialog box.
 
 Changing a Text Box’s AutoFit Behavior When there is too much text to fit in a text box, there are three things that may happen: 
 
 110
 
 Do Not AutoFit: The text and the box can continue at their default sizes, and the text can overflow out of the box or be truncated.
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 Shrink Text on Overflow: The text can shrink its font size to fit in the text box. This is the default setting for placeholder text boxes.
 
 
 
 Resize Shape to Fit Text: The text box can enlarge to the size needed to contain the text. This is the default setting for manual text boxes.
 
 FIGURE 4-15
 
 You can adjust the position from the Format Shape dialog box.
 
 Whenever there is too much text in a placeholder box, the AutoFit icon appears in the bottom-left corner. Click that icon to display a menu, as shown in Figure 4-16. From that menu, you can turn AutoFit on or off. Depending on the text-box type, you might not have all the menu items shown in Figure 4-16. FIGURE 4-16
 
 You can use the AutoFit icon’s menu to change the AutoFit setting for a text box.
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 With a manual text box, the AutoFit icon does not appear, and so you must adjust the AutoFit behavior in the text box’s properties. The following method works for both manual and placeholder boxes: 1. Right-click the border of the text box and choose Format Shape. 2. Click Text Box. 3. In the Autofit section, choose one of the Autofit options, as shown in Figure 4-17. 4. Click Close. FIGURE 4-17
 
 You can set AutoFit properties in the Format Shape dialog box.
 
 One other setting that also affects AutoFit behavior is the Wrap Text in Shape option. This on/off toggle enables text to automatically wrap to the next line when it reaches the right edge of the text box. By default, this setting is On for placeholder text boxes and for manual text boxes that you create by dragging. However, it is Off by default for manual text boxes that you create by clicking. You can change the setting by displaying the text box’s properties, as shown in Figure 4-17, and selecting or deselecting the Wrap Text in Shape check box.
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 Table 4-1 summarizes the various AutoFit behaviors and how they interact with one another. TABLE 4-1
 
 AutoFit and Resize Shape to Fit Text Behaviors Setting
 
 Default For
 
 When Wrap Text in Shape Is On
 
 When Wrap Text in Shape Is Off
 
 Do Not Autofit
 
 n/a
 
 Text overflows at bottom of text box
 
 Text overflows at right and text box only
 
 Shrink Text on Overflow
 
 Placeholders
 
 Text shrinks to fit
 
 Text shrinks to fit
 
 Resize Shape to Fit Text
 
 Manual text boxes
 
 Text box expands vertically only (default for manual text that you create by dragging)
 
 Text box expands vertically and horizontally (default for manual box that you create by text box clicking). However, if you clicked to create the text box initially, the width keeps expanding until you press Enter.
 
 Summary In this chapter, you learned how to create new slides, either from scratch or from outside sources. You learned how to select, rearrange, and delete slides, and how to place content on a slide. Along the way, you learned the difference between a content placeholder and a manually inserted object, and how to create your own text boxes, move and resize objects, and find or replace text. These are all very basic skills, and perhaps not as interesting as some of the more exciting topics to come, but mastering them will serve you well as you build your presentation. In the next chapter, you’ll learn about themes and layouts, two of the innovative features in PowerPoint 2010 that make it such an improvement over earlier versions. You’ll find out how a theme differs from a template and how it applies font, color, and effect formatting to a presentation. You will then apply layouts and create your own custom layouts and themes.
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 M
 
 ost presentations consist of multiple slides, so you’ll need a way of ensuring consistency among them. Not only will you want each slide (in most cases) to have the same background, fonts, and text positioning, but you will also want a way of ensuring that any changes you make to those settings later automatically populate across all your slides.
 
 To accomplish these goals, PowerPoint offers layouts, themes, and masters. Layouts determine the positioning of placeholders; themes assign color, font, and background choices; and masters transfer theme settings to the slides and provide an opportunity for repeated content, such as a logo, on each slide. In this chapter you learn how to use layouts, themes, and masters to create a presentation that is attractive, consistent, and easy to manage.
 
 IN THIS CHAPTER Changing a slide’s layout Applying a theme Customizing theme formatting Specifying repeated elements Modifying a slide layout Creating a new slide layout Managing themes and layouts Storing themes in custom templates
 
 Understanding Layouts and Themes As you learned in Chapter 4, a layout is a positioning template. The layout used for a slide determines what content placeholders will appear and how they will be arranged. For example, the default layout, called Title and Content, contains a placeholder for a title across the top of the slide and a multipurpose placeholder for body content in the center. A theme is a group of design settings. It includes color settings, font choices, object effect settings, and in some cases also a background graphic. In Figure 5-1, the theme applied is called Concourse, and it is responsible for the colored swoop in the corner, the color of that swoop, and the fonts used on the slide. A theme is applied to a slide master, which is a sample slide and not part of the regular presentation, existing only behind-the-scenes to provide its settings to the real slides. It holds
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 the formatting that you want to be consistent among all the slides in the presentation (or at least a group of them, because a presentation can have multiple slide masters). Technically, you do not apply a theme to a slide; you apply a theme to a slide master, and then you apply a slide master to a slide. That’s because a slide master can actually contain some additional elements besides the formatting of the theme such as extra graphics, dates, footer text, and so on.
 
 FIGURE 5-1
 
 In Slide Master view, notice that each layout has its own customizable layout master.
 
 Slide Master
 
 Subordinate master for each layout
 
 Themes versus Templates PowerPoint 2007 and 2010 handle themes, layouts, and slide masters very differently from earlier versions, and this can take some getting used to if you’re upgrading from PowerPoint 2003 or earlier. In PowerPoint 2003 and earlier, you applied a design template (not a theme) to the slide master. A design template was a regular PowerPoint template file (.pot extension) with color choices, font choices, and background graphics. You could have multiple slide masters in a single presentation, so you could base some slides on a different design template than others. PowerPoint 2007 and 2010 still use templates, but the primary means of changing the presentation’s look and feel is to apply different themes to the slide master rather than different templates to the presentation as a whole. A template with multiple slide masters can carry multiple themes.
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 A theme is both simpler than and more complex than a template. It is simpler because it cannot hold some of the things a real template can hold. A theme can provide only font, color, effect, and background settings to the presentation. (It can also provide slide layouts, but let’s postpone that discussion for a bit.) On the other hand, a theme can also do more than a PowerPoint template; you can apply a theme saved as a separate file to other Office applications, so you can share its color, font, and effect settings with Word or Excel, for example.
 
 Where Themes Are Stored A theme is an XML file (or a snippet of XML code embedded in a presentation or template file). A theme can come from any of these sources: 
 
 Built-in: Some themes are embedded in PowerPoint itself and are available from the Themes gallery on the Design tab regardless of the template in use.
 
 
 
 Custom (automatically loaded): The default storage location for theme files in Windows Vista or Windows 7 is C:\Users\username\AppData\Roaming\Microsoft\Templates\ Document Themes. For Windows XP, it is C:\Documents and Settings\username\ Application Data\Microsoft\Templates\Document Themes. All themes (and templates containing themes) stored here are automatically displayed among the gallery of theme choices on the Design tab, in a Custom category.
 
 
 
 Inherited from starting template: If you start a presentation using a template other than the default blank one, that template might have one or more themes included in it.
 
 
 
 Stored in current presentation: If you modify a theme in Slide Master view while you are working on a presentation, the modified code for the theme is embedded in that presentation file.
 
 
 
 Stored in a separate file: If you save a theme (using any of a variety of methods you’ll learn later in this chapter), you create a separate theme file with a .thmx extension. These files can be shared among other Office applications, so you can standardize settings such as font and color choices across applications. (Some of the unique PowerPoint portions of the theme are ignored when you use the theme in other applications.)
 
 Themes, Layouts, and Slide Master View In PowerPoint 2010, the slide master has separate layout masters for each layout, and you can customize and create new layouts. For example, Figure 5-1 shows Slide Master view (View ➪ Slide Master). Notice along the left side that there is a different, separately customizable layout master for each available layout, all grouped beneath the slide master. Any changes you make to the slide master trickle down to the individual layout masters, but you can also customize each of the individual layout masters to override a trickle-down setting. For example, on a particular layout you can choose to omit the background graphic to free up its space on the slide for extra content. A master is a set of specifications that govern formatting and appearance. PowerPoint actually has three masters: the Slide Master (for slides), the Handout Master (for handouts), and the Notes Master (for speaker notes). This chapter deals only with the Slide Master.
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 Cross-Reference For more on the Handout and Notes Masters, see Chapter 19. 
 
 The slide master holds the settings from a theme and applies them to one or more slides in your presentation. A slide master is not exactly the same thing as a theme because the theme can also be external to PowerPoint and used in other programs, but there’s a rough equivalency there. A slide master is the representation of a particular theme applied to a particular presentation.
 
 Note Which themes appear in Slide Master view? The ones you have applied to at least one slide in the presentation, plus any custom themes copied from another presentation (see the section ‘‘Copying a Theme from Another Presentation’’ for more details) and any themes inherited from the template used to create the presentation. The built-in themes do not show up here unless they are in use. 
 
 When you make changes to a slide master, those changes trickle down to the individual layout masters associated with it. When you make changes to an individual layout master, those changes are confined to that layout in that master only. To enter Slide Master view, choose View ➪ Slide Master. A Slide Master tab appears. To exit from Slide Master view, choose Slide Master ➪ Close Master View or select a different view from the View tab.
 
 Changing a Slide’s Layout As you construct your presentation, you may find it useful to change a slide’s layout. For example, you might want to switch from a slide that contains one big content placeholder to one that has two side-by-side placeholders, to compare/contrast two lists, drawings, or diagrams. Many of the layouts PowerPoint provides contain multipurpose placeholders that accept various types of content. For example, the default layout, called Title and Content, has placeholders for a slide title plus a single type of content — text, a table, a chart, a picture, a piece of clip art, a SmartArt diagram, or a movie. You choose the layout you want based on the number and arrangement of the placeholders, and not the type of content that will go into them. When you change to a different layout, you change the type and/or positioning of the placeholders on it. If the previous placeholders had content in them, that content shifts to a new location on the slide to reflect the different positioning for that placeholder type. If the new layout does not contain a placeholder appropriate for that content, the content remains on the slide but becomes orphaned. This means it is a free-floating object, outside of the layout. You need to manually position an orphaned object if it’s not in the right spot. However, if you later apply a different layout that does contain a placeholder for the orphaned object, it snaps back into that placeholder. To switch a slide to a different layout, follow these steps: 1. Select the slide or slides to affect. 2. On the Home tab, click Layout. A menu of layouts appears, as shown in Figure 5-2. 3. Click the desired layout.
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 FIGURE 5-2
 
 Switch to a different layout for the selected slide(s).
 
 Cross-Reference If you want to modify a built-in layout, or create your own layouts, see ‘‘Customizing and Creating Layouts’’ later in this chapter. 
 
 When a presentation has more than one slide master defined, separate layouts appear for each of the slide master themes. Figure 5-3 shows the Layout menu for a presentation that has two slide masters.
 
 Applying a Theme As you learned in ‘‘Understanding Layouts and Themes’’ at the beginning of this chapter, themes are the PowerPoint 2010 way of applying different designs to the presentation. A theme includes a background graphic (usually), color and font choices, and graphic effect settings. A theme can also include custom layouts. The method for applying a theme depends on whether that theme is already available in the current presentation or not. Some themes are built into PowerPoint so that they are always available; other themes are available only when you use certain templates, or when you specifically apply them from an external file. The following sections explain each of those possibilities.
 
 Note Themes , also called design themes , contain a combination of colors, fonts, effects, backgrounds, and layouts. There are also more specialized themes: color themes, font themes, and effect themes. When this book uses the term ‘‘theme’’ alone, it’s referring to a design theme. Where there is potential for confusion, the book calls it a design theme to help differentiate it from the lesser types of themes. 
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 FIGURE 5-3
 
 When there are multiple slide masters, each one’s layout is separate.
 
 Applying a Theme from the Gallery A gallery in PowerPoint is a menu of samples from which you can choose. The Themes gallery is a menu of all of the built-in themes plus any additional themes available from the current template or presentation file. To select a theme from the gallery, follow these steps: 1. (Optional) If you want to affect only certain slides, select them. (Slide Sorter view works well for this.) 2. On the Design tab, in the Themes group, if the theme you want appears, click it, and skip the rest of these steps. If the theme you want does not appear, you will need to open the gallery. To do so, click the down arrow with the line over it, as shown in Figure 5-4.
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 FIGURE 5-4
 
 Open the Themes gallery by clicking the down arrow with the line above it.
 
 Click here
 
 The Themes gallery opens, as shown in Figure 5-5. The gallery is divided into sections based upon the source of the theme. Themes stored in the current presentation appear at the top; custom themes you have added appear next. Built-in themes appear at the bottom. FIGURE 5-5
 
 Select the desired theme from the menu.
 
 Tip You can drag the bottom-right corner of the menu to resize the gallery. To filter the gallery so that only a certain category of theme appears, click the down arrow to the right of All Themes at the top and select a category from the menu that appears. 
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 3. Click the theme you want to apply. 
 
 If you selected multiple slides in step 1, the theme is applied only to them.
 
 
 
 If you selected a single slide in step 1, the theme is applied to the entire presentation.
 
 Tip To override the default behavior in step 3, so that you can apply a different theme to a single slide, right-click instead of clicking in step 3 and choose Apply to Selected Slide(s) from the shortcut menu. 
 
 Applying a Theme from a Theme or Template File You can open and use externally saved theme files in any Office application. This makes it possible to share color, font, and other settings between applications to create consistency between documents of various types. You can also save and load themes from templates.
 
 Cross-Reference To create your own theme files, see ‘‘Creating a New Theme’’ later in this chapter. 
 
 To apply a theme to the presentation from a theme or template file, follow these steps: 1. On the Design tab, open the Themes gallery (see Figure 5-5) and click Browse for Themes. The Choose Theme or Themed Document dialog box opens. 2. Navigate to the folder containing the file and select it. 3. Click Apply.
 
 Note Any custom themes you might have previously saved are located by default in C:\Users\username \AppData\ Roaming\Microsoft\Templates\Document Themes (in Windows Vista or Windows 7) or C:\ Documents and Settings\username \Application Data\Microsoft\Templates\Document Themes (in Windows XP). However, you don’t need to navigate to that location to open a theme file because all themes stored here are automatically included in the gallery already. 
 
 Changing Colors, Fonts, and Effects In addition to overall themes, which govern several types of formatting, PowerPoint also provides many built-in color, font, and effect themes that you can apply separately from your choice of overall theme. So, for example, you can apply a theme that contains a background design you like, and then change the colors and fonts for it. In the following sections, you’ll learn how to apply some of these built-in color, font, and effect settings to a presentation without changing the overall theme. Then later in the chapter you will learn how to save these customized settings as new themes and even how to create your own custom color and font settings in a theme.
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 Understanding Color Placeholders To understand how PowerPoint changes colors via a theme, you must know something about how it handles color placeholders in general. PowerPoint uses a set of color placeholders for the bulk of its color formatting. Because each item’s color is defined by a placeholder, and not as a fixed color, you can easily change the colors by switching to a different color theme. This way if you decide, for example, that you want all the slide titles to be blue rather than green, you make the change once and it is applied to all slides automatically. A group of colors assigned to preset placeholders is a color theme. PowerPoint contains 20+ built-in color themes that are available regardless of the overall theme applied to the presentation. Because most design themes use placeholders to define their colors, you can apply the desired design theme to the presentation and then fine-tune the colors afterward by experimenting with the built-in color themes. How many color placeholders are there in a color theme? There are actually 12, but sometimes not all of them are available to be applied to individual objects. When you choose a color theme (Design ➪ Colors), the gallery of themes from which you choose shows only the first eight colors of each color theme. It doesn’t matter so much here because you can’t apply individual colors from there anyway. When selecting colors from a color picker (used for applying fill and border color to specific objects), as in Figure 5-6, there are 10 theme swatches. And when you define a new custom color theme, there are 12 placeholders to set up. The final two are for visited and unvisited hyperlinks; these colors aren’t included in a color picker.
 
 FIGURE 5-6
 
 PowerPoint uses color pickers such as this one to enable you to easily apply color placeholders to objects.
 
 Switching Color Themes After applying the overall theme you want, you might want to apply different colors. To switch to a different color theme, follow these steps: 1. (Optional) To apply a different color theme to a slide master other than the default one, open Slide Master view (View ➪ Slide Master) and click the desired slide master. Otherwise, the color change will apply to all slides that use the default slide master. The default slide master is the first one listed in Slide Master view.
 
 123
 
 Part I: Building Your Presentation
 
 2. On the Design tab (or the Slide Master tab if in Slide Master view), click Colors. A gallery of color themes opens. 3. (Optional) Point to a color theme and observe the preview on the slide behind the list. 4. Click the desired color theme. See Figure 5-7. FIGURE 5-7
 
 Select the desired theme from the dialog box.
 
 Cross-Reference You can also create custom color themes; see the section ‘‘Creating a Custom Color Theme’’ later in this chapter for details. 
 
 Understanding Font Placeholders By default in most themes and templates, text box fonts are not set to a specific font, but to one of two designations: Heading or Body. Then a font theme defines what specific fonts to use. To change the fonts across the entire presentation, all you have to do is apply a different font theme.
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 A font theme is an XML-based specification that defines a pair of fonts: one for headings and one for body text. Then that font is applied to the text boxes in the presentation based on their statuses of Heading or Body. For example, all of the slide titles are usually set to Heading, and all of the content placeholders and manual text boxes are usually set to Body. In a blank presentation (default blank template), when you click inside a slide title placeholder box, you see Calibri (Headings) in the Font group on the Home tab. Figure 5-8 shows that the current font is Calibri, but that it is being used only because the font theme specifies it. You could change the font theme to Verdana/Verdana, for example, and then the font designation for that box would appear as Verdana (Headings). FIGURE 5-8
 
 When some text is using a font placeholder rather than a fixed font, (Headings) or (Body) appears after its name in the Font group on the Home tab.
 
 In some font themes, the same font is used for both headings and body. In a default blank presentation both fonts are Calibri, for example, and the Verdana/Verdana set is an additional example. In many other font themes, though, the heading and body fonts are different.
 
 Switching Font Themes After applying an overall theme, you might decide you want to use different fonts in the presentation. To switch to a different font theme, follow these steps: 1. (Optional) To apply a different font theme to a slide master other than the default one, open Slide Master view (View ➪ Slide Master) and click the desired slide master. Otherwise, the font change will apply to all slides that use the default slide master. The default slide master is the first one listed in Slide Master view. 2. On the Design tab (or Slide Master tab, if in Slide Master view), click Fonts. A gallery of font themes opens. 3. (Optional) Point to a font theme and observe the change on the slide behind the list. 4. Click the desired font theme. See Figure 5-9.
 
 Changing the Effect Theme Effect themes apply to several types of drawings that PowerPoint can construct, including SmartArt, charts, and drawn lines and shapes. They make the surfaces of objects formatted with 3-D attributes look like different textures (more or less shiny-looking, colors more or less deep, and so on).
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 FIGURE 5-9
 
 Select the font theme you want for your slide.
 
 To change the effect theme, follow these steps: 1. On the Design tab, click Effects. A gallery of effect themes opens. 2. (Optional) Point to a theme and observe the change on the slide behind the list. (This works only if you have an object on that slide that is affected by the effect theme; see the sidebar ‘‘Setting Up a Graphic on Which to Test Effect Themes’’ to set up such an object.) 3. Click the desired effect theme. See Figure 5-10.
 
 Setting Up a Graphic on Which to Test Effect Themes Because you haven’t worked with any of these graphics yet in this book, you haven’t had an opportunity to try them out yet. Effect themes are most evident when you use colorful 3-D graphics, so do the following to construct a dummy diagram that you can use to try out effect themes:
 
 1. On the Insert tab, click SmartArt. 2. Click Cycle, click the top left diagram, and click OK.
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 3. On the SmartArt Tools Design tab, click Change Colors, and click the first sample under Colorful.
 
 4. On the SmartArt Tools Design tab, open the SmartArt Styles gallery and click the first sample under 3-D. Now you have a diagram on which you can see the effect themes applied.
 
 FIGURE 5-10
 
 Select the desired effect theme.
 
 Creating and Managing Custom Color and Font Themes You can define your own custom color themes and font themes, and save them for reuse in other presentations. By default these are saved in the personal folders for the logged-in user on the local PC, and they remain available to that user regardless of the theme or template in use. These custom color and font themes are also included if you save the overall theme as a separate theme file (.thmx), as you will learn to do later in this chapter, so that you can take those settings to another PC or send them to some other user.
 
 127
 
 Part I: Building Your Presentation
 
 Creating a Custom Color Theme A custom color theme defines specific colors for each of the 12 color placeholders (including the two that you can’t directly use — the ones for hyperlinks). To create a custom color theme, first apply a color theme to the current presentation that is as close as possible to the color theme you want. This makes it easier because you have to redefine fewer placeholders. Then follow these steps: 1. On the Design tab, open the Colors list and choose Create New Theme Colors. The Create New Theme Colors dialog box opens. 2. Type a name for the new color theme in the Name box, replacing the default name (Custom 1, or other number if there is already a Custom 1). 3. Click a color placeholder and open its menu. See Figure 5-11. FIGURE 5-11
 
 Select the color for the chosen placeholder.
 
 4. Click a color. Alternatively, you can click More Colors, select a color from the Colors dialog box (see Figure 5-12), and click OK. The Colors dialog box has two tabs: The Standard tab has color swatches, and the Custom tab enables you to define a color numerically by its RGB (Red Green Blue) or HSL (Hue Saturation Lightness). 5. Redefine any other colors as needed. 6. Click Save. The color theme is saved, and now appears at the top of the Colors gallery, in the Custom area.
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 FIGURE 5-12
 
 Choose a custom color if none of the standard colors is appropriate.
 
 Sharing a Custom Color Theme with Others A custom color theme is available only to the currently logged-in user on the PC on which it is created. If you want to share it with another user on the same PC, you can copy it into his or her user folder in Windows Vista or Windows 7: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes\Theme Colors where username is that user’s login name. 
 
 In Windows XP: C:\Documents and Settings\username\Application Data\Microsoft\Templates\Document Themes\Theme Colors.
 
 
 
 The default color themes are located in: C:\Program Files\Microsoft Office\Document Themes 14\Theme Colors regardless of the operating system version.
 
 Another way to share a custom color theme is to create the new color theme and then save the (overall) theme to a theme file (.thmx). See ‘‘Creating a New Theme’’ later in this chapter. The resulting theme file will contain the custom colors, as well as the usual theme content.
 
 Deleting a Custom Color Theme A custom color theme remains until you delete it from the Theme Colors folder for your user profile. To delete a theme color, use Windows Explorer to navigate to this folder: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes\Theme Colors
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 where username is your login name, and you’ll find an .xml file for each of your custom color themes. Delete the files for the color themes that you want to delete. You can also right-click the color theme in the Gallery, click Edit, and then click the Delete button in the Edit Theme Colors dialog box.
 
 Tip If you don’t want to delete a custom color theme, but you also don’t want it showing up on your Colors menu in PowerPoint all the time, move the file to a folder outside of the Document Themes folder hierarchy. For example, create an Unused Themes folder on your hard disk and move it there until you need it. When you want to use the custom color theme again, move the file back to its original location 
 
 If you don’t want to exit from PowerPoint to delete the color theme, you can take advantage of the fact that you can use most dialog boxes in PowerPoint that save or open files to manage files in general. Follow these steps: 1. Open any dialog box that saves or opens files. For example, on the Design tab, open the Themes gallery and choose Browse for Themes. 2. Navigate to the location of the color themes: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes\Theme Colors 3. Open the File Type list and choose All Files so that all of the files appear. 4. Select the file for the color theme that you want to delete and press the Delete key on the keyboard. 5. Click Cancel to close the dialog box.
 
 Creating a Custom Font Theme You can create your own custom font themes, which are then available in all presentations. A custom font theme defines two fonts: one for headings and one for body text. To create a custom font theme, follow these steps: 1. On the Design tab, open the Fonts list and choose Create New Theme Fonts. The Create New Theme Fonts dialog box opens, as shown in Figure 5-13. FIGURE 5-13
 
 Create a new custom font theme by specifying the fonts to use.
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 2. Type a name for the new font theme in the Name box, replacing the default text there. 3. Open the Heading Font drop-down list and select the desired font for headings. 4. Open the Body Font drop-down list and select the desired font for body text. 5. Click Save. The font theme is saved, and now appears at the top of the Fonts list, in the Custom area.
 
 Sharing a Custom Font Theme with Others A custom font theme is available only to the currently logged-in user on the PC on which it is created. If you want to share it with another user on the same PC, you can copy it into his or her user folder: 
 
 In Windows Vista or Windows 7: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes\Theme Fonts where username is that user’s login name.
 
 
 
 In Windows XP: C:\Documents and Settings\username\Application Data\Microsoft\Templates\Document Themes\Theme Fonts
 
 You can also share a custom font theme by creating it and then saving the (overall) theme as a new theme (.thmx) file. Then you can share that theme file with others via e-mail, disk, or other distribution methods.
 
 Cross-Reference To save your theme as a new theme, see the section ‘‘Creating a New Theme.’’ 
 
 Deleting a Custom Font Theme A custom font theme remains until you delete it from the Theme Fonts folder for your user profile. To delete a font theme, use Windows Explorer to navigate to this folder: 
 
 In Windows Vista or Windows 7: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes\Theme Fonts
 
 
 
 In Windows XP: C:\Documents and Settings\username\Application Data\Microsoft\Templates\Document Themes\Theme Fonts
 
 where username is your login name, and you’ll find an .xml file for each of your custom font themes. Delete the files for the font themes that you want to delete. You can also delete it from within PowerPoint by browsing for the file with any dialog box that saves or opens files, or by right-clicking the font theme in the Gallery, clicking Edit, and then clicking Delete in the Edit Theme Fonts dialog box.
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 Cross-Reference Deleting a custom font theme from a dialog box is essentially the same as deleting a custom color theme. See the section ‘‘Deleting a Custom Color Theme’’ for more details. 
 
 Changing the Background The background is the color, texture, pattern, or image that is applied to the entire slide (or slide master), on which everything else sits. By its very definition, it applies to the entire surface of the slide; you cannot have a partial background. However, you can have a background graphic overlaid on top of the background. A background graphic is a graphic image placed on the slide master that complements and works with the background. It’s important to understand the distinction between a background and a background graphic because even though most themes contain both, they are set up differently, and making the change you want to the overall appearance of your slides often involves changing both. For example, Figure 5-14 shows the Concourse theme applied to a slide master. The slide background is pure white, and a blue and black background graphic is overlaid on it. FIGURE 5-14
 
 A slide’s background is separate from its background graphic(s) if any are present.
 
 Background graphic (on slide master)
 
 Background (plain white)
 
 Most themes consist of both background formatting (even if it is just a solid color) and a background graphic. The background graphics included in the built-in themes in PowerPoint are unique to those themes, and not available as separate graphics outside of them. So, for example, if you want the colored swoop shown in Figure 5-14, the only way to get it is to apply the Concourse theme. Because the decorative background graphics are unique to each theme, many
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 people choose a theme based on the desired background graphic, and then customize the slide master’s appearance to modify the theme as needed.
 
 Tip To use a background graphic from one template with the look-and-feel of another, apply the first theme to a slide, and then in Slide Master view copy the background graphic to the clipboard. Then apply the second theme and paste the graphic from the clipboard into the slide master. 
 
 Applying a Background Style Background styles are preset background formats that come with the built-in themes in PowerPoint. Depending on the theme you apply, different background styles are available. These background styles all use the color placeholders from the theme, so their color offerings change depending on the color theme applied. To apply a background style, follow these steps: 1. (Optional) To affect only certain slides, select them. (Or, to affect certain layouts, go into Slide Master view and choose the layouts.) 2. On the Design tab, click Background Styles. A gallery of styles appears, as shown in Figure 5-15. FIGURE 5-15
 
 Apply a preset background style.
 
 3. Click the desired style to apply it to the entire presentation. Alternatively, you can right-click the desired style and choose Apply to Selected Slides. You cannot customize background styles or add your own custom background styles; there are always 12 of them, and they are always determined by the theme. If you need a different background, you can choose Format Backgrounds and then customize the background settings as described in the following sections.
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 Applying a Background Fill A custom background fill can include solid colors, gradients, textures, or graphics. Because Chapter 10 covers these in more detail, this section covers how to specify your own background fill, which involves the following steps: 1. (Optional) To affect only certain slides, select them. . (Or, to affect certain layouts, go into Slide Master view and choose the layouts.) 2. On the Design tab, click Background Styles. The Background Styles gallery opens. 3. Click Format Background. The Format Background dialog box opens. 4. Choose the option button that best describes the type of fill you want. See Figure 5-16. 5. Set the options for the fill type that you chose. For example, in Figure 5-16, click the Color button and choose a solid color. The changes you make apply immediately. FIGURE 5-16
 
 Select a background fill type, and configure the options for the type you chose.
 
 Cross-Reference See Chapter 10 for details about these fill types and how to configure their options. 
 
 6. (Optional) To apply the change to all slides, click Apply to All. Otherwise the change will apply only to the slides you selected in step 1. 7. (Optional) To apply a different background to some other slides, select them and repeat steps 4 and 5. The Format Background dialog box is non-modal, so its changes are applied immediately and you can select things in the presentation file without closing it. 8. Click Close to exit the dialog box.
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 Working with Background Graphics In the preceding steps, one of the fill types you could choose was Picture or Texture Fill. This type of fill covers the entire background with the picture or texture that you specify. This is not a background graphic, however. A background graphic is an object or a picture overlaid on top of the background on the slide master. It complements the background, and it might or might not cover the entire background.
 
 Note Some theme-provided background graphics actually consist of multiple shapes grouped together. You can ungroup them, as shown in Chapter 10, so that you can modify or remove only a portion of the background graphic. 
 
 Displaying and Hiding Background Graphics Sometimes a background graphic can get in the way of the slide’s content. For example, on a slide that contains a large chart or diagram, a background graphic around the border of the slide can overlap the content. You don’t have to delete the background graphic entirely to solve this problem; you can turn it off for individual slides. To hide the background graphics on one or more slides, follow these steps: 1. Select the slide or slides to affect. 2. On the Design tab, select the Hide Background Graphics check box. Deselect the check box to redisplay the background graphics later as needed.
 
 Deleting Background Graphics The background graphics reside on the slide master, so to remove one, you must use Slide Master view. Follow these steps: 1. On the View tab, click Slide Master. Slide Master view opens. 2. Select the slide master or layout master that contains the graphic to delete. 3. Click the background graphic to select it. 4. Press the Delete key on the keyboard.
 
 Tip Some background graphics are on the slide master itself, and others are on individual layout masters. The background graphics on the slide master trickle down to each of its layout masters, but can’t be selected/deleted from the individual layout masters. To use a background graphic only on certain layouts, cut it from the slide master to the Clipboard (Ctrl+X), and then paste it individually onto each layout master desired (Ctrl+V). Alternatively, turn on the background graphic for the slide master and then use Hide Background Graphics on individual layout masters that should not contain it. 
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 Adding Your Own Background Graphics You can add your own background graphics, either to the slide master or to individual layout masters. This works just like adding any other graphic to a slide (see Chapter 13), except you add it to the master instead of to an individual slide. Inserting pictures is covered in greater detail in Chapter 13, but here are the basic steps for adding a background graphic: 1. Display the slide master or layout master on which you want to place the background graphic. 2. Do any of the following: 
 
 On the Insert tab, click Picture. Select a picture to insert and click Open.
 
 
 
 On the Insert tab, click Clip Art. Search for a piece of clip art to use, and insert it on the master.
 
 
 
 In any application (including PowerPoint), copy any graphic to the Clipboard by pressing Ctrl+C; then display the master and paste the graphic by pressing Ctrl+V.
 
 Tip Most of the background graphics that come with the built-in themes are either semi-transparent or use one of the placeholder colors for their fill. Therefore changing the color theme also changes the color of the background graphic. Keep that in mind if you are creating your own background graphics; it’s better to use theme colors or transparency than to use fixed colors that might clash with a color theme that you later apply. 
 
 Working with Placeholders As a review, to enter Slide Master view, display the View tab and click Slide Master. One or more slide masters appear in the left pane, with its own subordinate layout masters. A slide master has five preset placeholders that you can individually remove or move around. Figure 5-17 points them out on a slide master with the Concourse theme applied, but they might be in different locations in other themes: 
 
 Title: The placeholder for the title on each slide
 
 
 
 Text: The main content placeholder on each slide
 
 
 
 Date: The box that displays the current date on each slide
 
 
 
 Slide number: The box that displays the slide number on each slide
 
 
 
 Footer: A box that displays repeated text at the bottom of each slide
 
 These elements are all enabled by default, but the Footer is empty by default so it is not visible on individual slides unless you type some text into it in Slide Master view or add text to it using Insert Header and Footer. Each of these elements trickles down to the layout masters beneath it, so formatting, moving, or deleting one of these elements from the slide master also changes it on each of the layouts. See Figure 5-17 for an example of the various placeholders.
 
 136
 
 Chapter 5: Working with Layouts, Themes, and Masters
 
 FIGURE 5-17
 
 Each slide master contains these placeholders (or can contain them).
 
 Title
 
 Text
 
 Footer
 
 Date
 
 Slide Number
 
 Formatting a Placeholder You can format the text in each of the placeholders on the slide master just like any regular text, and that formatting carries over to all slides and layouts based on it. For example, if you format the code in the Slide Number box with a certain font and size, it will appear that way on every slide that uses that slide master. You can also format the placeholder boxes just like any other text boxes. For example, you can add a border around the page number’s box, and/or fill its background with color.
 
 Tip If you want to make all of the text in a heading all-caps or small-caps, use the Font dialog box. From the Home tab, click the dialog box launcher in the Font group and select the Small Caps or All Caps check box there. 
 
 Cross-Reference See Chapters 6 and 7 to learn how to format text. See Chapter 7 for more information about formatting text boxes. 
 
 Moving, Deleting, or Restoring Placeholders You can move each of the placeholders on the slide master or an individual layout master. For example, you might decide you want the Footer box at the top of the slide rather than the bottom, or that you want to center the slide number at the bottom of the slide: 
 
 To move a placeholder, click it to select it and then drag its border, just as you did with text boxes in Chapter 4.
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 To delete one of the placeholders on the slide master, select its box and press the Delete key on the keyboard. Deleting it from the slide master deletes it from all of the associated layouts as well.
 
 
 
 To remove all three of the footer placeholders at once (Date, Footer, and Slide Number) display the Slide Master tab and deselect the Footers check box.
 
 
 
 To restore deleted placeholders on the slide master, display the Slide Master tab and select the Footers check box. If any of the footer placeholders (Date, Footer, or Slide Number) were previously deleted, they reappear.
 
 Caution Restored placeholders might not appear in the same spots as they did originally; you might need to move them. To put the placeholders back to their original locations, reapply the theme from the Themes button on the Slide Master tab. 
 
 Here are some more details you should remember about deleting and restoring: 
 
 On an individual layout master, you can quickly delete and restore the Title and Footer placeholders by selecting or deselecting the Title and Footers check boxes on the Slide Master tab. The ‘‘footer’’ that this check box refers to is actually all three of the bottom-of-the-slide elements: the actual footer, the date box, and the slide number box.
 
 
 
 You can also individually delete the placeholders from a layout master, the same as you can on a slide master. Just select a placeholder box and press the Delete key.
 
 
 
 You can restore all of the placeholders, except Text, by selecting the aforementioned check boxes on the Slide Master tab. Whenever any of the three footer boxes are missing, the Footers check box becomes cleared, and you can restore the missing box or boxes by re-selecting the check box.
 
 
 
 You cannot restore the Text placeholder, however, on an individual layout master. You must recreate it with the Insert Placeholder command.
 
 Cross-Reference For more on the Insert Placeholder command, see the section, ‘‘Customizing and Creating Layouts.’’ 
 
 Displaying the Date, Number, and Footer on Slides Even though the placeholders for Date, Number, and Footer might appear on the slide master, they do not appear on the actual slides in the presentation unless you enable them. This might seem counterintuitive at first, but it’s actually a benefit. PowerPoint enables you to turn the date, number, and footer on and off without having to delete, recreate, or reformat their placeholders. You can decide at the last minute whether you want them to display or not, and you can choose differently for different audiences and situations. You can control all three areas from the Header and Footer dialog box. To open it, from the Insert tab click Header and Footer. (Clicking Date and Time or clicking Number opens the same dialog box.) Then on the Slide tab, select the check boxes for each of the three elements that you want to use, as shown in Figure 5-18.
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 FIGURE 5-18
 
 Choose which footer elements should appear on slides.
 
 Date and Time You can set Date and Time either to Update Automatically or to Fixed: 
 
 Update Automatically pulls the current date from the computer’s clock and formats it in whatever format you choose from the drop-down list. You can also select a language and a Calendar Type (although this is probably not an issue unless you are presenting in some other country than the one for which your version of PowerPoint was developed).
 
 
 
 Fixed prints whatever you enter in the Fixed text box. When Fixed is enabled, it defaults to today’s date in the m/dd/yyyy format.
 
 Tip In addition to (or instead of) placing the date on each slide, you can insert an individual instance of the current date or time on a slide, perhaps as part of a sentence. To do so, position the insertion point inside a text box or placeholder and then on the Insert tab, click Date and Time. Select the format you want from the dialog box that appears and click OK. 
 
 Slide Number This option shows the slide number on each slide, wherever the Number placeholder is positioned. You can format the Number placeholder on the master slide with the desired font, size, and other text attributes
 
 Cross-Reference See Chapter 6 for more on formatting. 
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 By default, slide numbering starts with 1. You can start with some other number if you like by following these steps: 1. Close Slide Master view if it is open. To do so, click the Close button on the Slide Master tab. 2. On the Design tab, click the dialog box launcher in the Page Setup group. The Page Setup dialog box opens. 3. In the Number Slides From box, increase the number to the desired starting number. 4. Click OK.
 
 Tip You can insert the slide number on an individual slide, either instead of or in addition to the numbering on the Slide Master. Position the insertion point, and then on the Insert tab, click Slide Number. If you are in Slide master view, this places a code on the Slide Master for the slide number that looks like this: . If you are on an individual slide, it inserts the same code, but the code itself is hidden and the actual number appears. 
 
 Footer The footer is blank by default. Select the Footer check box, and then enter the desired text in the Footer box. You can then format the footer text from the slide master as you would any other text (see Chapter 6 for details about formatting). You can also enter the footer text in the Header and Footer dialog box’s Footer text box.
 
 Don’t Show on Title Slide This check box in the Header and Footer dialog box suppresses the date/time, page number, and footer on slides that use the Title Slide layout. Many people like to hide those elements on title slides for a cleaner look and to avoid repeated information (for example, if the current date appears in the subtitle box on the title slide).
 
 Customizing and Creating Layouts In addition to customizing the slide master (including working with its preset placeholder boxes, as you just learned), you can fully customize the individual layout masters. A layout master takes some of its settings from the slide master with which it is associated. For example, by default it takes its background, fonts, theme colors, and preset placeholder positioning from the slide master. But the layout master also can be individually customized; you can override the slide master’s choices for background, colors, and fonts, and you can create, modify, and delete various types of content placeholders.
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 Understanding Content Placeholders You can insert seven basic types of content on a PowerPoint slide: Text, Picture, Chart, Table, Diagram, Media (video or sound), and Clip Art. A placeholder on a slide master or layout master can specify one of these types of content that it will accept, or you can designate it as a Content placeholder, such that it will accept any of the seven types. Most of the layouts that PowerPoint generates automatically for its themes use the Content placeholder type because it offers the most flexibility. By making all placeholders Content placeholders rather than a specific type, PowerPoint can get by with fewer separate layout masters because users will choose the desired layout based on the positioning of the placeholders, not their types. A Content placeholder appears as a text placeholder with a small palette of icons in the center, one for each of the content types. Each content placeholder can hold only one type of content at a time, so as soon as the user types some text into the content placeholder or clicks one of the icons in the palette and inserts some content, the placeholder becomes locked into that one type of content until the content is deleted from it.
 
 Note If a slide has a placeholder that contains some content (any type), selecting the placeholder and pressing Delete removes the content. To remove the placeholder itself from the layout, select the empty placeholder and press Delete. If you then want to restore the placeholder, reapply the slide layout to the slide. 
 
 You can move and resize a placeholder on a layout master as you would any other object. Drag a selection handle on the frame to resize it, or drag the border of the frame (not on a selection handle) to move it.
 
 Cross-Reference The Content placeholders are shown in Chapter 4 in Figure 4-12. You can also see Chapter 4 for more on moving and resizing an object. 
 
 Adding a Custom Placeholder You can add a custom placeholder to an individual layout master. This makes it easy to build your own custom layouts. To add a custom placeholder, follow these steps: 1. In Slide Master view, select the layout master to affect. 2. On the Slide Master tab, click the bottom part of the Insert Placeholder button to open its menu. 3. Click Content to insert a generic placeholder, or click one of the specific content types. See Figure 5-19. The mouse pointer becomes a cross-hair.
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 FIGURE 5-19
 
 Create a new placeholder on a slide.
 
 4. Drag on the slide to draw the placeholder box of the size and position desired. A blue box appears showing where the placeholder box will go. When you release the mouse button, the new placeholder appears on the slide.
 
 Deleting and Restoring a Custom Placeholder To delete a custom placeholder, select it and press the Delete key, just as you learned to do earlier with the preset placeholders. The difference between custom and preset placeholders is not in the deleting, but rather in the restoring. You can immediately undo a deletion with Ctrl+Z, but you cannot otherwise restore a deleted custom placeholder from a layout master. PowerPoint retains no memory of the content placeholders on individual layouts. Therefore, you must recreate any content placeholders that you have accidentally deleted.
 
 Tip To restore one of the built-in layouts, copy it from another slide master. See the sections ‘‘Duplicating and Deleting Layouts,’’ and ‘‘Copying Layouts Between Slide Masters’’ later in this chapter. 
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 Overriding the Slide Master Formatting for a Layout You can apply formatting to a layout in almost exactly the same ways as you apply formatting to a regular slide or to a slide master. Only a few things are off-limits: 
 
 You cannot apply a different theme to individual layouts under a common slide master. To use a different theme for some slides, you have to create a whole new slide master (covered later in this chapter).
 
 
 
 You cannot apply a different font, color, or effect theme, because these are related to the main theme and the slide master. If you need different fonts or colors on a certain layout, specify fixed font formatting for the text placeholders in that layout, or specify fixed color choices for objects.
 
 Cross-Reference For more on slide masters, see the section ‘‘Managing Slide Masters.’’ For more on formatting text placeholders, see Chapter 6. For more on specifying colors for objects, see Chapter 10.  
 
 You cannot delete a background graphic that is inherited from the slide master; if you want it only on certain layouts, delete it from the slide master, and then paste it individually onto each layout desired, or select Hide Background Graphics from the Slide Master tab and then deselect Hide Background Graphics from certain layouts.
 
 
 
 You cannot change the slide orientation (portrait or landscape) or the slide size.
 
 So what can you do to an individual layout, then? Plenty. You can do the following: 
 
 Apply a different background.
 
 
 
 Reposition, resize, or delete preset placeholders inherited from the slide master.
 
 
 
 Apply fixed formatting to text placeholders, including different fonts, sizes, colors, attributes, indents, and alignment.
 
 
 
 Apply formatting using theme colors and theme fonts
 
 
 
 Apply fixed formatting to any placeholder box, including different fill and border styles and colors.
 
 
 
 Create manual text boxes and type any text you like into them. You might do this to include copyright notice on certain slide layouts, for example.
 
 
 
 Insert pictures or clip art that should repeat on each slide that uses a certain layout.
 
 Creating a New Layout In addition to modifying the existing layouts, you can create your own brand-new layouts, defining the exact placeholders you want. To create a new layout, follow these steps: 1. From Slide Master view, click the slide master with which to associate the new layout. 2. Click Insert Layout. A new layout appears. Each new layout you create starts with preset placeholders inherited from the slide master for Title, Footer, Date, and Slide Number.
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 3. (Optional) Delete any of the preset placeholders that you don’t want. 4. Insert new placeholders as needed. 5. (Optional) Name the layout.
 
 Cross-Reference To insert a placeholder, see the section ‘‘Adding a Custom Placeholder’’ earlier in the chapter. To name the layout, see the next section ‘‘Renaming a Layout.’’ 
 
 Note The new layout is part of the slide master, but not part of the theme. The theme is applied to the slide master, but at this point their relationship ends; and changes that you make to the slide master do not affect the existing theme. To save your custom layout(s), you have two choices: You can save the presentation as a template, or you can save the theme as a separate file. You learn more about saving themes in ‘‘Managing Themes’’ later in this chapter. 
 
 Renaming a Layout Layout names can help you determine the purpose of a layout if it is not obvious from viewing its thumbnail image. To change the name of a layout, or to assign a name to a new layout you’ve created, follow these steps: 1. In Slide Master view, right-click the layout and choose Rename Layout. The Rename Layout dialog box opens. 2. Type a new name for the layout, replacing the existing name. 3. Click Rename.
 
 Duplicating and Deleting Layouts You might want to copy a layout to get a head start on creating a new one. To copy a layout, right-click the layout in Slide Master view and choose Duplicate Layout. A copy of the layout appears below the original. If you are never going to use a certain layout, you might as well delete it; every layout you can delete makes the file a little bit smaller. To delete a layout, right-click the layout in Slide Master view and choose Delete Layout.
 
 Caution You might have a couple of layouts at the bottom of the list that employ vertical text. These are for users of Asian languages. They show up in the New Slide and Layout galleries on the home tab if you have certain Asian languages enabled on your system. Don’t delete them if you will sometimes need to create Asian-language slides. 
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 Copying Layouts Between Slide Masters When you create additional slide masters in the presentation, any custom layouts you’ve created for the existing slide masters do not carry over. You must manually copy them to the new slide master. To copy a layout from one slide master to another, follow these steps: 1. In Slide Master view, select the layout to be copied. 2. Press Ctrl+C. 3. Select the slide master under which you want to place the copy. 4. Press Ctrl+V. You can also copy layouts between slide masters in different presentations. To do so, open both presentation files, and then perform the previous steps. The only difference is that after step 2, you must switch to the other presentation’s Slide Master view.
 
 Managing Slide Masters Let’s review the relationship one more time between slide masters and themes. A theme is a set of formatting specs (colors, fonts, and effects) that can be used in PowerPoint, Word, or Excel. Themes are not applied directly to slides — they are applied to slide masters, which govern the formatting of slides. The slide masters exist within the presentation file itself. You can change them by applying different themes, but they are essentially ‘‘built in’’ to the presentation file. When you change to a different theme for all of the slides in the presentation, your slide master changes its appearance. You can tweak that appearance in Slide Master view. As long as all of the slides in the presentation use the same theme, you need only one slide master. However, if you apply a different theme to some of your slides, you need another master, because a master can have only one theme applied to it at a time. PowerPoint automatically creates the additional master(s) for you, and they are all available for editing in Slide Master view. If you later reapply a single theme to all of the slides in the presentation, you do not need multiple masters anymore, so the unused one is automatically deleted. In addition to all this automatic creation and deletion of slide masters, you can also manually create and delete slide masters on your own. Any slide masters that you create manually are automatically preserved, even if they aren’t always in use. You must manually delete them if you don’t want them anymore. In the following sections, you learn how to create and delete slide masters manually, and how to rename them. You also learn how to lock one of the automatically created slide masters so that PowerPoint does not delete it if it falls out of use.
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 Creating and Deleting Slide Masters To create another slide master, click Insert Slide Master on the Slide Master tab. It appears below the existing slide master(s) in the left pane of Slide Master view. From there, just start customizing it. You can apply a theme to it, modify its layouts and placeholders, and all the usual things you can do to a slide master. Another way to create a new slide master is to duplicate an existing one. To do this, right-click the slide master and choose Duplicate Master. To delete a slide master, select it in Slide Master view (make sure you select the slide master itself, not just one of its layouts) and press the Delete key. If any of that slide master’s layouts were applied to any slides in the presentation, those slides automatically convert to the default slide master’s equivalent layout. If no exact layout match is found, PowerPoint does its best: It uses its default Title and Content layout and includes any extra content as orphaned items.
 
 Renaming a Slide Master Slide master names appear as category headings on the Layout list as you are selecting layouts. For example, in Figure 5-20, the slide master names are Apex and Check. FIGURE 5-20
 
 Slide master names form the category titles on the Layout list.
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 To rename a slide master, follow these steps: 1. In Slide Master view, right-click the slide master and choose Rename Master. The Rename Master dialog box opens. 2. Type a new name for the master, replacing the existing name. 3. Click Rename.
 
 Preserving a Slide Master Unless you have created the slide master yourself, it is temporary. Slide masters come and go as needed, as you format slides with various themes. To lock a slide master so that it doesn’t disappear when no slides are using it, right-click the slide master and choose Preserve Master. A check mark appears next to Preserve Master on its right-click menu, indicating it is saved. To un-preserve it, select the command again to toggle the check mark off. See Figure 5-21. FIGURE 5-21
 
 The Preserve Master command saves a slide master so that PowerPoint cannot automatically delete it.
 
 Managing Themes As you learned earlier in the chapter, themes are applied to slide masters to create the background, color, font, and effect formatting for a presentation. Some themes are built into PowerPoint, and you can also create and save your own themes as separate files and apply them to other presentations or even to other Office documents, such as in Word and Excel. In this section you learn how to create new themes, manage theme files, and apply themes across multiple presentations.
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 Creating a New Theme To create a new theme, first format a slide master exactly the way you want, including any custom layouts, backgrounds, colors, and font themes. Then save the slide master’s formatting as a new theme by following these steps: 1. On the Slide Master or the Design tab, click Themes, and click Save Current Theme. The Save Current Theme dialog box opens. 
 
 The default location shown in the Save Current Theme dialog box under Windows Vista or Windows 7 is C:\Users\username\AppData\Roaming\Microsoft\Templates\ Document Themes.
 
 
 
 For Windows XP, it is C:\Documents and Settings\username\Application Data\Microsoft\Templates\Document Themes.
 
 2. Type a name for the theme file in the File Name text box. 3. Click Save. The new theme is saved to your hard disk. The new theme is now available from the Themes button’s menu in all presentations you create while logged in as the same user on the same PC. All of its formatting is available, including any custom color or font themes it includes. You can use it in other programs too; in Word or Excel, choose Page Layout ➪ Themes in one of those programs.
 
 Renaming a Theme You can rename a theme file by renaming the .thmx file from Windows Explorer, outside of PowerPoint. You can also rename a theme file from inside PowerPoint by using any dialog box that saves or opens files. For example, to use the Choose Theme or Themed Document dialog box to rename a theme, follow these steps: 1. From the Design or Slide Master tab, click Themes, and choose Browse for Themes. The Choose Theme or Themed Document dialog box opens. 2. Navigate to the folder containing the theme file to rename. 
 
 By default, theme files are stored under Windows Vista or Windows 7 in: C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes.
 
 
 
 For Windows XP, it is C:\Documents and Settings\username\Application Data\Microsoft\Templates\Document Themes.
 
 3. Right-click the theme file and choose Rename. 4. Type the new name for the theme and press Enter. 5. Click Cancel to close the dialog box.
 
 Deleting a Theme A custom theme file continues appearing on the Themes gallery indefinitely. If you want to remove it from there, you must delete it from the Document Themes folder, or move it to some other location for storage. To delete a theme, follow these steps:
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 1. From the Design or Slide Master tab, click Themes, and choose Browse for Themes. The Choose Theme or Themed Document dialog box opens. 2. Navigate to the folder containing the theme files: 
 
 In Windows Vista or Windows 7: C:\Users\username\AppData\Roaming\Microsoft\ Templates\Document Themes.
 
 
 
 In Windows XP: C:\Documents and Settings\username\Application Data\Microsoft\ Templates\Document Themes.
 
 3. Right-click the theme file and choose Delete. 4. At the Delete File confirmation box, click Yes. 5. Click Cancel to close the dialog box.
 
 Copying a Theme from Another Presentation A presentation file ‘‘contains’’ themes, in that the themes are applied to its slide masters. (That’s how a template contains themes too.) As you learned earlier, you can preserve a slide master in Slide Master view so that it doesn’t get deleted automatically when there are no slides based on it; by creating new slide masters, applying themes to them, and then preserving them, you can create a whole library of themes in a single presentation or template file. Then to make this library of themes available in another presentation, you simply base the new presentation on that existing presentation (or template). However, if you did not initially base the new presentation on the template or presentation that contains the theme you want, you can apply the theme from it after the fact. One way to do this is to copy and paste (or drag and drop) the slide master from one file’s Slide Master view to the other’s. Follow these steps to copy a slide master (and thereby copy its theme) to another presentation: 1. Open both presentations. 2. In the presentation that contains the theme, enter Slide Master view (View ➪ Slide Master). 3. Select the slide master (top slide in the left pane) and press Ctrl+C to copy it. 4. Switch to the other presentation (View ➪ Switch Windows). 5. Enter Slide Master view (View ➪ Slide Master). 6. Press Ctrl+V to paste the slide master (and its associated theme and layouts).
 
 Summary In this chapter you learned how themes and slide masters make it easy to apply consistent formatting in a presentation, and how layout masters are associated with slide masters and provide consistent layouts for the slides based on them. You learned how to create, edit, rename, and delete themes, masters and layouts, and how to copy themes between presentations.
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 Now that you know how to format entire presentations using themes, you’re ready to start learning how to make exceptions to the formatting rules that the themes impose. In the next chapter you will learn how to format text in PowerPoint, and apply different fonts, sizes, attributes, and special effects. You can use this knowledge to make strategic changes to the text placeholders on slide masters to further customize your themes, or you can make changes to text on individual slides on a case-by-case basis to make certain slides stand out from the rest.
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 T
 
 ext formatting is formatting that you can apply to individual characters of text. It includes font (typeface), size, attributes such as bold and underline, fill color, and border color. (Formatting that affects entire paragraphs only, such as indentation or bullet style, is called paragraph formatting, not text formatting, and is covered in Chapter 7.) As you learned in Chapter 5, PowerPoint automates text formatting by applying themes to slide masters. The slide masters then dictate the default text size, font, color, and attributes that should be used on slides. By applying text formatting through the slide masters, rather than to individual slides, you ensure consistency and make it much easier to make global font changes later on. However, you may need to change the formatting of some text. For example, the font size for titles on the slide master may be a bit too large; in this case, you can decrease the font size for the Title placeholder, and this change will apply to all of the layouts for that master. You can even save the changes to a new theme file so that you can reuse the theme with the smaller title text later on. In some cases, you might need to manually change the text formatting for an individual text box, or even an individual paragraph or word. For example, you may create text boxes manually that label the parts of a diagram; in this case, you would probably want to use a fixed font and size for those labels, so that they do not change if you switch themes later on.
 
 Changing the Font There are several ways to change the font that is used in a presentation. Whenever possible, in order to maintain consistency, you should use the method that affects an entire slide master. However, in some cases, you may
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 need to change the font in an individual text box, or even individual characters within the text box. Office 2010 comes with a lot of different fonts, and you may also have acquired some additional fonts by installing other programs. A font is a typeface, or a style of lettering. To see an example of two different font styles, compare the lettering of the preceding heading to the lettering in this paragraph.
 
 Note In the past, when most fonts were not scalable, a distinction was sometimes drawn between the term ‘‘typeface’’ — referring to a certain style of lettering — and the term ‘‘font’’ — which referred to a specific typeface used at a certain size, with a certain combination of attributes, such as bold and italic. Nowadays, however, the terms font and typeface are synonymous for all practical purposes. 
 
 Windows fonts are generic — that is, they work with any program. For example, a font that came with a desktop publishing program such as Adobe InDesign also works with Microsoft Word and with PowerPoint. Within PowerPoint, you have access to all of the installed Windows fonts on your system. The majority of the fonts that come with Windows and Office are scalable, OpenType or TrueType fonts. These are outline fonts, which means that they consist of unfilled, mathematically created outlines of each character. When you assign a size, you are sizing the outline; each outline is then filled in with black (or whatever color you choose) to form each character. As a result, these fonts look good at any size. PowerPoint’s Font list does not differentiate between OpenType and TrueType fonts, and both are marked with TT icons to their left, as shown in Figure 6-1. (A few proprietary fonts might show an O icon, for OpenType, instead of TT.) Depending on the default printer, PowerPoint’s Font list may also contain fonts that have printer icons to their left. These are printer-resident fonts, and they are built into the default printer that you have set up in Windows. Figure 6-1 shows one such font, AvantGarde. You should not use these fonts in a presentation that you plan to show on another computer or distribute to others electronically, because not everyone will have these fonts available. In terms of appearance, there are two basic groups of fonts: serif (those with little tails on each letter, such as the small horizontal lines at the bases of the letters i and t) and sans-serif (those without the tails). The regular paragraph text in this book uses a serif font. The headings use a sans-serif font.
 
 Choosing the Right Fonts A font can make a tremendous difference in the readability and appeal of your presentation, so selecting the right ones is very important. But how do you choose from among all of the fonts that are installed on your system? Here are some general rules: 
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 Strive for consistency. (Yes, I keep harping on that, but it’s important.) You should avoid changing the font on an individual slide, and instead, make font changes to the slide master, or, in some cases, to a master layout.
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 FIGURE 6-1
 
 Fonts appear on the Fonts list on the Home tab.
 
 
 
 Whenever possible, rather than choosing a fixed font, use the (Headings) or (Body) placeholders at the top of the Font menu (see Figure 6-1). You can then redefine those placeholders using a font theme. This makes it much easier to change the fonts for the entire presentation later on.
 
 Cross-Reference For more on font themes, see Chapter 5.  
 
 Try to use a sans-serif font for the ‘‘Headings’’ font, because sans-serif is easier to read at large sizes.
 
 
 
 Use serif fonts for the body if the presentation is very text-heavy, because serif fonts are easier to read in long paragraphs (such as in this book).
 
 
 
 Avoid serif fonts for tiny text, because the serifs tend to break up onscreen at small sizes.
 
 
 
 Avoid script fonts in presentations, because they are hard to read.
 
 
 
 Avoid novelty fonts, because they take the focus away from your message.
 
 Another consideration when choosing fonts is whether the PC on which you present the show is likely to have the same fonts installed. If you stick with Windows-supplied fonts such as
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 Arial and Times New Roman, which are available in Windows XP and newer versions, this is a non-issue. However, if you use a font that came with Office 2007 and 2010 only, such as Calibri, but you plan to present on a PC that uses Office 2003 or earlier, then you might want to embed the fonts in the presentation when you are saving it. If you present or edit the show on a PC that does not have the right fonts, and the fonts are not embedded, then PowerPoint will use fonts that are as close as possible to a match. Although this is helpful, it can also cause strange and unexpected line breaks in your text.
 
 Tip When you install the Compatibility Pack in an earlier version of PowerPoint, it not only enables you to open PowerPoint 2007 and 2010 files, but it also installs the fonts introduced in PowerPoint 2007/2010, such as Calibri. 
 
 Tip To embed fonts when saving the presentation, choose Tools ➪ Save Options in the Save As dialog box. Select the Embed Fonts in the File check box, and click OK. 
 
 Tip If you end up on the other side of that equation and are stuck with a presentation that uses fonts that your system doesn’t have, use Replace Fonts to replace all instances of the missing font with one that is available on your PC. See ‘‘Replacing Fonts’’ later in this chapter. 
 
 Changing the Font Theme Choosing a different font theme is covered in Chapter 5 because of the connection between themes and fonts, but let’s have another look at it here in the context of font formatting. A font theme is a specification that names two fonts: one for headings (titles) and one for body text (everything else). Font themes apply to all text that uses the font placeholders rather than a fixed font. To switch to a different font theme, follow these steps: 1. On the Design tab, click Fonts. The Fonts menu opens to display samples of the available themes. These include both built-in font themes and any custom themes that you’ve created. 2. Hover the mouse pointer over a theme to see it previewed on the slide. 3. Click the font theme that you want.
 
 Cross-Reference To create your own custom font themes, see Chapter 5. 
 
 Tip You apply the font theme to the slide master that the current slide uses. If you have other slides in the presentation that use different slide masters, the change does not affect them. To apply the change to all slide masters, instead of clicking the font theme in step 3, right-click it and choose Apply to All Slides from the menu that appears. 
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 Applying a Fixed Font If you apply a specific font to some text, that text will no longer use the font that is specified by the font theme. That font will not change when you change the presentation’s overall font theme. If this is what you want, then you have two ways to apply a specific font: from the Home tab or from the mini toolbar. To apply a font from the Home tab, follow these steps: 1. Select the text to be formatted. It can be on a slide master (most preferable), on a layout master, or on an individual slide. 2. On the Home tab, in the Font group, open the Font drop-down list (Figure 6-1). 3. Point to a font other than the ones designated (Headings) and (Body). The selected text is previewed in that font. 4. Click the font that you want. PowerPoint applies the font to the text. If you want to return to using the theme fonts, select the ‘‘Headings’’ or the ‘‘Body’’ font from the top of the menu. The mini toolbar is just what it sounds like — a small toolbar. It appears above and to the right of selected text. When the mouse pointer is directly on top of the selected text, the mini toolbar appears dimmed, but if you move your mouse up to the mini toolbar, it becomes fully visible. To apply a font from the mini toolbar, follow these steps: 1. Select the text to be formatted. It can be on a slide master (most preferable), on a layout master, or on an individual slide. 2. Hover the mouse pointer over the selection so that the mini toolbar appears, as shown in Figure 6-2. If it does not appear, right-click the selection. 3. On the mini toolbar, open the Font drop-down list. 4. Point to a font other than the ones marked (Headings) or (Body). The selected text is previewed in that font. 5. Click the font that you want. PowerPoint applies the font to the text.
 
 FIGURE 6-2
 
 Use the mini toolbar to apply a font.
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 Using the Font Dialog Box The Font dialog box (shown in Figure 6-3) provides a third way of changing the font. It also gives you access to the controls for setting font size, color, and attributes, all of which you will learn about later in this chapter. To open the Font dialog box, click the dialog launcher in the Font group on the Home tab. Then make your selections in the dialog box, just as you would from the Home tab’s Font group. Notice in Figure 6-3 that the Font drop-down list is labeled Latin Text Font. In this case, ‘‘Latin’’ just means regular text characters. FIGURE 6-3
 
 The Font dialog box provides access to many different text-formatting controls, as well as the font list.
 
 Replacing Fonts If you restrain yourself from using a lot of manual text formatting, and rely on the theme to handle it, you should not have a problem with inconsistent font usage. Whenever you need to make a change, you can do it once on the slide master and be done with it. However, not everyone can be counted on to show such discipline and good design sense as you. Suppose your coworker created a long presentation in which he sporadically applied a certain font for some special elements. Now you need to work on that presentation, but you don’t have that font. You will need to go through and hunt for all instances of that font and change them to some other font. Fortunately, PowerPoint has a Replace Fonts feature that can help you to find all of these instances. Follow these steps: 1. On the Home tab, click the down arrow for the Replace button and choose Replace Fonts. The Replace Font dialog box appears, as shown in Figure 6-4. 2. In the Replace drop-down list, select the font that you want to replace. Only the fonts that are currently in use in the presentation appear on this list, and so it’s easy to navigate.
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 FIGURE 6-4
 
 Replace all instances of one font with another.
 
 3. In the With drop-down list, select the desired replacement font. All of the available fonts on your system appear here. 4. Click Replace. All of the instances of that font are replaced. 5. Repeat steps 2 to 4 to replace another font, or click Close when you’re finished.
 
 Caution Replacing the theme fonts makes the placeholders no longer respond to font theme changes. You have to reset the slide master by reapplying a theme font there if you ‘‘un-theme’’ them using Replace Fonts. 
 
 Changing the Font Size Each theme has a specified font size that it uses for titles and for body text, with different sizes typically used for different levels of bulleted lists. You can use the default settings, or you can edit the placeholders on the slide master to change them. In some cases, you might also need to change the size of an individual block of text on an individual slide.
 
 Note As you learned at the end of Chapter 4, PowerPoint has an AutoFit feature that you can turn on or off for each text box. When enabled, AutoFit permits the text size to shrink so that the text fits into the text box, or it permits the text box to grow so that the text fits at its current size. However, AutoFit does not change the text’s font size as applied by the Font Size setting; if you enlarge the text box, the text goes back to its regular size. 
 
 Choosing the Right Sizes The size of the text is just as important as the font. If the text is too large, it looks unattractive and amateurish, but if it’s too small, the people in the back row won’t be able to follow along. Font size is measured in points, and each point measures 1/72 of an inch when printed. However, PowerPoint slides are usually shown on a screen rather than in print, and so the appropriate font size depends mainly upon the presentation medium. For example, a 72-point letter on a 15-inch monitor is very different than a 72-point letter on a 12-foot projection screen.
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 The default sizes that are specified in the built-in themes provide you with a good starting point. You can increase or decrease the sizes on the slide masters as necessary. Here are some things to consider when choosing font size: 
 
 The farther away the audience will be sitting from the slides, and the smaller the display screen, the larger the text should be.
 
 
 
 Very thick and very thin letters are harder to read at small sizes. A font of moderate thickness is most readable.
 
 
 
 Very tight spacing can make thick letters difficult to read; on the other hand, very loose spacing can emphasize the individual letters to the point where the words they comprise are not as obvious. See the section ‘‘Adjusting Character Spacing’’ later in this chapter.
 
 
 
 If any of your slide titles are so long that they wrap to an additional line within the title placeholder box, consider slightly decreasing the font size for the title placeholder on the slide master so that the wrapping doesn’t occur. Make your changes to the slide master — not the individual slide on which the problem occurs. This is because audiences find it jarring when the slide title is not in the same place or not the same size on every slide.
 
 Specifying a Font Size The Font Size drop-down list, shown in Figure 6-5, is on the Home tab and is actually also an input box. You can click it and type a font size directly into the text box, or you can open the drop-down list and select a value. Typing your own value is useful if the size that you want doesn’t appear on the list. At the smaller sizes, the list increments by one point, but at the larger sizes, it makes bigger jumps, and so not all values are available.
 
 Note The same Font Size drop-down list is also available in the mini toolbar and in the Font dialog box. 
 
 As a shortcut, you can also use the Increase Font and Decrease Font buttons, which are available both on the Home Ribbon and on the mini toolbar. They are shown in Figure 6-5, and they increase or decrease the font size by one position on the Font Size list. (As noted earlier, for the smaller sizes, the increment occurs at one point at a time, but for larger sizes there is more of a jump between sizes.) You can also use the following keyboard shortcuts: 
 
 Increase Font: Ctrl+Shift+>
 
 
 
 Decrease Font: Ctrl+Shift+					    
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